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Chapter 1 Introduction

The contaminant impact from sources such as landfills and spills will be dependent on the interaction
between the engineered systems and the hydrogeology. Computer modeling may be used to simulate
this interaction and to assess the probable contaminant impact of a contaminant source. In addition,
computer modeling may be used to examine the effects of changes in the design and performance of the
engineered systems, or the local hydrogeology.

POLLUTEv8 is used to provide fast, accurate, and comprehensive contaminant migration analysis
capabilities. The program implements a one and a half dimensional solution to the advection-dispersion
equation.

Unlike finite element and finite difference formulations, POLLUTEv8 does not require a time-marching
procedure, and thus involves relatively little computational effort while also avoiding the numerical
problems of alternate approaches. With more then thirty years utilization in industry, POLLUTEv8 is a
well tested contaminant migration analysis program that is widely used internationally. Models that can
be considered range from simple systems on a natural clayey aquitard to landfill designs with composite
liners, multiple barriers and multiple aquifers. In addition to advective-dispersive transport, POLLUTEv8
can consider non-linear sorption, radioactive and biological decay, transport through fractures, passive
sinks, time-varying properties, and phase changes. 

The program is based upon the project concept for data storage, where the user has numerous projects
and within each project there are numerous models. Using this method, a Microsoft Access database is
used to store each project. Each project is stored in a separate directory, which can be on the same
computer or spread across a network. A master database is used to keep track of projects and their
locations, so that there is no need to remember the location of data files.
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1.1 Theory

The movement or migration of contaminants through the soil is of interest in the prediction of contaminant
impact from sources such as landfills and spills. There are three main mechanisms for contaminant
transport, these are advection, diffusion, and dispersion. In many applications the movement of
contaminants will be primarily in one direction, and can be predicted using the one-dimensional
dispersion-advection equation for a layered deposit [Rowe and Booker, 1985, 1991b; Rowe et al, 1994].

POLLUTEv8 is a computer program that implements a solution to the one-dimensional dispersion-
advec� tion equation for a layered deposit of finite or infinite extent [Rowe & Booker, 1991b]. Using this
solution POLLUTEv7 calculates the concentrations of a contaminant at user specified times and depths.

Unlike finite element and finite difference formulations, POLLUTEv8 does not require the use of a
“time� marching” procedure. POLLUTEv8 uses a finite-layer formulation that provides numerically accurate
results for a given idealization while requiring relatively little computational and data entry effort. Thus, in
its basic mode of operation the concentration of contaminant can be directly determined at any specified
time without calculating the concentration at earlier times.

1.1.1 Transport Mechanisms

The migration of dissolved contaminants through the subsurface involves different transport mechanisms
depending upon the type of soil, presence of fractures, degree of saturation, and soil - contaminant
interaction. For a saturated clay or silt the primary mechanisms are advection and diffusion, whereas for
a saturated sand the primary mechanisms are advection and dispersion. In a fractured soil the primary
mechanisms are advection and dispersion along the fractures and diffusion from the fractures in the
matrix. Soils with clay particles or organic matter may also act to retard the migration of contaminants
by adsorbing the contaminant. These transport mechanisms are described in detail below.

1.1.1.1 Advection

When water flows through the soil it will carry contaminants along with it in solution, this process is
called advection. The amount of contaminant mass transported by advection is proportional to the
groundwater (seepage) velocity, v, and the concentration, c, of the contaminant. This mass can be
measured in a plane perpendicular to the direction of groundwater flow during a unit of time, this is called
the flux, f . The flux is then the mass of contaminant transported per unit area per unit time and is given
by:

f = n v c = v
a
 c

where,
n = effective porosity of the soil,
v = groundwater (seepage) velocity,
v
a
 = Darcy velocity = n v.

c = concentration of the contaminant at the time of interest.

The total mass of contaminant transported from a contaminant source into the ground can then be
obtained by integrating the flux over the time period of interest viz.

m
a
 = A   n v c dt

where,
m

a
 = total mass of contaminant transported,
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A = cross-sectional area of the landfill.

It is should be noted that the velocity that the contaminant moves through the soil is the groundwater
velocity and not the Darcy velocity. If the groundwater velocity is zero (i.e., there is no flow) then there
would
be no advection.

1.1.1.2 Diffusion

Diffusion is the process where chemicals contaminants in the soil will migrate from areas of high
chemical concentration (potential) to areas of low chemical concentration (potential). The mass flux
transported by diffusion is proportional to the concentration gradient and is given by:

f = - n D
e
 dc/dz

where,
n = effective porosity of the soil,
D

e
 = effective diffusion coefficient,

dc/dz = concentration gradient.

The negative sign in the above equation arises from the fact that contaminants move from areas of high
con� centration to areas of low concentrations. By integrating the above equation the total mass of
contaminant transported by diffusion from a landfill can be obtained viz.:

m
d
 = A   (- n D

e
 dc/dz ) dτ

1.1.1.3 Advective-Diffusive Transport

For unfractured clayey and silty soils the primary transport mechanisms will be generally be advection
and diffusion (i.e., advective-diffusive transport). The flux of mass, f, is obtained by adding the advective
flux and the diffusive flux viz.:

f = n v c - n D
e
 dc/dz

and the total mass, m, transported from the landfill is given by:

m
d
 = A   ( n v c - n D

e
 dc/dz ) dτ

where the parameters are the same as those defined previously. By convention if the velocity is positive
the flow is out of the landfill, and if the velocity is negative the flow is into the landfill. The direction of
transport for diffusion and advection can be in the same direction or in opposite directions. If the direction
of diffusive transport is in the same direction as that of advective transport, then diffusion will increase the
amount of contaminant transported and decrease the time taken for the contaminant to move to a given
point. Diffusion can also occur in the opposite direction to advection. For example, even if groundwater is
flowing into a landfill, the high concentration of contaminant in the leachate can cause diffusive transport
out from the landfill. Thus, even though the groundwater flow is into a landfill contaminants can still
escape from the landfill by diffusion.
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1.1.1.4 Dispersion

In a granular layer (eg. an aquifer) or a fractured layer there can be significant localized variations in the
groundwater flow. These variations will cause mechanical mixing within the layer, this process is called
dispersion [Freeze and Cherry, 1979]. Although the process is very different to diffusion it can be
modelled mathematically in the same manner, and the two processes can be grouped together as the
“coefficient of hydrodynamic dispersion”, D, viz.:

D = D
e
 + D

md

where,
D

e
 = effective diffusion coefficient,

D
md

 = coefficient of mechanical dispersion.

In unfractured clayey soils the coefficient of hydrodynamic dispersion is often controlled by the diffusion
coefficient, and the coefficient of mechanical dispersion is negligible. In sandy soils and fractured layers
the opposite is generally true and dispersion dominates [Gillham and Cherry, 1982; Rowe, 1987; Rowe et
al, 2004]. The mass flux for advective-dispersive transport (including diffusion) is given by:

f = n v c - n D dc/dz

where the parameters are the same as those defined previously and D is the coefficient of hydrodynamic
dispersion. Dispersion is often modelled as a linear function of velocity [Bear, 1979; Freeze and Cherry,
1979; Rowe et
a;, 2004] given by:

D
md

 = α v

where,
α = dispersivity,
v = groundwater (seepage) velocity.

The dispersivity tends to be scale dependent and is not a true material property [Gillham and Cherry,
1982].

1.1.2 Retardation Mechanisms

In addition to the transport mechanisms mentioned above, the migration of contaminants is also
controlled by retardation mechanisms. There are two types of retardation mechanisms, sorption and
radioactive or biological decay, that can be modelled in POLLUTEv8. These mechanisms both serve to
slow the migration of contaminants by reducing the mass of contaminant available for transport. Both
mechanisms are discussed below.

1.1.2.1 Sorption

Sorption is the process whereby contaminants are removed from solution by interaction with solid matter
in the soil. Typical interactions are cation exchange in clays and the attraction of organic contaminants
to organic matter in the soil. Sorption can be modelled as a function of the concentration of the
contaminants in the soil. POLLUTEv8 can model three types of sorption; linear sorption, Freundlich non-
linear sorption,and Langmuir non-linear sorption.

Freundlich Non-Linear Sorption
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Freundlich Non-Linear Sorption is represented by the relationship:

S = K
f
 cE

where,
S = mass of solute sorbed per unit mass of soil,
K

f
 = empirically determined parameter,

E = empirically determined exponent.

The parameters K
f
 and E are best determined by performing batch tests on samples. When non-linear

sorption is used, the program splits the deposit into sublayers and uses an iterative technique to
determine an equivalent linear distribution coefficient (K) value of each layer. Since this is an empirical
equation, particular care is required ensuring correct units, especially when E is not unity. Large errors
can result from the use of mixed units or errors in converting from one set of units to another. This is
done by:

(a) calculating the concentration at the top and bottom of each sublayer based on an estimated linear K
value for each sublayer.

(b) determining a new secant K for each sublayer.

K = K
f
 c' E-1

where,
c’ = the average of the previous estimates of the concentration at the top and bottom of the sublayer.

(c) repeating steps (a) and (b) using the new estimate of K for each sublayer until the process converges.

The number of sublayers should be experimented with to ensure that the results obtained are sufficiently
accurate.

Langmuir Non-Linear Sorption

Langmuir Non-Linear Sorption is represented by the relationship:

S = (S
m

 b c) / (1 + b c)

where,
S

m
 = solid phase concentration corresponding to all available sorption sites being occupied,

b = parameter representing the rate of sorption,
S = mass of solute sorbed per unit mass of soil,
c = concentration of solute.

The parameters S
m

 and b are best determined by performing batch tests on samples of the deposit. 

When non-linear sorption is used, the program splits the deposit into sublayers and uses an iterative
technique to determine an equivalent linear distribution coefficient (K) value of each layer. This is done
by:
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(a) calculating the concentration at the top and bottom of each sublayer based on an estimated linear K
value for each sublayer.

(b) determining a new secant K for each sublayer:

K = (S
m

 b) / (1 + b c’)

where,
c’ = the average of the previous estimates of the concentration at the top and bottom of the sublayer.

(c) repeating steps (a) and (b) using the new estimate of K for each sublayer until the process converges.

The number of sublayers should be experimented with to ensure that the results obtained are sufficiently
accurate.

1.1.2.2 Radioactive or Biological Decay

Some contaminant species experience radioactive decay or biological degradation and the concentration
of these contaminants may decay as a function of time. The rate of radioactive decay is very predictable
and is controlled by the half-life of the contaminant species. Whereas, the rate of biological decay is a
function of several factors, including the presence of the appropriate bacteria, the presence of a suitable
substrate, and the temperature. Both types of decay are often modelled by first order decay, with the
controlling parameter being the half-life of the species. 

The decay can take place in the source, the deposit, or the base. First order (exponential) decay is used
for both radioactive and biological decay, eg.

c(t) = c(0) e- λ* t

where,
c(t) = concentration at time t,
c(0) = initial concentration,
λ = decay constant = .693147/half life.

1.1.3 Phase Change

Many practical problems involve a phase change as a compound (eg. volatile organic compounds such
as dichloromethane, benzene, toluene, etc.) migrate through a multiphased system. A common example
is diffusion migration from a dissolved phase (eg. in contaminated water) into the gaseous phase (eg. in
air in an unsaturated secondary leachate collection system). Under these conditions it is well known (eg.
see Schwartzenbach et. al., 1993) that there is usually a concentration ‘jump’ at the interface between
the contaminated water and the air, and that equilibrium is reached at the interface such that:

c
a/w

 = K
H
’ c

w/a

where.
c

a/w
 = concentration in air at the interface,
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c
w/a

 = concentration in water at the interface,

K
H
’ = dimensionless Henry’s Law Constant, and is related to the Henry’s Law Constant K

H 
by the

relationship

K
H
’ = K

H
 / (R T)

(R is the gas constant and T is the absolute temperature).

More generally, there is potential for phase change at interfaces other than air-water. For example, the
migration of an organic compound from a dissolved phase in leachate through a “solid” geomembrane,
may involve a phase change defined by [Rowe et al, 2004]:

c
g
 = S

gf
 c

f

where,
S

gf
 is the dimensionless ratio of the concentration at the geomembrane and water interface, typical

values have been reported by Rowe et al, 2004. Thus, in general the concentration ratio at an interface
where there is a phase change can be written as:

c
n/w

 = c
w/n

where,

c
n/w

 is the gas or solid concentration (mol. m-3) in the n phase (i.e. gas or solid), c
w/n

 is the concentration

(mol. m-3) dissolved in the solvent of interest (eg. water), and is the dimensionless phase parameter

(mol. m-3 mol.-1 m3). 

1.1.4 One-Dimensional Contaminant Migration

The theory implemented by the POLLUTEv8 program, in its basic mode of operation, is described in
detail by Rowe and Booker [1985, 1987, 1991b] and Rowe et al [1994]. According to this theory
contaminant migration in one-dimension, for an intact material, is governed by:

n dc/dt = n D d2c/dz2 - n v dc/dz - ρ K
d
 dc/dt - n λ c

where,
c = concentration of contaminant at depth z at time t,
D = coefficient of hydrodynamic dispersion at depth z,
v = groundwater (seepage) velocity at depth z,
n = porosity of the soil at depth z,
ρ = dry density of the soil at depth z,
K

d
 = distribution/partitioning (sorption) coefficient at depth z,

v
a
 = n v = Darcy velocity,

λ = decay constant of the contaminant species (i.e., the reciprocal of the species mean half life times ln
2).

Contaminant migration in a fractured layer is primarily in one direction along the fracture (e.g. either
horizontally or vertically), but contaminants can migrate from the fractures into the intact material in all
three co-ordinate directions. Thus contaminant migration along the fractures is governed by [Rowe et al,
2004]:



POLLUTEv820

© 2021 GAEA Technologies Ltd.

n
f
 dc

f
/dt = n

f
 D

f
 d2c

f
/dz2 - n

f
 v

f
 dc

f
/dz - K

f
 dc

f
/dt - q - n

f
 λ c

f

where,
c

f
 = concentration in a fracture at depth z and time t,

D
f
 = coefficient of hydrodynamic dispersion of the fractures,

v
f
 = fracture (groundwater) velocity in the fractures,

n
f
 = fracture porosity in the plane of flow = h1/H1+h2/H2,

= surface area of fractures per unit volume of soil/rock,
K

f
 = fracture distribution coef. [Freeze and Cherry, 1979],

q = contaminant transported into the intact matrix material, from the fractures, by matrix diffusion,
λ = decay constant of the contaminant species.

Note: the program automatically calculates n
f
, v

f
, and q from other information provided by the user.

1.1.5 Boundary Conditions

The POLLUTEv8 program solves the one-dimensional contaminant migration equation subject to
boundary conditions at the top and bottom of the soil deposit being modelled. There are three possible
top boundary (i.e., the usually the point of contact between the contaminant source and the soil deposit),
these are zero flux, constant concentration, and finite mass. The bottom boundary (i.e., the point of
contact between the soil deposit and either a much more or much less permeable strata) may be either
zero flux, constant concentration, fixed outflow, or infinite thickness. 

1.1.5.1 Zero Flux Top Boundary

The top boundary may be assumed to not allow any transmission of contaminant (i.e. zero flux). This
option has some highly specialized applications and will be rarely used. The surface flux passing into the
soil is given by:

f (z=0) = 0 for all t

1.1.5.2 Constant Concentration Top Boundary

n this boundary condition the top boundary is assumed to maintain a constant concentration. The
concen� tration at the boundary is given by:

c (z=0) = c
s
 for all t

where c
s
 is the constant concentration at the top boundary.

1.1.5.3 Finite Mass Top Boundary

The top boundary may be assumed to have a finite mass, in which case the source concentration starts
at an initial value co, increases linearly with time at a rate cr, and then decreases with time as
contaminant is transported into the soil and collected by a leachate collection system, if present. The
gradual conversion of waste into leachate can also be considered by providing a conversion rate half-life. 

The concentration at the top boundary is given by:
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c(t) = c
0
 + c

r
 t - λ   c(τ) dτ - 1/H

r 
  f (c, τ) dτ - q

c
/H

r 
  c(τ) dτ + R

s
 /WC (1 - e-Κt)

where,
c

0
 = initial source concentration at the start time.

c
r
 = rate of increase in concentration with time due to the addition of mass to the landfill.

f(c, τ, z=0) = the surface flux (mass per unit area per unit time) passing into the soil at the top boundary.
q

c
 = the volume of leachate collected per unit area of the landfill per unit time, if there is no leachate

collection system q
c
=0.

λ = first order decay coefficient calculated based on the half-life specified in the Special Features,
Radioactive/Biological Decay option, such that λ = ln 2 /(half-life for decay).
R

s
 = mass of contaminant in the waste available to be transformed into dissolved form over time (per unit

volume of waste). The program calculates R
s
 as follows:

R
s
 = p ρ

w
 - c

0
 WC

where,
p = available (leachable) mass of contaminant in the waste per unit mass of waste (eg. mass of chloride
in waste/total mass of waste);
ρ

w
 = apparent density of the waste (i.e. mass of waste per unit volume of the landfill);

WC = volumetric water content of the waste.
κ = generation coefficient calculated based on the conversion rate half-life K, such that κ = ln 2 / K. A
value of κ = 0 implies no generation of concentration with time. In the program κ = 0 is obtained by
specifying K = 0 (this is the default case).

H
r
 = reference height of leachate, and represents the volume of leachate (per unit area of landfill) which

would contain the total mass of contaminant at a concentration co. And may be defined in one of several
ways depending on what other options are being used. Note that generally the program will calculate H

r

(i.e. the user will generally not input any value for Hr, but the user does have the power to override the
program).

Option (a). If the user specified K is not 0 and WC is not 0 then Hr = WC H
w
 and represents the actual

fluid in the landfill (generally WC corresponds to field capacity, but could vary with time).

Option (b). If the user specified K equals 0 or WC equals 0 then Hr = p ρ
W

 H
w
 / c

0
 and this represents

the volume of fluid (per unit area of landfill) required to dissolve the leachable mass of contaminant (i.e. p
ρ

W
 H

w
) at the initial concentration c

0
.

Option (c). If the user specifies H
r
 is not 0 then the user specified value overrides the values calculated

under option (a) or (b). This is an advanced feature of the program and should not be used without very
carefully checking your calculations.

If the rate of increase in concentration c
r
 is zero and the reference height of leachate H

r
 is very large, this

boundary condition reduces to a constant concentration boundary condition. 
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1.1.5.4 Zero Flux Bottom Boundary

The bottom boundary may be assumed to not allow any transmission of contaminant, which corresponds
to an impermeable base strata. The flux across the boundary is given by:

f (z=H
b
) = 0 for all t

where H
b
 is the depth of the base strata.

1.1.5.5 Constant Concentration Bottom Boundary

This boundary condition the bottom boundary is assumed to maintain a constant concentration. The
concentration at the boundary is given by:

c (z=H
b
) = c

b
 for all t

where c
b
 is the constant concentration at the bottom boundary and H

b
 is the depth of the bottom

boundary.

1.1.5.6 Fixed Outflow Velocity

The bottom boundary may be specified as fixed outflow to represent a base aquifer, where the
concentration varies with time as mass is transported into the aquifer from the landfill and transported out
from beneath the landfill by the base velocity v

b
. 

Consideration of the conservation of mass gives the base concentration as:

c(τ, z = H
b
) = [ f(τ, z=H

b
, c)/n

b
h

b
 - v

b
 c (τ, z=H

b
)/n

b
 L ] dτ

where,
c(τ, z=H

b
) = the concentration in the base aquifer, averaged over the entire thickness of the base,

f(τ, z=H
b
, c) = the mass flux into the aquifer,

n
b
 = porosity of the base aquifer,

h
b
 = thickness of the base aquifer,

v
b 

= Darcy velocity in the aquifer and down-gradient edge of the landfill,

L = length of the landfill parallel to the velocity v
b
.

Note that the use of a very large base velocity will give the same results at using a constant base
concentration of zero. If the base velocity is zero and the porosity is zero the bottom boundary is
effectively a zero flux boundary.

1.1.5.7 Infinite Thickness

The bottom boundary may also be of infinite extent, in this option the properties of the bottom most layer
are adopted for the infinite layer.
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1.2 Installation

To get POLLUTEv8 up and running, the program first needs to be installed on your computer. The
program can be downloaded from GAEA's website. There are two types of installation, single user and
network user. The installation sections below will explain how to perform both types of installations.

1.2.1 Single User Installation

Installation

When installing the program you must be logged in as an administrator.

The following steps occur during the installation:

· The application is installed on your computer
· Files for the databases and datastore are copied to your computer
· Shortcuts are placed on your Start menu and desktop

After the application has been installed, there are a few more steps before it is ready for use. The
datastore needs to be setup, a default basemap selected, and example projects can be imported. All
these steps are accomplished by running POLLUTEv8 for the first time. The program can be started
using the icon on your desktop or the POLLUTEv8 application menu on the Start menu. 

First-Run and Program Setup

The first time that the program is run you must be logged in as an administrator so that the
directories can be created.

When the program is started for the first time a setup wizard will run that guides you through the steps
below.

1. Selection of a single user or network user installation.
2. Select the industry that you will be using to register the software. The price, features, and settings in

the application will change depending on the industry selected.
3. After the above information is specified the databases and data store will be setup.
4. The next step is to specify a default basemap for the application.  
5. And the last step is to import any demo projects to help learn the application faster.

After the above steps are completed, the application will start initially in demo mode. You can use the
application in demo mode for up to 20 times before you need to register  it. 

Directory Permissions

The data for the application is stored in the database and data store directories. The location of these
directories will depend on the operating system and is defaulted to the common application data
directory. All of the users must have full read and write access to these directories. When
possible the install program will try to set the permissions of these directories properly.  For
administrative users this will not be a problem; however, limited users may need to be given permission
to read and write to these directories. The location and method of setting the permissions will vary with
the type of Windows operating system as described below.

Windows XP Home

27
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The default directory where the database and datastore directories are located for Windows XP is "c:
\Documents and Settings\All Users\Application Data\Pollute and Migrate8". Typically non-administrative
(limited) users may only have read access to this directory. To change the permissions on this directory
to grant limited users full control follow the steps below.

1. Log in as an administrator
2. In Windows Explorer browse to the directory "c:\Documents and Settings\All Users\Application Data"

and highlight the folder "Pollute and Migrate8".
3. Right click on the AutoReporting2 folder and select "Sharing and Security" from the popup menu, the

form below will be displayed.
4. On the Sharing tab check the boxes for "Share this folder on the network" and "Allow network users

to change my files".

Windows Vista and XP Professional

The default location for the database and data store files in Windows Vista is "c:
\Users\Public\Application Data\Pollute and Migrate8". Typically non-administrative (limited) users only
have read access to this directory. To change the permissions on this directory to grant limited users full
control follow the steps below.

1. Log in as an administrator
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2. In Windows Explorer browse to the directory "c:\Users\Public\Application Data" and highlight the
folder "Pollute and Migrate8".

3. Right click on the AutoReporting2 folder and select "Properties" from the popup menu, the form below
will be displayed.

4. On the Security tab make sure that the group "Everyone" has "Full Control" permissions.

Windows 8 and above

The default location for the database and data store files is "c:\ProgramData\GAEA\Pollute and
Migrate8". Typically non-administrative (limited) users may only have read access to this directory. To
change the permissions on this directory to grant limited users full control follow the steps below.

5. Log in as an administrator
6. In Windows Explorer browse to the directory "c:\ProgramData" and highlight the folder "Pollute and

Migrate8".
7. Right click on the AutoReporting2 folder and select "Properties" from the popup menu, the form below

will be displayed.
8. On the Security tab make sure that the group "Everyone" has "Full Control" permissions.
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1.2.2 Network Installation

The installation of the network version of the application on the server and client computers is described
in the section Network License Management .227
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1.3 Registration

POLLUTEv8 can be licensed on individual computers, a network, or a combination of both. When
licensed on a network the licensing is based on concurrent usage, where the number of concurrent users
must be less than or equal to the maximum number of users licensed. When the application it will run in
demo mode until it is licensed. 

The method for licensing will depend upon whether it is a single user or network installation. The
registration sections below discuss how to license POLLUTEv8 and how to transfer the registration.

1.3.1 Single User Registration

To license POLLUTEv8, a registration code must be entered. The registration code is based on the serial
number. This serial number is unique for each computer. The serial number can be obtained by running
the program and selecting the Tools > Manage Licenses. The License Manager form will be displayed
with a table that shows the current licensing. To get detailed information click on the program in the
table. The detailed information will be displayed to the right. 

To obtain the serial number and enter the registration code for POLLUTEv8, select the Pollute module in
the License Manager table and then click on the Register button on the toolbar at the top of the Manage
Licenses form. The Register form will then be displayed showing the unique serial number of the
module. 
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To obtain the registration code enter the invoice number you received when purchasing the software and
contact GAEA with the unique serial number. GAEA can be contacted either by clicking on the Obtain
Registration button or be emailing us at codes@gaeatech.com. When the Obtain Registration button is
used an email form will be displayed where you can enter your contact information and email it directly to
GAEA. 

After you receive the registration code from GAEA you can enter it on the Register form and then save it
by clicking on the Store Code button. The module should then show as licensed on the License Manager
form.

1.3.2 Network Registration

Prior to using the application on the client computers, the application should be registered on the server.
The registration on the server is handled through the Network Monitor program and is described in the
section on Using the Network License Manager . 230

mailto:codes@gaeatech.com.
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1.3.3 Transferring the Registration

If you need to transfer the license for a single user installation from one computer to another, follow the
steps below.

On the licensed computer

· select the Manage Licenses menu item from the Tools menu
· select the module that you wish to transfer the license on the License Manager form
· either click on the Relock button on the toolbar at the top of the form or select Relock from the popup

menu
· the Relock below form will be displayed 
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All of the information on this form needs to be filled in, including the file name. After the information is
entered click on the Relock button to email the relock file to GAEA. After the button is clicked the
Relock code will be displayed and the module will no longer be licensed on this computer.

On the new computer

After you have sent GAEA the relock file follow the instructions for single user registration  described
above.

1.3.4 File Entry of Registration Codes

The serial number can be exported to a file and emailed to GAEA. After the file has been processed a
registration file will be emailed back from GAEA. This registration file can then be imported and the
registration code saved. To export the serial number file, select the Pollute module on the License
Manager form and then click on the Export button on the toolbar of the form. The Export Serial Number
form will be displayed where you can enter the invoice number and your contact details. After you enter
the information you can either email the file directly to GAEA by clicking on the Email button or save it to
your disk and email it yourself by clicking on the Save button.

23
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After the file has been received and processed by GAEA you will receive a registration file back by email.
When you receive this file save it to your hard drive. To import the file click on the Import button on the
License Manager form and the Import Registration form will be displayed. Select the file you saved using
the Browse button on the form and the registration codes will be imported and saved by the program
when the Store Codes button is pressed.
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1.4 Using the Application

Login

All users must login to the application. When users are setup in the application they are assigned a
username, password, and user type (privilege). Different privilege levels are used to control access to
functions of the program and data. The different user types are administrator, power user, limited user,
and guest. For more information on setting up users see User Administration .

To have the application remember your user name and password, check remember credentials. The next
time the application is started you will not need to enter your login credentials. If you are using the
network to login, the Network Settings button can be used to change the network properties. When the
program is initially installed the default User name is "Admin" and the default password is "admin".

Initial Display

The initial display will consist of a Geographical Information System (GIS) or a list of projects depending
on your settings in Preferences. The GIS shows your existing projects and any GIS data. To the left of
the GIS the sidebar usually shows a list of your projects. And to the right of the GIS the sidebar usually
shows a list of layers, scale, and an index map. At the top of the display there are also toolbars and
menus for controlling and using the program. These are described briefly below and in detail in the
chapters throughout this manual.

219
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Menus

The main menu appears at the top of the screen and is composed of several submenus for Files, Tools,
and Help. Depending upon what is open at the time, an Edit submenu may also be present. The File
submenu is used  to create, open, and delete projects, models, and model templates; import and export
data; and set program preferences. Several types of tools are included in the Tools submenu for the GIS,
projects, symbol libraries, databases, units, and managing the program licenses..

In this User's Guide menu items and paths have been abbreviated to make it easier to understand. All
menu items are shown in blue italics and start with the uppermost menu then an arrow to the next menu
or menu item. For example, the Project menu item of the Open submenu of the File menu is abbreviated
as File > Open > Project.

A popup menu can also be displayed by clicking the right mouse button, the menu items in the popup
menu will vary depending on what is being displayed and where on the screen the mouse is clicked. In
this manual menu items that can be obtained from the popup menu are shown as Popup > menu item.

Toolbars

Initially two toolbars will be displayed, a Main toolbar and a GIS toolbar.

The Main toolbar is used to create, open, and close projects, questionnaires, and report templates. If a
project is open you can also create and open report responses and reports. In addition it can be used to
display different views, the help guide and exit the program.
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The GIS toolbar is used to access various features and functionality of the GIS. This toolbar is described
in the GIS section .

Sidebars

The sidebars can be on the left, right, or both sides and contain the contents described below.

Projects

The projects region has a Find Project toolbar and a list of projects. You can locate a project in the list
using the Find toolbar by entering the project name and pressing the Find button. The project will then be
highlighted in the project list and be zoomed to in the GIS. You can also zoom to a project in the project
list by selecting the Popup > Locate after the project has been highlighted in the list. 

To open a project using the Project List, highlight the project and then select Popup > Open or double-
click on it in the sidebar. If no project is selected, the Open Project form will be displayed. This form lists
the projects and lets you select one to open. 

For a detailed description of how to create and use projects see the section below and Chapter 3 .

Layers

The layers region lists the layers in the GIS. These layers can be turned on and off by checking and
unchecking the box beside the layer. The order of the layers in the sidebar controls the order in which
they are displayed in the GIS, with the layers at the top being drawn on the layers at the bottom.

Scale Bar

The scale bar displays the current scale of the GIS or project shown in the GIS window.

North Direction

The compass on the bottom right shows the current direction for North. When the application is started
this is at the top of the screen. To change the direction slide the bar to the left or right below the
compass. Sliding to the left will rotate the GIS windows to the West, sliding to the right will rotate to the
East. Double-click on the slider to adjust the display so that North is at the top of the screen again.

1.4.1 Geographic Information System

The Geographical Information System (GIS) is used to organize, find, and select projects. The
application can also be used with no GIS, in this case a list of projects is displayed instead. When the
GIS is being displayed it obtains its geographical data from a Web Map Service.

The display of the GIS and default Web Map Service is specified in the Preferences .

35
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1.4.1.1 Web Map Services

Web map services use a standard protocol to serve georeferenced map images over the Internet. This
protocol was developed and published by the Open Geospatial Consortium. Several web map services
are available within the application and more are being added with each update. 

1.4.1.1.1  Selecting Web Map Services

The web map service displayed for the GIS can either be selected from the GIS toolbar or in File >
Preferences. If it is selected in Preferences it will be the default web map service and will be shown every
time the application is started. When it is selected from the GIS toolbar it will be effective only until it is
changed again or the application is closed.  New web map services are being added all the time. If you
would like to have a web map service added that is not in the list please contact us.

Before displaying the web map service the application checks to see if there is an Internet connection. If
there is no connection a list of projects will be displayed.

1.4.1.1.2  Adding a Web Map Service

Additional custom web map services (WMS) can be added to the application by selecting Tools > GIS >
Add Web Map Service. The form below will then be displayed. A custom web map service can be used
to add user subscribed services such as First Base Solutions ( a Canadian based service for high
resolution orthoimagery).

The following information can be specified on this form:

Name: This is the name of the custom WMS. It will be displayed when selecting a WMS from the GIS
toolbar.

URL: This is the URL for the custom WMS. The URL is usually specified by the service provider.

Copyright: This the copyright for the custom WMS. It will be displayed on the status bar at the bottom
of the screen.
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1.4.1.2 Using the GIS

The display of the GIS can be controlled using the GIS toolbar and compass control as described in the
sections below. The use of the GIS to create and locate projects is described in the Chapter 3.

1.4.1.2.1  GIS Toolbar

The GIS toolbar can be used to adjust the basemap display; find, identify and select features.The
controls on this toolbar depend on whether the basemap is a static basemap or web map service.

Full Extent

The Full Extent button will display the full extent of the GIS or project

Zoom In

The Zoom In button is used to zoom in to a smaller scale on the GIS. 

Zoom-out

The Zoom Out button is used to zoom out to a larger scale on the GIS. 

Dynamic Zoom

The Dynamic Zoom button can be used to zoom in and out using the mouse. 

To zoom in 
1. Click on the View/Zoom mode menu item.
2. Within the Map area choose a rectangular area to which you would like to zoom in.
3. Move the mouse pointer to the top left corner of the area and press the left mouse button.
4. Move the mouse pointer to the bottom right corner of the area and release the left mouse button.

To zoom out 
1. Click on the View/Zoom mode menu item.
2. Within the Map area decide how large should be the area containing the currently visible extent and where it should be located after zooming out.
3. Move the mouse pointer to the bottom right corner of this area and press the left mouse button.
4. Move the mouse pointer to the top left corner of this area and release the left mouse button.
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Drag

The Drag button is used to move the visible area on the screen. To move the visible area click on the
screen and while holding the mouse button down move the cursor in the desired direction to see that
area displayed.

Select Feature

The Select Feature button can be used to select a feature on the map. To select a feature click on the
button and then click on the feature on the map. The attributes of the selected feature will then be
displayed as shown below.

Display Hints

The Display Hints button can be used to select the layer and field used for hints. These hints can
optionally be displayed when the mouse is over a feature on the map. For example, when the mouse if
over a project the hint could display the project name. When the button is pressed the Map Hint
Properties form below will be displayed. This form can be used to specify whether hints are shown, the
hint color, layer and field to use for the hint.
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Search

The Search button can be used to search for features on the map that meet a specified criteria. When
this button is pressed the Search form below will be displayed. This form can be used to specify the
layer, field. and search criteria. When the Search button on this form is pressed any features that meet
this criteria will be momentarily highlighted.

Web Map Service

This drop down list can be used to select the current web map service being displayed. 

North Arrow
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The North arrow on the GIS can be turned on and off using the North Arrow button. The color of this arrow
is specified in Preferences .

Find Address

Addresses can be located on the GIS by clicking on the Find Address button. The form below will be
displayed and can be used to find addresses by street address, latitude and longitude, or UTM
coordinated.

Find Address at a Point

The address of a point on the GIS can be displayed using the find address at a point button. After this
button is clicked, click on the point on the GIS and the address will be displayed.

Find Elevation at a Point

The elevation of a point on the GIS can be displayed using the find elevation at a point button. After this
button is clicked, click on the point on the GIS and the elevation will be displayed.

Measure Distance

52
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Distances can be measured on the GIS using the Measure Distance tool on the GIS toolbar. When this
tool is selected the Ruler control below will be displayed. The distance units can be set using the drop
down list on the right. To measure a distance click on the first point and then click on the second. To
hide the Ruler control click on the Measure Distance tool again.

Measure Area

Areas can be measured on the GIS using the Measure Area tool on the GIS toolbar. When this tool is
selected the Ruler control below will be displayed. The area units can be set using the drop down list on
the right. To measure an area click on the first point and then click on the next points. To hide the Ruler
control click on the Measure Area tool again.

Street View

A street view for a point on the GIS can be obtained by clicking on the down arrow of the Street View
button and selected either Google or Bing. Then click on the point on the map to display the street view
in the Street View form. Additional street views can be displayed by closing the form and clicking on
other points on the map.
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The following can be specified on this form:

Width: This is the width of the image in pixels.

Height: This is the height of the image in pixels.

Heading: This is the heading from North of the image.

Pitch: This is the vertical pitch on the image. Positive values are up and negative values are down.

Field of View: This is the field of view of the image 

After the parameters above have been changed use the Refresh button to update the image. To save the
image to a JPEG file click on the Save button and specify the file name.

Overlay Grid
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If a local project is open, the overlay grid button on the toolbar can be used to overlay a grid on the
project. When this button is pressed the Project Grid form is displayed. 

The following can be specified on this form:

Show Grid: Check this box to overlay a grid.

Horizontal Grid Spacing: This is the horizontal spacing between grid lines in local units.

Starting Value: This is the horizontal start value for the grid.

Vertical Grid Spacing: This is the vertical spacing between grid lines in local units.

Starting Value: This is the vertical start value for the grid.

Line Style: This is used to select the  line style for the grid lines.

Line Color: Press this button to select the color for the grid lines.
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1.4.1.2.2  Compass Control

The compass on the bottom right shows the current direction for North. When the application is started
this is at the top of the screen. To change the direction slide the bar to the left or right below the
compass. Sliding to the left will rotate the GIS windows to the West, sliding to the right will rotate to the
East. Double-click on the slider to adjust the display so that North is at the top of the screen again.

1.4.2 No GIS

If no GIS is specified in Preferences the main window will display a list of projects as shown below.  A
project can be opened by double-clicking it in the list or by highlighting it and selecting Popup > Open. 
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1.5 Preferences

To set the program preferences no project can be open. Select File > Preferences. The Preferences form
will be displayed. This form has a list of preference categories on the left side and the details of the
selected category are displayed on the left. Each of the categories are described in the sections below.
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1.5.1 Appearance

The following can be edited in the Appearances category:

User Interface

Display new object prompts: Check this box to display prompts for new objects.

Open last project: Check this box to open the last opened project when the program is started.

Activate undo: Check this box to activate the undo feature so that some operations can be undone.

Status bar: Check this box to display a status bar on the main form.

Maximize form: Check this box to maximize some forms when they are displayed.

Show toolbar button text: Check this to show the text on buttons.

Projects
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Show Project Boundary: Check this box to show the project boundary when a project is opened.

Project Margin: This is used to specify the margin between the project display and the project boundary
as a percentage of the display width. The larger the margin the larger the area outside of the project
boundary will be displayed.

Line Style: Click this button to change the line style, width, and color of the boundary line.

Look up new project addresses: Check this box to look up the project address when a new project is
created using the GIS.

1.5.2 Backups

The following can be edited in the Backups category:

Main Database

Backup main database: If this checkbox is checked then the main databases will be backed up at
regular intervals. If this checkbox is not selected then the main databases will not be backed up.
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Interval: This is used to select the interval to use when backing up the main databases.

Number to maintain: This is the number of backups to maintain, older backups will be deleted.

Project Databases

Backup project database: If this checkbox is checked then the currently open project will be backed
up at regular intervals. If this checkbox is not selected then the currently open project will not be backed
up.

Interval: This is used to select the interval to use when backing up the project database.

Number to maintain: This is the number of backups to maintain, older backups will be deleted.

Backup on Project Close: Check this to create a backup of the project when it is closed.

1.5.3 Company
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Company information is used in different parts of the application for addressing emails, creating sample
labels, etc. The following can be edited in the Company category:

Company Name: This is your company name. 

Contact Name: This is the contact name to use in correspondence from the application.

Phone Number: This is the phone number for the company.

Fax Number: This is the fax number for the company.

Email: This is the main email address for the company.

Street 1: This is the first line of the street address.

Street 2: This is the second line of the street address.

City: This is the city for the company.

State: This is the state or province for the company.

Country: This is the country for the company.

Postal Code: This is the postal or zip code for the company.
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1.5.4 Datasources

The following can be edited in the Datasources category (these features should not be changed without
consulting your database administrator):

Database Provider: This is used to select the type of database. Currently, only Microsoft Access is
supported.

User name: This is the user name for the main database. Normally, it should be Admin.

Password: This is the password for the main database. Normally, it is blank.

Path: This is the path to the main database.

Show Folder: Click this button to show the database folder

Datastore folder: This is the folder containing the datastore.

Show Folder: Click this button to show the datastore folder.
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1.5.5 Defaults

The following can be edited in the Defaults category:

Default printer: This is used to select the default printer to use in some modules.

Location Precision: This is the precision (number of decimal places) to use when displaying location
information.

Depth Precision: This is the precision (number of decimal places) to use when displaying depth
information. 

Decimal Degree Precision: This is the precision (number of decimal places) to use when displaying
decimal degrees. 
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Dictionary: This is used to select the dictionary to use for some modules when performing spell
checking. One of the following dictionaries can be selected: American, British, Dutch, English, French,
German, Italian, and Spanish.

Resolution: This is the resolution to save images in the datastore. The resolution can be set to low (100
dpi), medium (300 dpi), or high (600 dpi). These images are used when displaying or printing a page
document. Typically, low or medium is sufficient. The higher the resolution the more disk space and time
is required when images are saved.

Character Set: This is used to select the character set used by some modules. Normally, the default
character set can be used.

Default Local Units: This is used to select whether to use feet or meters for the default local units.

1.5.6 GIS
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The following can be edited in the GIS category:

Basemap

Type: Select the type of basemap to use for the default. The type of basemap can be a web map service
or none. 
 
Default Basemap: This is the basemap to use for a web map service. 

Initial Display

This is used to select the initial display when the application is started. It can either show an area around
where you are located based on your Internet IP, an area showing the extent of all of your projects, or an
area based on the address specified on the Company tab..

GIS Display

Show GIS Sidebar: Check to show the GIS sidebar.

Show Compass: Check to show the GIS compass.

Display Units: This is used to select the units for the current cursor location shown in the status bar at
the bottom of the display.

Map Scale

Number of Dividers: This is the number of dividers in the scale bar.

Divider Color 1: Click this button to change the color of the first divider in the scale bar.

Divider Color 2: Click this button to change the color of the second divider in the scale bar.
 
North Arrow

Color: Click this button to change the color of the North arrow on the map.
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1.5.7 Internet

The following can be specified for the Internet category:

Incoming Email Settings

Incoming email settings are not currently used by the program.

Host: This is the name of the host for incoming emails.

Port: This is the port to use for incoming emails.

Username: This is the username to use for incoming emails.

Password: This is the password to use for incoming emails.

Use TLS/SSL: Check this to use TLS or SSL for incoming emails.

Test Settings: Click this button to test the incoming email settings.

Outgoing Email Settings
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Outgoing email settings are used to send email.

Host: This is the name of the host for outgoing emails.

Port: This is the port to use for outgoing emails.

Username: This is the username to use for outgoing emails.

Password: This is the password to use for outgoing emails.

Use TLS/SSL: Check this to use TLS or SSL for outgoing emails.

Test Settings: Click this button to test the outgoing email settings.

FTP Settings

FTP settings are used to send data directly to FTP.

Server: This is the name of the FTP server.

Port: This is the port to use for the FTP server.

Username: This is the username to use for the FTP server.

Password: This is the password to use for the FTP server.

Test Settings: Click this button to test the FTP settings.
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1.5.8 Maintenance

The following can be edited in the Maintenance category:

Application Updates

Check for updates: Check this box to automatically check for program updates on the Internet.

Schedule: Select the schedule to check for program updates.

Application Maintenance

Perform maintenance tasks: This is used to select whether to perform maintenance tasks.

Delete expired cache objects: Check this box to delete cache images of objects when maintenance is
performed.

Check for unassociated projects: Check this box to find and delete projects that are in the project
database but not in the project list.

Schedule Tasks: Select the schedule to perform maintenance.
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Perform every: If the schedule is custom, this is used to specify the number of days between
maintenance tasks.

Run now: Click this button to run maintenance tasks now.

1.5.9 Network License

The following can be edited in the Network License category (these features should not be changed
without consulting your database administrator):

Networked:  This is used to indicate whether the program and licensing is running from a central
database and server.

Network Settings

Name or IP Address: This is the name or IP address of the server. 

Port Number: This is the port number for the server. If the program is not networked it will be disabled. It
should be set to 3002.
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Request network licenses for: This is the modules to request licenses from the server.

Clear auto-login: Click this button to clear the auto-login file. The next time you login you will be
required to enter a username and password.

1.5.10 Pollute

The following can be specified for the Internet category:

Defaults

Time Units: This is the default time units to use when creating a model.

Depth Units: This is the default depth units to use when creating a model.

Concentration Units: This is the default concentration units to use when creating a model.

Symbol Library: This is the default symbol library to use when creating a model.
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Layer Defaults

Number of Sublayers: This is the default number of sublayers to use when adding a layer.

Porosity: This is the default porosity to use when adding a layer.

Thickness: This is the default thickness to use when adding a layer.

Dry Density: This is the default dry density to use when adding a layer.

Dispersion Coefficient: This is the default dispersion coefficient to use when adding a layer.

Subsurface Image

Draw text leaders: Check this box to draw leader lines from the text to the layers.

Width: This is the width of the image in pixels.

Height: This is the height of the image in pixels.

Leader Line Style: Press this button to select the line style for the leader lines.

Layer Line Style: Press this button to select the line style for the layers.

Model Title Font: Press this button to select the font for the model title.

Model Text Font: Press this button to select the font for the model text.

Results

Default Display: This is the default display to use for the results.
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1.6 Symbol Libraries

Libraries are used to store symbols that can be used for layers and boundaries. Libraries contain 18
symbols each, the program comes with several previously defined libraries. In addition, any number of
new libraries can be created, making the number of symbols available unlimited. Each symbol also has a
default symbol description stored in the library, which is used when selecting the symbol. 

1.6.1 Creating a Library

Libraries can be created and edited at any time (no project has to be open). To create a library select
Tools > Symbol Libraries > New. After this the Create New Symbol Library form will be displayed. 

The following information can be entered on this form:

Unique Library ID: This is a unique id or name for the library (up to 100 characters).

Name: This is the name of the library (up to 255 characters).

After the above information has been entered a blank library will be created and displayed. This library
will contain 18 blank symbols and descriptions, which can be edited  as discussed below.61
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1.6.2 Editing a Library

To edit a library, the library must first be created as described above or an existing library opened.
Existing libraries can be opened for editing by selecting Tools > Symbol Libraries > Open. After this the
Open Library form will be displayed. 

Select the library to open and press the Ok button. After the library has been opened and displayed, the
library can be edited as described in the sections below.
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1.6.2.1 Symbols

Each library can contain up to 18 symbols. The symbols in the library can be edited by clicking on them.
After this the Edit Bitmap form will be displayed.
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At the top of this form the symbol description can be entered. Underneath the description the bitmap of
the symbol is displayed. The buttons at the top of the form can be used to edit the bitmap as described
below.

The Clear button is used to erase the entire symbol.

The Import Picture button is used to import a bitmap picture from a file into the current symbol. When
this button is pressed, the Open bitmap form will be displayed. Select the bitmap file to import and then
press the Open button.

The Erase button is used to delete parts of the symbol. When this button is pressed the cursor will
change to an eraser. To erase a part of the symbol, hold the left mouse button down and move the cursor
over the area to be erased.
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The Curve button is used to draw a curved line on the symbol. When pressed the cursor will change to a
pencil. To draw a curve, hold down the left mouse button and move the mouse. When finished drawing
the line, release the mouse button.

The Line button is used to draw a straight line on the symbol. When pressed the cursor will change to a
pencil. To draw a line, press and hold down the left mouse button at the start of the line. Move the mouse
to the end of the line and release the mouse button.

The Rectangle button is used to draw a hollow rectangle on the symbol. When pressed the cursor will
change to a cross. To draw a rectangle, press and hold down the left mouse button at the upper left
corner of the rectangle. Move the mouse to the lower right corner of the rectangle and release the mouse
button.

The Ellipse button is used to draw a hollow ellipse on the symbol. When pressed the cursor will change
to a cross. To draw an ellipse, press and hold down the left mouse button at the upper left corner of the
ellipse. Move the mouse to the lower right corner of the ellipse and release the mouse button.

The Undo button is used to undo the previous edit operation.

1.6.3 Deleting a Library

To delete a library, select Tools > Symbol Libraries > Delete. The Delete Libraries form will be displayed.
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A single library can be selected by clicking on it and pressing the Ok button. 
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1.7 Units

Various types of units are used throughout the application. The precision and conversion of these units
are described in the sections below.

1.7.1 Unit Precision

The precision (significant digits) used in the display of the units used in the application can be adjusted
by selecting Tools > Units > Unit Precision, the Unit Precision form will be displayed.

To adjust the precision for a set of units, select the type of units and then change the precision for the
unit. If the precision is specified as -1 then the precision (significant digits) is assumed to be infinite.

1.7.2 Unit Conversion

Values can be converted from one set of units to another using the unit conversion function by selecting
Tools > Units > Conversion, the Unit Conversion form will be displayed.
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To convert a value select the type of units and then the input and output units. Then enter the input value
(value to be converted) and press the Convert button. The converted value will be displayed using the
number of significant digits specified for the type of units.
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1.8 Clear Recent

The program stores a list of recently opened projects and models. To clear this list select Tools >
Recently Opened > Projects or Tools > Recently Opened > Pollute Models.
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1.9 Help and Support

GAEA Technologies strives to make this application easy to use and learn. Several tools and features
are provided to assist the user to learn the program and when necessary get technical support. These
features can be found in the Help menu of the main menu and are described below.

1.9.1 Help System

In addition to the User's Guide in PDF format, context sensitive help can be found within the application.
The help system can be displayed by either selecting Help > Contents or clicking on the Help button on
a form. When the Help button on a form is used, the help displayed will be specific to that specific form.

1.9.2 Technical Support

Customers with a current technical maintenance agreement can receive technical support by selecting
Help > Email Technical Support. This is the preferred method of obtaining technical support since it
provides us wit the maximum amount of information and data concerning your problem. Before emailing
technical support you will need to provide the outgoing email settings in preferences  for the email to
be sent by the application.

The following is displayed and/or edited on this form:

Company: This is your company or organization name that has the license for the program.

Name:  This is your name.

54
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Email: This is your email address.

Phone: This is your phone number.

Operating System: This is Windows operating system of the computer. It is automatically filled in by
the application and can not be changed.

Modules: This is a list of the modules, versions, licenses, and networking for the application. It is filled in
automatically by the application and can not be changed.

Main Database: Check this to attach the main database for the application. It include project
boundaries, templates and project documents. It is highly recommended that this database is included in
your email. 

Project Database: If a project is opened, this will be displayed. Check this to include the project
database with your email. If your problem involves project specific data (boreholes, cross-sections,
samples, etc.) please include this database.

Error: This is brief description of the error that will be shown in the subject of the email.

Description: This is a detailed description of the error or problem. Please provide as much information
as possible.

1.9.3 Updates

Updates to the program are periodically published online and can be installed by selecting Help > Check
for Updates. If an update is available from the Internet, you will be asked whether to install it or not. We
strongly recommend you install all updates.
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Chapter 2 Templates

Templates are a new feature in version 8 and are used to create predefined models and format the output
(charts and listings) from the models. The program comes with several predefined templates for
POLLUTEv8; these include a blank (empty) model, primary landfill, primary and secondary landfill,
vertical migration, and horizontal migration. These templates form the underlying base templates of all
templates.

By using templates models can be created quickly with a minimum amount of data entry. The models
created can have their data edited as required. New templates can be created from existing templates or
models.
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2.1 Creating a Template

A new template can be created from either an existing template or model.

2.1.1 Creating from an Existing Template

To create a new template from an existing template, open the template then click on the SaveAs button.
The Save As form will then be displayed. Enter a unique new name and then click on the Ok button to
create the new template.

When the new template is saved the graph and listing options will also be copied. In addition, the
underlying base template will also be set the same as the original template.

2.1.2 Creating from an Existing Model
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To create a new template from an existing model, open the model then click on the SaveAs button. The
Save As form will then be displayed. Enter a unique new name, check the Save As Template box, and
then click on the Ok button to create the new template.

When the new template is saved the graph and listing options from the original template will also be
copied. In addition, the underlying base template will also be set the same as the original template.
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2.2 Opening a Template

To open an existing template make sure no project is open and then select File > Open > Pollute
Template. The Open Pollute Template form will be displayed.

Select the template to open and then click the Open button.
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2.3 Editing a Template

After a template has been opened, the model data and output options can be edited. On the left side of
the form is the model data and on the right side is the model output.

The model data in the template will be used as the initial data for any model created with the template.
This data can be further edited in the actual model. The editing of the model data is described in detail in
the Models chapter.

Model output can be displayed in a variety of charts and in a list. The options and formatting of these
charts and listing is specified and saved in the template. The editing of the charts and listing formats and
options is described in the sections below.

After the editing is complete, click on the Save button to save the changes.

 

2.3.1 Editing Chart Formating and Options

The output from a model can be displayed in several types of charts depending on the special features
selected. These charts include:

· Depth vs Concentration
· Concentration vs Time
· Concentration vs Depth vs Time
· Depth vs Time
· Flux vs Time

or if the Monte Carlo or Sensitivity special features are selected:
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· Probability vs Concentration
· Probability vs Time
· Probability vs Variable Value

2.3.1.1 Editing Chart Formating

The format of the chart can be edited by clicking on the Edit button on the Graph tab. The Editing Chart
form will be displayed.

This form shows a tree view on the left containing the various sections of the chart that can be formatted.
On the right are the options for the selected section. The editing of each of these sections is described
below.
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2.3.1.1.1  Editing the Series Format

The chart series can only be edited when editing a model. This section is ignored when editing a
template. 

The section will display a list of the data series currently in the chart. In the following charts the series
will be line series:

· Depth vs Concentration
· Concentration vs Time
· Flux vs Time
· Probability vs Concentration
· Probability vs Time
· Probability vs Variable Value
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In the Concentration vs Depth vs Time chart the series will be a surface. And in the Depth vs Time chart
the series will be a color grid. 

It is recommended to only edit the Chart Line Options  and Chart Grid Options  to control the
format for the series.

2.3.1.1.2  Editing the Chart Format

This section is used to edit the format of the chart. 

The sub-sections can be edited by clicking on them in the tree view on the left or the tabs at the top. The
editing of the most pertinent sub-sections is described below.

85 86
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The chart title can be formatted using the Titles sub-section. Several tabs control the format of the title
and are described briefly below.

The following are some of the most pertinent items that can be edited:

Position Tab

Vert. Margin: This is used to specify the margin between the title and chart.

Options Tab

Visible: Check this to show the title on the chart.

Alignment: This is used to select the alignment of the title relative to the chart.

Text Tab

Text: This is the title to show for the chart. If the text contains [Model Title], the model title used for the
actual model will be substituted. For the Probability vs Concentration chart if the text contains [Max
Conc], the maximum concentration for the model result will be substituted.  For the Probability vs Time
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chart if the text contains [Max Time], the time of the maximum concentration for the model result will be
substituted.  For the Probability vs Variable Value chart if the text contains [Expected Value], the
expected value of the variable for the model result will be substituted. 

Format Tab

Font: This is used to set the font for the title.

The axes can be formatted using the Axis sub-section. When this sub-section is expanded each axis
can be selected for formatting. The Depth Right and Depth Top axes are used for 3D charts. Several tabs
control the format of the each axis and are described briefly below.

The following are some of the most pertinent items that can be edited:

Scales Tab

Automatic: Check this to automatically calculate the axis minimum and maximum values based on the
data.
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Visible: Check this to show the axis on the chart.

Title Tab

Title: This is the title to show for the axis. If the text contains [units], the data units will be substituted. 

Angle: This is the angle of title relative to the horizontal.

Position: This is the position of the title along the axis.

Font: This is used to set the font for the axis title.

Labels Tab

Visible: Check this to show the tick labels on the axis.

Angle: This is the angle of tick labels relative to the horizontal.

Min. Separation %: This is used to specify the minimum separation between labels. A value between
20 and 40% is recommended.

Font: This is used to set the font for the tick labels.

Ticks Tab

Outer Visible: Check this to show ticks at the labels.

Outer Length: This is used to specify the length of the ticks used for the labels.

Outer Color: This is used to select the color of the ticks used for the labels,

Minor Visible: Check this to show minor ticks between labels.

Minor Length: This is used to specify the length of the minor ticks.

Minor Color: This is used to select the color of the minor ticks.

Grid Tab

Visible: Check this to show the grid related to the axis.

Color: This is used to select the color of the grid lines,

Style: This is used to select the style of the grid lines.

The chart legend can be formatted using the Legend sub-section. Several tabs control the format of the
legend and are described briefly below.
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The following are some of the most pertinent items that can be edited:

Style Tab

Visible: Check this to show the legend on the chart.

Check boxes: Select check boxes to display a check box beside each series in the legend to turn on
and off the display of the series in the chart.

Position Tab

Position: This is used to select the location of the legend relative to the chart.

Margin: This is used to specify the distance between the chart and the legend.

Title Tab

Visible: Check to show the title in the legend.

Text: This is the title to show in the legend.
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Text Alignment: This is used to select the horizontal alignment for the legend title.

Font: This is used to set the font for the legend title.

2.3.1.1.3  Editing the Chart Data

This section can be used to preview the data in the chart. This section is not shown when editing a
template.

The data shown is the result of the model execution and it is not recommended that the data be edited in
this section. Any edits will only be shown on the chart and not be saved.

2.3.1.1.4  Editing the Print Preview

This section can be used to preview and print the chart. This section is not shown when editing a
template.
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2.3.1.2 Editing Chart Line Options

If the chart type is not Concentration vs Depth vs Time or Depth vs Time, the chart is displayed as series
of lines. The line options can be edited by pressing the Options button on the Graph tab. The Chart
Options form will be displayed.
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The following can be edited on this form:

Line Width: This is used to select the width of the lines.

Line Colors: This is used to select the colors of each of the line series. When the color is clicked on, a
combo box is displayed that can be used to select a color.

Show Data Values: Check this to show the data values for the line series.

2.3.1.3 Editing Chart Grid Options

If the chart type is Concentration vs Depth vs Time or Depth vs Time, the chart is displayed as a grid and
the grid options can be edited by pressing the Options button on the Graph tab. The Chart Options form
will be displayed.



Chapter 2 Templates 87

© 2021 GAEA Technologies Ltd.

The following can be edited on this form:

Interpolate Data: Check to interpolate the data for the grid. This will interpolate between data values to
create a finer grid mesh.

Number of Interpolations: This is used to specify the number of interpolations between data values.
The higher the number of interpolations the finer the grid mesh. Generally, a value between 2 and 4 is
recommended.

Start Color: This is used to select the start color for the lowest concentration in the grid.

End Color: This is used to select the end color for the highest concentration in the grid.

Number of Steps: This is the number of steps (intervals) in color between the start and end colors.

Grid Visible: Check to make the grid lines visible.

Grid Color: This is used to select the color of the grid lines.

2.3.2 Editing Listing Formating and Options

The output for a model can also be displayed in a listing. Options for the listing can be edited by
pressing the Options button on the List tab. The List Options form will be displayed.
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The following can be edited on this form:

Table Header Color: Press this button to change the color for the background of table headers.

Program Font: Press this button to change the font used for the program name in the listing.

Title Font: Press this button to change the font used for the title in the listing.

Section Title Font: Press this button to change the font used for the section titles in the listing.

Normal Font: Press this button to change the font used for the normal text in the listing.



Chapter 2 Templates 89

© 2021 GAEA Technologies Ltd.

2.4 Deleting a Template

To delete an existing template make sure no project is open and then select File > Delete > Pollute
Template. The Delete Pollute Template form will be displayed.

Select the template to delete and then click the Delete button.



POLLUTEv890

© 2021 GAEA Technologies Ltd.

2.5 Exporting a Template

To export an existing template to an XML exchange file, make sure no project is open and then select
File > Export > Pollute Template. The Export Pollute Template form will be displayed.

Select the template to export and then click the Export button.



Chapter 2 Templates 91

© 2021 GAEA Technologies Ltd.

2.6 Importing a Template

To import a template from a previously exported XML exchange file, select File > Import > Pollute
Template. The Import Pollute Template form will be displayed,

Select the XML exchange file containing the template, then click the Open button. For the template to be
imported, the imported template name must not already exist in the program.
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Chapter 3 Projects

Projects are the primary building block of POLLUTEv8 and are used to encapsulate all the data in the
application. The sections below describe how to manage projects, import data into projects, and export
data from projects.

The initial display of POLLUTEv8 will consist of a basemap (or project list) and sidebars on the left and
right. The basemap shows your existing projects and any GIS data contained in the web map service. To
the left of the basemap, the sidebar usually shows a list of your projects. And  the right sidebar usually
shows a list of layers in the basemap and an index map. Prior to use projects must either be created or
imported. After this they can be selected from the basemap or sidebar and edited. 

On the project tree sidebar, projects can be grouped into categories and subcategories. These groupings
can be used to sort projects by things such as year, office, and client. The creation and editing of these
categories and subcategories is described in the section on editing project categories  below. In
addition, the most recently opened projects are grouped at the top of the project tree.

Projects can be assigned to a category or subcategory when they are created  or edited.

118
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3.1 Creating a Project

There are two types of projects, georeferenced or local. Georeferenced projects have GIS based
coordinates, normally in decimal degrees, and can be seen on basemaps.Whereas, local projects have
coordinates in feet or meters and are not shown on basemaps.

Georeferenced Project

If the project is to be georeferenced, the area of the basemap where the project is located should be
zoomed in on first before creating the project. To assign the project to a category or subcategory on the
project tree, highlight the category or subcategory first and then create the project. To create a new
georeferenced project either select File > New > Project > Georeferenced or click the New button on the
main toolbar and select Project > Georeferenced. 

After this you will need to specify the boundaries of the project on the basemap. To do this click the left
mouse button at each of the points on the project boundary, then double click or right click when done.
Projects can be square or polygonal. The New Project form will then be displayed. This form has four
tabs for a georeferenced project as described in the sections below. 

Local Project

To create a new local project either select File > New > Project > Local or click the New button on the
main toolbar and select Project > Local.  The New Project form will then be displayed. This form has
three tabs for a local project as described in the sections below. 
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3.1.1 Project Info Tab

The following information can be specified on this tab:

Project Number: This is the unique project number.

Project Name: This is the name of the project.

Set Password: Check this box to set a password for the project.

Password: If Set Password is checked the password can be specified, 

Client ID: This is an optional client identification.

Client Name: This an optional client name.

Address: This is the street address of the project.
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City: This is the city of the project.

State/Province: This is the state or province of the project.

Country: This  is the country of the project.

Postal/ZIP Code: This is the postal or ZIP code of the project.

3.1.2 Boundary Tab

This tab is shown for georeferenced projects only and used to specify the georeferenced boundary
points.
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The default coordinate system for georeferenced projects is the WGS 84 geographic system. Alternate
geographic or projected coordinate systems can be selected; however, the coordinates stored in the
database will be in the default system.

Coordinate System

Geographic System: Select this to specify the boundary in geographic coordinates.

Projected System: Select this to specify the boundary in projected coordinates.

Coordinate System: This is used to select the geographic or projected coordinate system.

Degrees Minutes Seconds: If the selected coordinate system is geographic, select this to specify the
coordinates as degrees, minutes, and seconds.

Decimal Degrees: If the selected coordinate system is geographic, select this to specify the
coordinates in decimal degrees.

Boundary Points

Longitude: If it is a geographic coordinate system, this is the longitude of the boundary point in either
decimal degrees or degrees, minutes, and seconds.

Latitude: If it is a geographic coordinate system, this is the latitude of the boundary point in either
decimal degrees or degrees, minutes, and seconds.

X Coordinates: If it is a projected coordinate system, this is the x coordinate of the boundary point.

Y Coordinates: If it is a projected coordinate system, this is the y coordinate of the boundary point.

Add Point: Press this button to add a point to the boundary.

Delete Point: Press this button to delete the selected boundary point.

3.1.3 Local Coordinates Tab

The information on the local coordinates tab will depend on whether it is a local or georeferenced project.

3.1.3.1 Georeferenced

If the project is a georeferenced project the map coordinates will be in decimal degrees. For display in 3D
local coordinates in either feet or meters will need to be assigned. Changing the local coordinates for a
project after it has been created is not advisable using this tab, since only project coordinates will be
changed and not the model coordinates. If it is necessary to change the coordinates after models have
been created the Assign Local Coordinates  function should be used. 108
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The following information can be specified on this tab:

Local Units: Select either feet or meters.

Reference Corner: Select the corner of the project to use as a reference. The x and y coordinates
below will be assigned to this corner.

X Coordinate to Corner: This is the x coordinate of the reference corner.

Y Coordinate to Corner: This is the y coordinate of the reference corner.

3.1.3.2 Local

If the project is a local project the coordinates will be either feet or meters. Changing the local
coordinates for a project after it has been created is not advisable using this tab, since only project
coordinates will be changed and not the borehole or well coordinates. If it is necessary to change the
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coordinates after boreholes or wells have been created the Assign Local Coordinates  function should
be used. 

The following information can be specified on this tab:

X-Coordinate: This is the x-coordinate of the boundary point.

Y-Coordinate: This is the y-coordinate of the boundary point.

Local Units: Select either feet or meters. These can only be changed when the project is created.

On the right side of the tab there are buttons to add and delete points. 

108
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3.1.4 Category Tab

Highlight the category or subcategory to assign the project to on the project tree.
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3.2 Locating a Project

Georeferenced projects can be located on the basemap by clicking on the project in the sidebar and then
selecting Popup > Locate. The basemap will then be zoomed in so that the project can easily be
identified.
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3.3 Opening a Project

Projects can either be opened by selecting them from a list or selecting them on the sidebar.

Selecting from the Sidebar

To select the project from the sidebar either click on it once and then select Popup > Open or double-
click on the project on the sidebar.

Selecting from a List

To select the project from a list either select File > Open > Project or click on the Open button on the
main toolbar and select Project. The Open Project form below will then be displayed.

On the left of this form are lists of the most recently opened projects and of all the projects. On the right
side of the form the details of the highlighted project are shown, some of these details are not shown for
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the most recent projects. At the top of the form is a toolbar that can be used to find a project by
specifying the project number. To select a project to open, highlight it and then click on the Open button.
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3.4 Editing a Project

If the project is georeferenced the GIS will show the selected web map service and project boundary;
otherwise, for local projects only the project boundary is shown. The project is also used to create and
open models.

The project information, local coordinates, category, and address can be edited by selecting Edit >
Project Information. The Project Information form will be displayed and can edited as described in
Creating a Project .94
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3.5 Deleting a Project

An existing project can be deleting by selecting File > Delete > Project. The Delete Project form below
will be displayed.
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3.6 Georeferencing a Project

When projects are imported or created their spatial reference may not be known at the time of import.
Georeferencing specifies a spatial location on the basemap for the project. Georeferencing can either be
done manually or the location of the project can be located on the basemap.

To georeference a project make sure no project is open then select either Tools > Projects >
Georeference on Map or Tools > Projects > Georeference Manually. The Georeference Project form
below will be displayed where you can select the project to be georeferenced. 

On the left of this form are lists of the most recent projects and all the projects. On the right side of the
form the details of the highlighted project are shown, some of these details are not shown for the most
recent projects. At the top of the form is a toolbar that can be used to find a project by specifying he
project number. To select a project to georeference, highlight it and then click on the Select button.

The sections below describe the different methods for georeferencing a project.
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3.6.1 Georeferencing to a Point

If the project is to be georeferenced to a point on the map you will then need to click on the basemap at
one of the boundary pointss of the project. After this the Georeference Project form below will be
displayed. 

The following information can be specified on this form:

Map X: This is the X location, normally longitude, for the point on the project boundary.

Map Y: This is the Y location, normally latitude, for the point on the project boundary.

Existing Boundary Points: These are the current project boundary points. Select the line containing the
point that will be assigned the new map location and the new boundary points will be adjusted.

New Boundary Points: These are the new project boundary points.

3.6.2 Georeferencing Manually

Georeferencing a project manually is very similar to georeferencing a project to a point , except that
the longitude (Map X) and latitude (Map Y) of the point must be specified.

107
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3.7 Assigning Local Coordinates

Sometimes, it may be necessary to assign the local coordinates to a project after the project has been
created or imported. To do this select Tools > Projects > Assign Local Coordinates. The select project
form below will be displayed.

Use this form to select the project and then press the Select button. The Assign Local Coordinates form
below will be displayed.
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The following information can be specified on this form:

Local Units: Select either feet or meters.

Reference Corner: Select the corner of the project to use as a reference. The x and y coordinates
below will be assigned to this corner.

X Coordinate to Corner: This is the x coordinate of the reference corner.

Y Coordinate to Corner: This is the y coordinate of the reference corner.

After the Ok button is pressed the local coordinates will be assigned to the project.



POLLUTEv8110

© 2021 GAEA Technologies Ltd.

3.8 Exporting a Project

Projects can be exported to an XML Exchange file or Access database file. The sections below
describes how to export data from a project. 

3.8.1 Exporting a Project to Access Database

Before the project can be exported it must first be opened . After a project has been opened it can be
exported to a project database file by selecting File > Export > Project > To MDB. The select directory
form below will be displayed, where you can specify the directory to store the exported project database.
The exported file name consists of the project ID the letters "_PN_" and the project name with the
extension ".mdb". This file name should not be changed, if it is the file will not be able to be imported. If it
is necessary to change the name it is recommended that the file be zipped and the zip file name
changed.

3.8.2 Exporting a Project to XML

Before the project can be exported it must first be opened . After a project has been opened it can be
exported to an XML Exchange file by selecting File > Export > Project > To XML. The Export form will be
displayed, where you can specify the file name of the exported project. 

102
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3.9 Importing a Project

Projects can be imported from XML Exchange files and Access database files. The importation of project
files is described in the section below. When importing a project, no project can be open at the time. 

3.9.1 Importing Access Project Databases

When importing a project, no project can be open at the time. To import a project database select File >
Import > Project > From MDB, the Import Project Database form will be displayed. Use this form select
the project database file to be imported. The file name consists of the project ID the text "_PN_" and the
project name with the extension ".mdb". 

3.9.2 Importing  XML Projects

When importing a project, no project can be open at the time. To import a project from an XML Exchange
file select File > Import > Project > From XML, the Import Project form will be displayed. Use this form
select the file to be imported. If the project number of the imported project is already in the application, a
new unique project number will need to be specified. After this the project will be imported and added to
the project list.
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3.10 Importing POLLUTEv7 Data

Project data from POLLUTEv7 can be imported either one project at a time or a list of projects can be
imported as explained in the sections below.

3.10.1 Importing an individual POLLUTEv7 project

When importing a POLLUTYEv7 project, no project can be open at the time. To import a POLLUTEv7
project select File > Import > POLLUTEv7 Data > Project, then select the project database file. The
default location for the POLLUTEv7 project database files is "c:\Program Files (x86)
\GAEA\Pollute\Projects".

After the POLLUTEv7 project database file has been selected, the Import POLLUTEv7 Database form will
be displayed.
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This form lists the models in the POLLUTEv7 project. Either all of the models can be selected or
individual models selected using the All Models and Import check boxes. The model ID for the imported
POLLUTEv7 models can be specified using either the Model Number or Model Title.

3.10.2 Importing a list of POLLUTEv7 projects

When importing a list of POLLUTEv7 projects, no project can be open at the time. To import multiple
POLLUTEv7 projects select File > Import > POLLUTEv7 Data > Project List then select the POLLUTEv7
main database file. The file name is "PMProjects.mdb" and is normally stored in "c:\Program Files (x86)
\GAEA\database".
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After the POLLUTEv7 main database file has been selected, the Import POLLUTEv7 Project List form will
be displayed.
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This form lists the projects in the POLLUTEv7 main database. Either all of the projects can be selected
or individual projects selected using the All Projects and Import check boxes. The model ID for the
imported POLLUTEv7 models can be specified using either the Model Number or Model Title.
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3.11 Querying Projects

Project queries can be used to select projects based on their location, project ID, client and other
selection parameters. To query projects, select Tools > Projects > Query Projects. The Query Projects
form will be displayed.

This form is used to specify the selection queries to be used to select the projects. More than one query
can be used for the query, the queries to be used are shown on the left side of the form. For a project to
be selected it must meet all of the queries. 

To select additional queries use the Select Query combo box on the form. These queries can be based
on areal extent, client ID, client, project name, project ID, date created, or status. When an additional
query is selected, the parameters for the query can be specified beneath the combo box. After the
parameters of the query have been specified the query can be added to the list by pressing the Add
Query button. After a query has been added to the list it can be removed by selecting it on the list and
pressing the Remove Query button. The added query can be modified by selecting it in the list, changing
its parameters, then clicking on the Update button.

The following wildcards can be used within the parameters:

Symbol Description Example

%   Represents zero or more characters   bl% finds bl, black, blue, and blob

_   Represents a single character   h_t finds hot, hat, and hit
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[]   Represents any single character within the
brackets

  h[oa]t finds hot and hat, but not hit

^   Represents any character not in the brackets   h[ ôa]t finds hit, but not hot and hat

-   Represents a range of characters   c[a-b]t finds cat and cbt

To conduct the query, press the Perform Query button at the top of the form.  The results of the query
will be display on the Results tab. This tab will list the projects that meet the query. 

A project from the list can be opened by selecting and then pressing the Open button. In addition, the list
can be exported to an Excel file by pressing the Export button. 
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3.12 Editing Project Categories

The project categories and subcategories on the project tree in the sidebar can be edited by selecting
Tools > Projects > Edit Project Tree. The Edit Project Tree Categories form will be displayed. This form
displays the project categories and subcategories in tree consisting of nodes and sub-nodes.

The buttons at the top of the form can be used for the following:

Add: To add a project category, highlight the Projects node and click on the Add button then enter the
name below. To add a project subcategory, highlight the category and click on the Add button then enter
the name below.

Edit: To edit a project category or subcategory, highlight it and click on the Edit button. Then edit the
name below.
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Remove: To remove a project category or subcategory, highlight it and click on the Remove button.
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3.13 Changing a Project Number

The project number is used to uniquely identify all objects associated with the project and should not
normally be changed. However, if it is required to be changed the menu item Edit > Change Project
Number can be used. This menu item is only available when no project is open. When selected the
Select Project form below will be displayed.

On the left of this form are lists of the most recently opened projects and of all the projects. On the right
side of the form the details of the highlighted project are shown, some of these details are not shown for
the most recent projects. At the top of the form is a toolbar that can be used to find a project by
specifying the project number. To select a project, highlight it and then click on the Select button.

Using this form select the project number to change and press select. The Enter New Project ID and
Name form will be displayed.
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This form is used to enter the unique new project number and name. After this is entered press the Ok
button to finalize the change. The existing project will then be exported to a temporary XML file, then the
XML file will be imported with the new project number and name, and finally the old project will be
deleted.
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Chapter 4 Models

Models are used to represent the subsurface lithology, containment systems, and contaminant source to
be studied. These models can be used to study the effects of landfills, buried waste, spills, lagoons,
barrier systems, etc. Each study area should be grouped into one or more projects. A project is used to
store one or more models in a study area. After a model has been created it can be run to calculate the
concentrations of a contaminant at specified depths and times.
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4.1 Creating a New Model

After a project has been created or opened, a model can be created either by clicking on the New button
and selecting Pollute Model or selecting File > New > Pollute Model. The New Pollute Model form below
will be displayed. 

Select the template to use for the model and enter a unique model name. When a template is selected it
will be shown in the Preview. The Existing tab lists the existing models in the project. After the unique
name is entered press the Ok button to create the model and open it for editing.

The program comes with the templates described below. In addition, you can create your own templates
as described in the section Creating a Template .

Blank

73
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This is an empty model that requires the majority of the data to be entered when it is created. If no
template is selected, the blank template is used to create the model.

Primary Landfill

The Primary Liner (Subtitle D) Landfill option is used to quickly enter a landfill that may contain a
leachate collection system, primary composite liner, aquitard, and aquifer. In this option the primary
composite liner can be composed of a geomembrane and a primary liner. If the geomembrane is present
the leakage through the geomembrane can be calculated using either equations by Rowe et. al., 2004;
equations by Giroud et. al., 1992; or by specifying and equivalent hydraulic conductivity for the
geomembrane.

Primary and Secondary Landfill

The Primary and Secondary Liner Landfill option is used to quickly enter a landfill that may contain a
primary leachate collection system, primary composite liner, secondary leachate collection system,
secondary composite liner, aquitard, and aquifer. In this option the composite liners can be composed of
a geomembrane and/or compacted clay or GCL. The leakage through the geomembrane can be
calculated using either equations by Rowe et. al., 2004; equations by Giroud et. al., 1992; or by
specifying and equivalent hydraulic conductivity for the geomembrane.

Vertical Migration

The Vertical Migration option is used to quickly enter a model for the vertical migration of a contaminant
from a waste mass into an aquifer. The model may contain a primary composite liner, aquitard, and
aquifer. In this option the primary composite liner can be
composed of a geomembrane and a clay liner. If the geomembrane is present the leakage through the
geomembrane is calculated using equations by Rowe et. al., 2004.

Horizontal Migration

The Horizontal Migration option is used to quickly enter a model for the horizontal migration of a
contaminant from a waste mass to the site boundary. The model may contain a primary composite liner
and an aquitard. In this option the primary composite liner can be composed of a geomembrane and a
clay liner. If the geomembrane is present the leakage through the geomembrane is calculated using
equations by Rowe et. al., 2004.
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4.2 Opening a Model

To open an existing model either select File > Open > Pollute Model, press the Open button on the
toolbar and select Pollute Model, or double-click on it in the list of models. If the first two methods are
used the Open Pollute Model form will be displayed.

This form lists the most recently opened models at the top and all of the models on the bottom. When a
model is selected a preview for it will be shown on the right. Select the model to open and then click on
the Open button.
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4.3 Editing a Model

After a model has been created or opened, depending on the template it can be edited using the
methods below.

4.3.1 Editing a Normal Model

If the model was created using the Blank template, the model form will display the model data on the left
and the model output on the right. The model data can be entered in the four tabs for General data,
Layers, Boundaries, and Special Features. In addition, there is a tab for the subsurface model.

The data entry for the General data, Layers, and Boundaries is described in the sections below. The data
entry for the Special Features is the same for all the templates and is described in the Editing Special
Features  section. Based upon the model data a subsurface model is displayed on the Subsurface
Model tab, this is the same for all templates and is described in the section Displaying the Subsurface
Model . The control of the display of the model output is the same for all templates and is described in
the section Displaying Model Output .

4.3.1.1 General Data

To edit the general data for a model click on the General tab on the left side of the model form.
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The following can be specified on this tab:

General Information

Model Title: This is the title of the model is used to describe the model, and may be up to 255
characters long.

Maximum Depth: This is the maximum depth of the model including the bottom boundary condition. It
is used only for drawing purposes and will not affect the calculations within the model.

Darcy Velocity: The Darcy Velocity is defined as: v
a
 = n v where, n = the effective porosity, v = the

seepage (groundwater) velocity. If zero is entered for the Darcy velocity the transport mechanism will be
purely diffusive. When the Variable Properties or Passive Sink options have been selected the Darcy
Velocity parameter is omitted, since it is entered in these options.

Laplace Transform Parameters

The solution of the contaminant migration equations involves the inversion of a Laplace Transform. In this
inversion the accuracy depends upon four parameters: TAU, N, SIG, and RNU. The user may adopt the
default values (TAU=7, SIG=0, N=20, and RNU=2) or specify other values. It has been found that a value
of TAU between 7 and 10, and a value of SIG = 0 is satisfactory in most cases. The more critical
parameters, RNU and N, typically yield accurate results when: 

RNU = (0.1 * Layer Thickness * Darcy Velocity) / (Minimum Diffusion/Dispersion Coefficient)

and

N = 10 * RNU if RNU is greater than 1.0. 
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These values of RNU and N will work extremely well but will often require more integration than is
necessary. If the computation times seem excessive smaller values of RNU and N should be tried, and
the accuracy of the results compared. The program will detect grossly unreasonable results and
automatically repeat the calculation with the values suggested above, in this circumstance the value of
RNU is limited to 40. 

Run Parameters

The run parameters specify the depths and times to calculate the concentrations for the model.

Time Units: The output units for the times can be selected using the combo box. All of the units
selected for the input data will then be converted to units consistent with these units and the output data
generated will be in these units.

Depth Units: The output units for the depths can be selected using the combo box. All of the units
selected for the input data will then be converted to units consistent with these units and the output data
generated will be in these units.

Concentration Units: The output units for the concentrations can be selected using the combo box. All
of the units selected for the input data will then be converted to units consistent with these units and the
output data generated will be in these units.

All Depths or Specified Depths: This allows you to select whether to calculate the concentrations at
all depths or at selected depths. If All Depths is selected, the concentrations will be calculated at the
boundary between all sublayers. If you wish to calculate at selected depths then the depths can be
added and removed using the Add and Delete buttons. 

Type of Output: There are two types of output that can be generated, either concentrations at specified
times or maximum concentrations. If Concentrations at Specified Times is selected the Times can be
added and removed using the Add and Delete buttons.

If the top boundary condition is Finite Mass or Constant Concentration, then the contaminant
concentration at any depth will reach a maximum value at a determinable time. After reaching this
maximum value the concentration will decrease if the contaminant source is finite (i.e., the Reference
Height of Leachate is finite), or the concentration will remain at the maximum value if the contaminant
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source is infinite (i.e., Constant Concentration top boundary condition). When the output type is
maximum concentrations then the following can be specified: 

Search Depth: This is the depth for which to search for the maximum concentration, any depth between
0 and the maximum thickness of the deposit above the base boundary. The default depth is the depth of
the base boundary. In searching for the maximum concentration the depth used will be the depth closest
to the nearest sublayer interface. It is recommended that the user be sure to have a sublayer interface at
the depth requested, or specify a large number of sublayers for the layer. 

Accuracy: This is the accuracy to which the maximum base concentration is to be calculated, typically
a value of 0.1% is used.

Number of Iterations: This is the maximum number of iterations to try to obtain the maximum base
concentration to the required accuracy, typically a value of 25 is used. If the lower and upper time limits
are well selected, convergence to an accuracy of 0.1% can usually be obtained within 10 iterations.

Upper and Lower Time Limits: The user needs to specify lower and upper time limits in which the
maximum is expected to occur. If the lower and upper time limits do not bracket the time of the
maximum, the program will usually adjust the time limits to include the time of the maximum. However, if
both the specified limits are at times when there is negligible concentrations at the depth being
considered, then the program may not be able to find a meaningful maximum. If the top boundary
condition is Constant Concentration and the lower time limit is close to or above the time of the
maximum, the program will adjust the lower time limit until it is lower than the time of the maximum.
When the top boundary condition is Constant concentration, the user is advised to check the results by
using different values for the lower and upper time limits.

4.3.1.2 Layers

To edit the layer data for a model click on the Layers tab on the left side of the model form.

At the top of the tab there are buttons for:

Add: Add a layer below the currently selected layer.
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Delete: Delete the currently selected layer.

Copy: Copy the currently selected layer to the clipboard.

Paste: Paste the layer in the clipboard below the currently selected layer.

Move Down: Move the currently selected layer down.

Move Up: Move the currently selected layer up.

The following can be specified for each layer:

Name: This is the name of the layer. It is used only for drawing and output.

Number of Sublayers: The number of sublayers in each layer is primarily used in the output of the
calculated concentrations with depth; a concentration will be calculated at each sublayer interface. If the
Freundlich Non-Linear Sorption, Langmuir Non-Linear Sorption, or Variable Properties Special Feature is
selected, the accuracy of the results will depend on the number of sublayers.

Thickness: This is the thickness of the layer, this is the total thickness of all the sublayers in the layer..
The maximum thickness of each sublayer is 5 units. This maximum can be adjusted using the Maximum
Sublayer Thickness option of the Special Features menu. If the maximum sublayer thickness is not
changed then the number of sublayers is automatically increased if required to keep their thickness to
less than 5.

Dry Density: The dry density of the layer.

Porosity: This is the porosity of the layer, which must be greater than 0 and less than or equal to 1. If
the layer is being used to represent a geomembrane the porosity should be set to 1.

Coefficient of Hydrodynamic Dispersion: This is the coefficient of hydrodynamic dispersion for the layer:

D = D
e
 + D

md

where,
D

e
 = the diffusion coefficient for the species,

D
md

 = the coefficient of mechanical dispersion.

For intact clayey layers, diffusion will usually be the controlling factor and dispersion will often be
negligible [Gillham and Cherry, 1982, Rowe, 1987; Rowe et al, 2004]. In sandy layers, dispersion will
tend to be the controlling factor. If the Variable Properties option of the Special Features submenu is
selected the dispersivity can be specified separately.

Distribution Coefficient: This is the distribution coefficient for the layer. In the basic mode (ie. where
Langmuir Non-linear sorption and Freundlich Non-linear sorption have not been selected) the sorption-
desorption of a conservative species of contaminant is assumed to be linear such that:

S = K
d
 c

where,
S = solute sorbed per unit weight of soil,
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K
d
 = distribution (sorption) coefficient,

c = concentration of contaminant.

This is a reasonable approximation for low concentrations of contaminant, however at high
concentrations sorption is generally not linear and more complex relationships should be used. If there is
no sorption (i.e.,a conservative species) the distribution coefficient is zero. Two types of non-linear
sorption can be used if desired, these are Langmuir Non-Linear Sorption and Freundlich Non-Linear
Sorption. Both options can be selected in the Special Features submenu.

Fractures: Any or all of the layers may be fractured. These fractures may be 1, 2, or 3 dimensional.
Where the first dimension is for one set of vertical fractures, the second is for a second set of
(orthogonal) vertical fractures, and the third is for horizontal fractures (ie. for a 3D block, dimension 1 is
length, dimension 2 is width, and dimension 3 is depth). If 1, 2, or 3 dimensional fractures are specified
for the layer, the fracture data can be entered at the bottom of the tab.

Symbol: This is used to select the symbol that will be used for the layer when drawing the subsurface
model. When the symbol is clicked on the symbol can be selected as described in the Select
Symbol  section.

Fractures

Continuity of concentration and flux is assumed at the boundary between layers. If a fractured layer is in
contact with an unfractured layer, it is assumed that all fluid flow is transported along the fractures that
intersect the unfractured layers (i.e., it is equivalent to having a very thin sand layer between unfractured
and fractured layers). In a fractured model the program can consider advective-dispersive transport along
the fractures coupled with diffusion into the matrix on either side of the fracture. However, if the Darcy
velocity is zero, or small, then the transport mechanism will be essentially diffusive through the matrix,
the fractures will have no effect and should not be considered in modeling the migration of contaminants.
Users planning to model migration in fractured media are warned that they should first see Rowe and
Booker, 1990, 1991a, 1991b, and Rowe et al, 2004 for a discussion of modeling of fractured systems.

The following information about the fractures in each dimension can be specified:

Fracture Spacing: The spacing of fractures is the distance between fractures in each dimension.

Fracture Opening Size: The fracture opening size is the width of the gap between the fracture walls.

Number to sum: This is the number of terms to sum in the evaluation of the advective-dispersive
equation for contaminant migration [Rowe and Booker, 1990, 1991a, 1991b]. For blocks where the
fracture spacing is of the same order in all directions, 8 to 10 terms is usually adequate. As the aspect
ratio (horizontal spacing/vertical spacing or vertical spacing/vertical spacing) increases more terms are
required in the summation. When the aspect ratio is large, the problem can usually be reduced to a
lower order (eg. from 3D to 2D or 2D to 1D). For example, if the spacing between fractures in one vertical
direction is 50 units, and in the other vertical and horizontal directions is 2 units. The widely spaced
fractures can be ignored and the problem reduced to a 2D problem [Rowe and Booker, 1990].

Dispersion coefficient: This is the dispersion coefficient along the fracture. 

Distribution coefficient: This is the distribution coefficient along the fracture as defined by Freeze and
Cherry (1979). This is often assumed to be zero. 

Select Symbol

133
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The following information can be specified using this form:

Library: This combo box is used to select the symbol library to use to draw the layer. When the arrow
at the right is pressed a list will display the available symbol libraries. After a library has been selected,
the symbols displayed in the tab will be updated.

Symbol: The symbol from the library can be selected by clicking on one of the 18 symbols displayed for
the current library. The selected symbol is highlighted with a blue border.

Foreground Color: This is the color to use for the shaded parts of the symbol. The foreground color can
be changed by pressing the Foreground Color button. When this button is pressed a Color form is
displayed. Using this form, a basic color can be selected or a custom color can be specified.

Background Color: This is the color to use for the unshaded parts of the symbol. The background color
can be changed by pressing the Background Color button. When this button is pressed a Color form is
displayed. Using this form, a basic color can be selected or a custom color can be specified.

Fill Size: The fill size is used to expand or condense the symbol The size of the symbol is multiplied by
the fill size and then the symbol is drawn. For example, a fill size of 2 will result in the symbol being
doubled in size. The fill size must be greater than 0.

4.3.1.2.1  Select Symbol

This form is used to select a symbol to represent a subsurface layer.
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The following can be specified on this form:

Library: This is used to select the symbol library. Symbols are grouped into libraries consisting of 18
symbols. When the library is selected the symbols will be displayed in the grid below the library.

Symbol: The symbol can be selected by clicking on it in the grid. The selected symbol will be
highlighted with a blue box and the description for the symbol will be displayed beneath the symbol grid.

Foreground: This is used to select the foreground color for the symbol.

Background: This is used to select the background color for the symbol.

Fill Size: This is used to specify the fill size for the symbol. Generally a value of 1 or 2 should be used.

4.3.1.3 Boundaries

For every model there are two boundary conditions, one at the top and one at the bottom. The top
boundary condition is usually the point of contact between the contaminant source (eg. a landfill) and the
subsurface layers (deposit), and can be either:

· Zero Flux,
· Constant Concentration, or
· Finite Mass

The bottom boundary condition is usually the point of contact between the deposit and either a much
more or much less permeable strata (eg. an aquifer or bedrock) and can be either:



Chapter 4 Models 135

© 2021 GAEA Technologies Ltd.

· Zero Flux,
· Constant Concentration,
· Fixed Outflow, or
· Infinite Thickness

To edit the boundary data for a model click on the Boundaries tab on the left side of the model form.

Zero Flux Top Boundary Condition

The zero flux top boundary condition represents the case where there is no transmission of contaminant
across the top boundary. This option is for highly specialized applications and is rarely used. If the top
boundary is specified as zero flux no additional information is required.

Constant Concentration Top Boundary Condition

The constant concentration top boundary condition represents the case where the concentration of
contaminant in the landfill remains constant throughout time, and is equivalent to the assumption of an
infinite mass of contaminant in the landfill. If this top boundary condition is specified the following can be
specified:

Concentration: This is the constant concentration for the top boundary.

Finite Mass Top Boundary Condition

The finite mass top boundary condition is most representative of a landfill, where the concentration of
contaminant starts at an initial value, increases with time, and then declines as contaminant is
transported into the subsurface and is removed by leachate collection systems. 
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When the top boundary is finite mass the user must specify:

· Initial Source Concentration,
· Rate of Increase in concentration,
· Volume of Leachate Collected

and either:

· Thickness of Waste,
· Waste Density,
· Proportion of Mass,
· Volumetric Water Content of the waste,
· Conversion Rate Half-Life of the contaminant

or:

· Reference Height of Leachate

If the Variable Properties option has been selected from the Special Features menu, the values for the
finite mass parameters will be specified in the Variable Properties entry instead.
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Initial Source Concentration: This is the initial concentration of the source of contaminants, usually at
time zero.

Rate of Concentration Increase: This is the rate of increase in concentration with time due to
increasing mass entering the landfill. If the peak concentration is reached early in the landfill’s life and
the analysis starts at this time, the rate of increase would be zero.

Volume of Leachate Collected: This is the volume of leachate collected per unit area of landfill per unit
time, usually by the leachate collection system. Thus, the average volume of leachate collected is equal
to the average infiltration through the landfill cover less the average exfiltration through the base of the
landfill (assuming the waste is at field capacity). For example, if the average infiltration is 0.3 m/a and the
average exfiltration is 0.03 m/a, then the average volume of leachate collected is 0.3-0.03 = 0.27 m/a.

Waste Thickness: This is the vertical thickness of the waste, and is used to calculate the mass of
contaminant per unit area of waste. Either the thickness of waste or reference height of leachate must be
specified.

Waste Density: This is the apparent density of the waste (i.e. mass of waste per unit volume of the
landfill). Either the waste density or reference height of leachate must be specified.

Proportion of Mass: The available (leachable) mass of contaminant in the waste per unit mass of waste
(eg. mass of chloride in waste/total mass of waste). Either the proportion of mass or reference height of
leachate must be specified. Rowe et al (2004) report some published values for leachable mass.

Volumetric Water Content: This is the volumetric water content of the waste. Either the volumetric
water content or reference height of leachate must be specified.

Conversion Rate Half-Life: The generation coefficient is calculated based on the conversion rate half-
life K, such that = ln 2 / K. A value of = 0 implies no generation of concentration with time. In the
program = 0 is obtained by specifying K = 0 (this is the default case). 

Reference Height of Leachate: The reference height of leachate represents the volume of leachate that
would contain the total leachable mass of a contaminant of interest at the initial source concentration.
Thus, the reference height (H

r
) is equal to the mass of contaminant (M) per unit area divided by the initial

source concentration (c
o
) (i.e. H

r
 = M/c

o
).

Either the reference height of leachate or the waste thickness, waste density, proportion of mass,
volumetric water content, and conversion rate half-life must be specified. If the reference height of
leachate is zero then the mass of contaminant is calculated using the above parameters. If the reference
height of leachate is not zero than the mass of contaminant is calculated using this value, and the above

parameters are ignored. For example, if there is an average of 12.5 m of waste at a density of 600 kg/m3

and the contaminant represents 0.2% of the total waste mass, is then:

M = (0.2/100) (600) (12.5) = 15 kg/m2

And, if the initial source concentration is 1000 mg/L (i.e., 1 kg/m3) then the reference height is H
r
 = 15/1

= 15 m. 

Zero Flux Bottom Boundary Condition
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The zero flux bottom boundary condition represents the case where no mass is transported into or out of
the bottom of the deposit. This condition can be used to represent the case of a deposit underlain by an
impermeable base stratum (e.g., intact bedrock that is impermeable relative to the overlying layer or
deposit). If the bottom boundary is specified as zero flux no additional information is required.

Constant Concentration Bottom Boundary Condition

The constant concentration bottom boundary condition represents the case where the concentration of
contaminant remains constant in the base strata. The user will be prompted to specify the constant
concentration in the base strata. If the bottom boundary condition is specified as constant concentration
the following can be specified:

Concentration: This is the constant concentration for the bottom boundary.

Fixed Outflow Bottom Boundary Condition

The fixed outflow bottom boundary condition is most representative of the case where the model is
underlain by an aquifer (permeable base strata). The concentration in the base strata (aquifer) varies with
time as mass is transported into the aquifer from the deposit, and then transported away by the
horizontal velocity in the base strata. The base aquifer is modelled as a boundary condition (not a
separate layer) and the concentration at the bottom of the model is the concentration at the top of the
base aquifer. This boundary condition assumes that there is sufficient dispersion/mixing such that the
concentration is uniform across the thickness of the aquifer being considered. Thus the concentration at
the bottom of the aquifer thickness modelled is the same as reported at the top of the aquifer. If the
actual aquifer is very thick, normally only the upper portion (3 - 6 m depending on conditions) should be
considered in modeling.
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When the bottom boundary is specified as fixed outflow the following can be specified:

Landfill Length: This is the length of the landfill in the direction of groundwater flow.

Landfill Width: This is the width of the landfill in a direction perpendicular to groundwater flow. The width
is usually set to 1, since it has no influence on the results.

Base Thickness: This is the vertical thickness of the base strata that is being modelled as a boundary
condition.

Base Porosity: This is the porosity of the base strata, between 0 and 1.

Base Outflow Velocity: This is the horizontal Darcy outflow velocity within the base strata at the down-
gradient edge of the landfill. If the outflow velocity is set very high the results will be equivalent to setting
a constant base concentration of zero. If the Variable Properties option has been selected from the
Special Features submenu, the value of the Outflow Velocity will be specified in the Variable Properties
option.

Base Symbol: This is used to select the symbol that will be used for the aquifer when drawing the
subsurface model. When the symbol is clicked on the symbol can be selected as described in the
Select Symbol  section.133



POLLUTEv8140

© 2021 GAEA Technologies Ltd.

Infinite Thickness Bottom Boundary Condition

The infinite thickness bottom boundary condition represents the case where the deposit extends infinitely
in depth. This condition can be used to model lateral migration within the deposit. If the bottom boundary
is specified as infinite thickness only the base symbol is required.

Base Symbol: This is used to select the symbol that will be used for the aquifer when drawing the
subsurface model. When the symbol is clicked on the symbol can be selected as described in the
Select Symbol  section.

4.3.2 Editing a Primary Landfill Model

The Primary Liner (Subtitle D) Landfill option is used to quickly enter a landfill that may contain a
leachate collection system, primary composite liner, aquitard, and aquifer. In this option the primary
composite liner can be composed of a geomembrane and a primary liner. If the geomembrane is present
the leakage through the geomembrane can be calculated using either equations by Rowe et. al., 2004;
equations by Giroud et.al., 1992; or by specifying and equivalent hydraulic conductivity for the
geomembrane.

If the model was created using the Primary Landfill template, the model form will display the model data
on the left and the model output on the right. The model data can be entered in the tabs for General data,
Source & Hydraulic Heads, Geomembranes, Clay Liners, Aquitard, Aquifer, and Special Features. In
addition, there is a tab for the subsurface model.

The data entry for the General data, Source & Hydraulic Heads, Geomembranes, Clay Liners, Aquitard,
and Aquifer is described in the sections below. The data entry for the Special Features is the same for all
the templates and is described in the Editing Special Features  section. Based upon the model data a
subsurface model is displayed on the Subsurface Model tab, this is the same for all templates and is
described in the section Displaying the Subsurface Model . The control of the display of the model
output is the same for all templates and is described in the section Displaying Model Output .

133
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4.3.2.1 General Data

To select the layers in the model and edit the general data click on the General tab on the left side of the
model form.

The following can be specified on this tab:

General Information

Model Title: This is the title of the model is used to describe the model, and may be up to 255
characters long.

Units: This is used to select the units to use when creating the model.

Geomembrane: Check this box to include a primary geomembrane in the model. If this box is not
checked the Geomembranes tab will not be present.

Clay Liner: Check this box to include a primary clay liner in the model. If this box is not checked the
Clay Liners tab will not be present.

Aquitard: Check this box to include an aquitard in the model. If this box is not checked the Aquitard tab
will not be present.
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Aquifer: Check this box to include an aquifer in the model. If this box is not checked the Aquifer tab will
not be present.

Laplace Transform Parameters and Run Parameters

The information specified for the Laplace Transform Parameters and Run Parameters is the same as
described in the General Data  section for a Normal Model.

4.3.2.2 Source and Hydraulic Heads

To edit the source and hydraulic head data for a model click on the Source and Hydraulic Heads tab on
the left side of the model form.

The following can be specified on this tab:

Source

Concentration: This is the concentration for the source. It can either be a constant concentration or the
initial concentration depending on the source type.

Landfill Length: This the length of the landfill in the direction of groundwater flow.

Landfill Width: This is the width of the landfill perpendicular to groundwater flow.

Source Type: This option is used to specify the top boundary condition, it can be either Constant
Concentration or Finite Mass

If the source type is Finite Mass the following data can also be edited:

127
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Waste Thickness: This is the vertical thickness of the waste, and is used to calculate the mass of
contaminant per unit area of waste.

Infiltration: The average infiltration through the landfill cover.

Waste Density: This is the apparent density of the waste (i.e. mass of waste per unit volume of the
landfill).

Percentage of Mass: The available (leachable) mass of contaminant in the waste per unit mass of
waste (eg. mass of chloride in waste/total mass of waste).

Hydraulic Heads

Leachate Head on Primary Liner: The leachate head above the primary liner.

Groundwater level relative to top of aquifer: The groundwater level relative to the top of the aquifer,
or if no aquifer is present the hydraulic gradient in the liner.

4.3.2.3 Geomembranes

To edit the geomembrane data for a model click on the Geomembranes tab on the left side of the model
form.

The following data can be edited on this tab:

Name: This is the name of the geomembrane layer. 

Symbol: This is the symbol used to draw the geomembrane. To change the symbol click on the Change
Symbol button. The Select Symbol  form will be displayed where you can change the bitmap library,
bitmap, foreground color, background color, and fill size for the symbol.

Number of Sublayers: This is the number of sublayers for the geomembrane and is typically 1.

133
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Thickness: This is the thickness of the geomembrane.

Diffusion Coefficient: This is the diffusion coefficient of the geomembrane. See Rowe et al (2004) for a
discussion of this parameter and a table of typical values.

Phase Parameter: This is a dimensionless phase parameter, ‘K
H
’ or ‘Sgf’, as discussed in the

Introduction . The default is one; this represents no phase change. See Rowe et al (2004) for a
discussion of this parameter and a table of typical values for common contaminants and HDPE
geomembranes.

Leakage Method: This is used to select the method for calculating the leakage through the
geomembrane. It can be calculated using the equations by Rowe et. al., 2004 for either a circular hole in
a geomembrane in direct contact with the foundation (similar assumptions to Giroud but allowing one to
consider more variables) or for a wrinkle (or series of wrinkles) with holes (the most realistic situation for
many applications); Giroud & Bonaparte, 1992; or specifying an equivalent hydraulic conductivity.

LEAK, Rowe et at 2004

If the Leakage Type specified is Rowe et. al., 2004 the following can be specified:

Transmissivity (THETA): A detailed discussion of this is given by Rowe (1998) and the effect of this
parameter is examined by Rowe et al (2004). Values used in examples include: 1.6x10-8 m2/s for “good
contact” between a geomembrane (GM) and compacted clay liner (CCL), 1.x10-7 m2/s for “poor contact”
between a GM and CCL, and 1.x10-10 m2/s for “typical” contact between a GM and geosynthetic clay
liner (GCL).

Conductivity (KOM): This is the hydraulic conductivity of the collection system or other material directly
above the hole in the geomembrane. The default is 1x10-4 m/s.

Calculation Method: The method used to calculate the leakage can be either: LEAK - a circular hole in
a geomembrane in direct contact with the foundation (similar assumptions to Giroud but allowing one to
consider more variables) or Wrinkles - for a wrinkle (or series of wrinkles) with holes (the most realistic
situation for many applications).

Calculate Leakage: After all of the parameters have been specified, this button can be used to
calculate and display the leakage (Darcy velocity) through the geomembrane.

LEAK

18
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If the Calculation Method is selected as LEAK the following parameters can be specified:

Hole Frequency: This is the number of holes in the geomembrane per hectare or acre. The default is
2.5 holes per hectare. See Rowe et al (2004, Chapter 13) for a discussion of the number of holes per
hectare.

Hole Radius: This is the average radius of the holes in the geomembrane. The default is 0.00564 m.

Wrinkle Radius: This is the optional average radius of the wrinkles in the geomembrane. The default is
0.00564 m. A "circular hole" can be either a wrinkle or a hole (both involve fluid in direct contact with the
underlying clay liner. The only differences are (a) the wrinkle is bigger and (b) if it is a wrinkle then you
also need a hole in the wrinkle and leakage through that hole can be controlled by Benoulli's equation).

CFLAG: This is either 1 or 0 depending upon the boundary. CFLAG is 1 when head in the underlying
aquifer is greater than zero, and is 0 when the head is greater than the thickness of the soil layer above
the
first aquifer.

Wrinkles

If the Calculation Method is selected as Wrinkles the parameters below can be specified. It is suggested
that you sketch up the proposed idealized wrinkle configuration to make sure that it makes physical
sense. It is easier to work in term of hectares and remember that a hectare is 100m by100m square.
When modeling Wrinkles one is modeling those wrinkles that have holes. The frequency gives the
number of wrinkles with holes per hectare (or acre) while the spacing and length give the typical wrinkle
dimensions. For the default 10 (100m long) wrinkles/ha the spacing must by 10m (100m/no of
wrinkles=10). For 5 (100m) long wrinkles the spacing would be 20m (100m/no of wrinkles=5). But if the
wrinkles were only 20m long one could have 12 of them (three row of 4) with a spacing of 25m (100m/4
wrinkles per row).

Wrinkle Frequency: This is the number of wrinkles per hectare or acre. The default is 10 per hectare.

Wrinkle Width: This is the average width of the wrinkles. The default is 0.3 m.

Wrinkle Spacing: This is the average spacing between the wrinkles. The default is 10 m.

Wrinkle Length: This is the average length of the wrinkles. The default is 100 m.

Hole Radius: This the average radius of the holes in the wrinkles. The default is 0.00564 m. This will
limit the leakage that can occur through a given wrinkle.
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Giroud & Bonaparte 1992

If the Leakage Type specified is Giroud & Bonaparte 1992 the following can be specified:

Contact: This is the type of contact between the geomembrane and the underlying material (either the
clay liner or aquitard).

Hole Type: This is the type of holes in the geomembrane, either circles or long (rectangles).

Permeation: This is whether or not to consider permeation through the geomembrane.

Hole Frequency: This is the number of holes per hectare or acre. The default is 2.5 per hectare.

Hole Area: If the Hole Type is Circle then this parameter will be displayed. It is the average area of the
holes in the geomembrane.

Hole Length: If the Hole Type is Long then this parameter will be displayed. It is the average length of
the holes in the geomembrane.

Hole Width: If the Hole Type is Long then this parameter will be displayed. It is the average width of the
holes in the geomembrane.

Equivalent K

Equivalent K: If the method used to calculate the leakage through the geomembrane is Equivalent K,
then this parameter will be displayed. This is the equivalent hydraulic conductivity of the geomembrane. If
you are unsure what the value of this is, it is recommended to use a leakage rate landfill. Note: that the
use of an equivalent K is a device for convenience of calculation and in no way represents the true
leakage mechanisms. We recommend that you use the leakage equations. See Rowe et al (2004) for a
discussion of leakage equations.
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4.3.2.4 Clay Liners

To edit the clay liner data for a model click on the Clay Liners tab on the left side of the model form.

The following parameters can be edited on this tab:

Name: This is the name of the clay liner.

Symbol: This is the symbol used to draw the clay liner. To change the symbol click on the Change
Symbol  button.

Number of Sublayers: This is the number of sublayers to use for the liner. Typically, a value of 10 is
used.

Thickness: This is the thickness of the clay liner.

Density: This is the density of the clay liner.

Conductivity K: This is the equivalent hydraulic conductivity of the clay liner. If you are unsure what the
value of this is, it is recommended to use a leakage rate landfill.

Diffusion Coefficient: This is the coefficient of hydrodynamic dispersion for the clay liner.

Distribution Coefficient: This is the distribution coefficient for the clay liner.

Porosity: This is the porosity of the clay liner.

4.3.2.5 Aquitard

To edit the aquitard data for a model click on the Aquitard tab on the left side of the model form. Note
that this layer is an attenuation layer beneath the Clay liner. It is typically a layer with a hydraulic
conductivity higher than that required for a clay liner (1x10-9 m/s) but less than an aquifer.
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The following parameters can be edited on this tab:

Name: This is the name of the aquitard.

Symbol: This is the symbol used to draw the aquitard. To change the symbol click on the Change
Symbol  button. 

Number of Sublayers: This is the number of sublayers to use for the aquitard. Typically, a value of 10 is
used.

Thickness: This is the thickness of the aquitard.

Density: This is the dry density of the aquitard.

Conductivity K: This is the equivalent hydraulic conductivity of the aquitard. If you are unsure what the
value of this is, it is recommended to use a leakage rate landfill.

Diffusion Coefficient: This is the coefficient of hydrodynamic dispersion for the aquitard.

Distribution Coefficient: This is the distribution coefficient for the aquitard.

Porosity: This is the porosity of the aquitard.

4.3.2.6 Aquifer

To edit the aquifer and outflow data for a model click on the Aquifer tab on the left side of the model form.
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Aquifer

Name: This is the name of the aquifer.

Symbol: This is the symbol used to draw the aquifer. To change the symbol click on the Change
Symbol  button.

Thickness: This is the thickness of the aquifer.

Porosity: The porosity of the aquifer.

Outflow

After this all of the information on the previous tabs has been entered the minimum horizontal outflow
velocity in the aquifer will be calculated. You will then have the option of using this velocity or a higher
velocity. In addition the calculated Darcy velocity and leachate head on the primary liner will be
displayed.

4.3.3 Editing a Primary and Secondary Landfill Model

The Primary and Secondary Liner Landfill model is used to quickly enter a landfill that may contain a
primary leachate collection system, primary composite liner, secondary leachate collection system,
secondary composite liner, aquitard, and aquifer. In this option the composite liners can be composed of
a geomembrane and/or compacted clay or GCL. 
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If the model was created using the Primary and Secondary Landfill template, the model form will display
the model data on the left and the model output on the right. The model data can be entered in the tabs
for General data, Source & Hydraulic Heads, Collection System, Geomembranes, Clay Liners, Aquitard,
Aquifer, and Special Features. In addition, there is a tab for the subsurface model.

The data entry for the General data, Source & Hydraulic Heads, Collection System, Geomembranes,
Clay Liners, Aquitard, and Aquifer is described in the sections below. The data entry for the Special
Features is the same for all the templates and is described in the Editing Special Features  section.
Based upon the model data a subsurface model is displayed on the Subsurface Model tab, this is the
same for all templates and is described in the section Displaying the Subsurface Model . The control
of the display of the model output is the same for all templates and is described in the section Displaying
Model Output .

4.3.3.1 General Data

To select the layers in the model and edit the general data click on the General tab on the left side of the
model form.
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The majority of the data on this tab is the same as that for a Primary Landfill Model and is described in
that section . The following layers can be included in this model.

Primary Geomembrane: Check this box to include a primary geomembrane in the model. If this box
and the secondary geomembrane box are not checked the Geomembranes tab will not be present.

Primary Clay Liner: Check this box to include a primary clay liner in the model. If this box and the
Secondary Clay Liner box are not checked the Clay Liners tab will not be present.

Secondary Geomembrane: Check this box to include a secondary geomembrane in the model. If this
box and the primary geomembrane box are not checked the Geomembranes tab will not be present.

Secondary Clay Liner: Check this box to include a secondary clay liner in the model. If this box and
the Primary Clay Liner box are not checked the Clay Liners tab will not be present.

Aquitard: Check this box to include an aquitard in the model. If this box is not checked the Aquitard tab
will not be present.

Aquifer: Check this box to include an aquifer in the model. If this box is not checked the Aquifer tab will
not be present.
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4.3.3.2 Source and Hydraulic Heads

To edit the source and hydraulic head data for a model click on the Source and Hydraulic Heads tab on
the left side of the model form.

The source parameters are the same as those for a Primary Landfill Model and are described in that
section .

Hydraulic Heads

Leachate Head on Primary Liner: The leachate head above the primary liner.

Leachate Head on Secondary Liner: The leachate head above the secondary liner.

Groundwater level relative to top of aquifer: The groundwater level relative to the top of the aquifer,
or if no aquifer is present the hydraulic gradient in the liner.

4.3.3.3 Collection System

To edit the collection system data for a model click on the Collection System tab on the left side of the
model form.
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The following parameters can be edited on this tab:

Name: This is the name of the collection system.

Symbol: This is the symbol used to draw the collection system. To change the symbol click on the
Change Symbol  button.

Number of Sublayers: This is the number of sublayers to use for the collection system. Typically, a
value of 1 is used.

Thickness: This is the thickness of the collection system.

Density: This is the density of the collection system.

Diffusion Coefficient: This is the coefficient of hydrodynamic dispersion for the collection system.

Distribution Coefficient: This is the distribution coefficient for the collection system.

Porosity: This is the porosity of the collection system.

Phase Parameter: This is a dimensionless phase parameter, ‘K
H
’ or ‘Sgf’, as discussed in the

Introduction . The default is one; this represents no phase change. 

4.3.3.4 Geomembranes

To edit the geomembrane data for a model click on the Geomembranes tab on the left side of the model
form.
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The top of the form is used to specify the data for the primary geomembrane and the bottom of the form
is used to specify the data for the secondary geomembrane. The data entered for each geomembrane is
the same as that for a Primary Landfill model and is described in that section .

 

4.3.3.5 Clay Liners

To edit the clay liner data for a model click on the Clay Liners tab on the left side of the model form.
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The top of the form is used to specify the data for the primary clay liner and the bottom of the form is
used to specify the data for the secondary clay liner. The data entered for each clay liner is the same as
that for a Primary Landfill model and is described in that section .

4.3.3.6 Aquitard

To edit the aquitard data for a model click on the Aquitard tab on the left side of the model form. Note
that this layer is an attenuation layer beneath the Clay liner. It is typically a layer with a hydraulic
conductivity higher than that required for a clay liner (1x10-9 m/s) but less than an aquifer.
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 The data entered for the aquitard is the same as that for a Primary Landfill model and is described in
that section .

4.3.3.7 Aquifer

To edit the aquifer and outflow data for a model click on the Aquifer tab on the left side of the model form.

The data entered for the aquifer is the same as that for a Primary Landfill model and is described in that
section .
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4.3.4 Editing a Vertical Migration Model

The Vertical Migration model is used to quickly enter a model for the vertical migration of a contaminant
from a waste mass into an aquifer. The model may contain a primary composite liner, aquitard, and
aquifer. In this option the primary composite liner can be composed of a geomembrane and a primary
liner. If the geomembrane is present the leakage through the geomembrane is calculated using equations
by Rowe et. al., 2004.

If the model was created using the Vertical Migration template, the model form will display the model
data on the left and the model output on the right. The model data can be entered in the tabs for General
data, Source & Hydraulic Heads, Collection System, Geomembranes, Clay Liners, Aquitard, Aquifer,
and Special Features. In addition, there is a tab for the subsurface model.

The data entry for the General data, Source & Hydraulic Heads, Collection System, Geomembranes,
Clay Liners, Aquitard, and Aquifer is described in the sections below. The data entry for the Special
Features is the same for all the templates and is described in the Editing Special Features  section.
Based upon the model data a subsurface model is displayed on the Subsurface Model tab, this is the
same for all templates and is described in the section Displaying the Subsurface Model . The control
of the display of the model output is the same for all templates and is described in the section Displaying
Model Output .

4.3.4.1 General Data

To select the layers in the model and edit the general data click on the General tab on the left side of the
model form.
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The majority of the data on this tab is the same as that for a Primary Landfill Model and is described in
that section . The following layers can be included in this model.

Collection System: Check this box if there is a collection system above the geomembrane.

Geomembrane: Check this box to include a primary geomembrane in the model. If this box is not
checked the Geomembranes tab will not be present.

Clay Liner: Check this box to include a primary clay liner in the model. If this box is not checked the
Clay Liners tab will not be present.

Aquitard: Check this box to include an aquitard in the model. If this box is not checked the Aquitard tab
will not be present.

Aquifer: Check this box to include an aquifer in the model. If this box is not checked the Aquifer tab will
not be present.

4.3.4.2 Source and Hydraulic Heads

To edit the source and hydraulic head data for a model click on the Source and Hydraulic Heads tab on
the left side of the model form.
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The source parameters are the same as those for a Primary Landfill Model and are described in that
section .

Hydraulic Heads

Leachate Head on Primary Liner: If there is a collection system this is the leachate head above the
primary liner.

Groundwater level relative to top of aquifer: The groundwater level relative to the top of the aquifer,
or if no aquifer is present the hydraulic gradient in the liner.

4.3.4.3 Geomembranes

To edit the geomembrane data for a model click on the Geomembranes tab on the left side of the model
form.
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The data entered for the geomembrane is the same as that for a Primary Landfill model and is described
in that section .

4.3.4.4 Clay Liners

To edit the clay liner data for a model click on the Clay Liners tab on the left side of the model form.

The data entered for the clay liner is the same as that for a Primary Landfill model and is described in
that section .

4.3.4.5 Aquitard

To edit the aquitard data for a model click on the Aquitard tab on the left side of the model form. Note
that this layer is an attenuation layer beneath the Clay liner. It is typically a layer with a hydraulic
conductivity higher than that required for a clay liner (1x10-9 m/s) but less than an aquifer.
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 The data entered for the aquitard is the same as that for a Primary Landfill model and is described in
that section .

4.3.4.6 Aquifer

To edit the aquifer and outflow data for a model click on the Aquifer tab on the left side of the model form.

The data entered for the aquifer is the same as that for a Primary Landfill model and is described in that
section .

4.3.5 Editing a Horizontal Migration Model

The Horizontal Migration model is used to model horizontal migration of a contaminant from a waste
mass to the site boundary. The model may contain a primary composite liner and an aquitard. In this
option the primary composite liner can be composed of a geomembrane and a primary liner. If the
geomembrane is present the leakage through the geomembrane is calculated using equations by Rowe
et. al., 2004. 
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In this model the attenuation layer is modeled as a passive sink, where there is downward flow due to
infiltration from precipitation and horizontal flow due to a difference in heads between the waste and the
attenuation layer. The infiltration will have the effect of removing contaminant by acting as a passive sink
with inflow. To avoid this effect set the infiltration into the attenuation layer to zero. Unless your really
understand what you are doing, it is recommended that you set the infiltration to zero.

At the site boundary, the attenuation layer is assumed to continue indefinitely and is modelled as an
Infinite Thickness boundary. If a geomembrane is present the horizontal flow is calculated using the
leakage through the geomembrane calculated using the equations by Rowe et. al., 2004. And if the
geomembrane is not present the horizontal flow is calculated using the average gradient (using the head
in the waste and the head in the attenuation layer) and the harmonic mean hydraulic conductivity
between the head measurements.

If the model was created using the Horizontal Migration template, the model form will display the model
data on the left and the model output on the right. The model data can be entered in the tabs for General
data, Source & Hydraulic Heads, Geomembranes, Clay Liners, Aquitard, and Special Features. In
addition, there is a tab for the subsurface model.
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The data entry for the General data, Source & Hydraulic Heads, Collection System, Geomembranes,
Clay Liners, and Aquitard is described in the sections below. The data entry for the Special Features is
the same for all the templates and is described in the Editing Special Features  section. Based upon
the model data a subsurface model is displayed on the Subsurface Model tab, this is the same for all
templates and is described in the section Displaying the Subsurface Model . The control of the display
of the model output is the same for all templates and is described in the section Displaying Model
Output .

4.3.5.1 General Data

To select the layers in the model and edit the general data click on the General tab on the left side of the
model form.
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The majority of the data on this tab is the same as that for a Primary Landfill Model and is described in
that section . The following layers can be included in this model.

Geomembrane: Check this box to include a primary geomembrane in the model. If this box is not
checked the Geomembranes tab will not be present.

Clay Liner: Check this box to include a primary clay liner in the model. If this box is not checked the
Clay Liners tab will not be present.

An aquitard layer is always present in this model.

4.3.5.2 Source and Hydraulic Heads

To edit the source and hydraulic head data for a model click on the Source and Hydraulic Heads tab on
the left side of the model form.
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The source parameters are the same as those for a Primary Landfill Model and are described in that
section .

Hydraulic Heads

Infiltration in to Attenuation Layer: This is the downward infiltration due to precipitation in the
attenuation layer (aquitard). The infiltration will have the effect of removing contaminant by acting as a
passive sink with inflow. To avoid this effect set the infiltration into the attenuation layer to zero.

Head in the Waste: This is the head in the waste, relative to the same datum (depth) as the head in the
attenuation layer (aquitard).

Head in the Aquitard: This is the head in the aquitard (attenuation layer) at a location outside of the
barrier (liner system). 

Distance between Head Measurements: This is the horizontal distance between the two head
measurements above. 

4.3.5.3 Geomembranes

To edit the geomembrane data for a model click on the Geomembranes tab on the left side of the model
form.
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The data entered for the geomembrane is the same as that for a Primary Landfill model and is described
in that section .

4.3.5.4 Clay Liners

To edit the clay liner data for a model click on the Clay Liners tab on the left side of the model form.

The data entered for the clay liner is the same as that for a Primary Landfill model and is described in
that section .

4.3.5.5 Aquitard

To edit the aquitard data for a model click on the Aquitard tab on the left side of the model form. Note
that this layer is an attenuation layer beneath the Clay liner. It is typically a layer with a hydraulic
conductivity higher than that required for a clay liner (1x10-9 m/s) but less than an aquifer.
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 The data entered for the aquitard is the same as that for a Primary Landfill model and is described in
that section .

4.3.6 Editing Special Features

There are several special features that can be added to a model; such as:

· Initial Concentration Profile,
· Maximum Thickness,
· Non-linear Sorption,
· Passive Sink,
· Print Mass into Base,
· Radioactive/Biological Decay,
· Variable Properties,
· Monte Carlo Simulation,
· Sensitivity Analysis.

These features are described in the sections below.

4.3.6.1 Initial Concentration Profile

This option allows you to input an initial concentration profile at specified depths and also the initial flux
into and out of the deposit. A situation where this may be appropriate, is if there is an initial background
concentration in a sample, and one is modeling outward diffusion from the sample in a laboratory
experiment (eg. see Barone et. al. 1990).

Note: If any of the layers have fractures, this option cannot be used.
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Warning: If using this option it is a good idea to specify a thin layer between zones where there are
significant differences between initial concentration (eg. between the soil and a top or bottom reservoir in
a diffusion test).

To add this feature check the Initial Concentration Profile box on the Special Features tab. The Initial
Concentration form will be shown on the right side of the tab. 

The following can be specified:

Start Time: This is the time for the start of the initial concentration profile, it is usually zero.

Flux into Soil: This is the flux of contaminant into the soil at the top boundary up to the start time
(usually zero for a start time of zero).

Flux into Base: This is the flux of contaminant out of the soil into the base up to the start time (usually
zero for a start time of zero).

Interval Type: The initial concentration profile can be specified over depth intervals or for every sublayer.
For example, if there were only two different zones with different initial concentrations, then it would be
best to specify the profile over these depth intervals.However, if the deposit had a continuously changing
initial concentration profile with depth, then it would be better to specify the concentration for each
sublayer (the number of sublayers is specified in the entry of the layer data). 

In addition if the Print Mass into the Base special feature is selected, the user will be asked for:

Mass into the Soil: This is the mass of contaminant into the soil at the top boundary up to the start
time (usually zero for a start time of zero).

Mass into the Base: This is the mass of contaminant out of the soil into the base up to the start time
(usually zero for a start time of zero).

Depth Intervals
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If the interval type is Depth Intervals then the depth interval and concentrations are specified in the table.
At the top of the table there are buttons to add and delete a depth interval.

Sublayers

If the interval type is Sublayers then the table will be populated with the depth intervals for the sublayers
and only the concentration for each depth interval needs to be entered.

4.3.6.2 Maximum Sublayer Thickness

This option allows the user to override the default maximum sublayer thickness of 5 units. The maximum
sublayer thickness is set at 5 to avoid possible exponential overflow in the program, which can occur
sometimes if the sublayers are too large. If the maximum sublayer thickness is not changed then the
number of sublayers is automatically increased if required to keep their thickness to less than 5. For
example, if the layer thickness was 50m with 5 sublayers (giving a sublayer thickness of 10), the
program will automatically adjust the number of sublayers to 10.

To select this option check the Maximum Sublayer Thickness box on the Special Features tab.

The following can be specified:

Maximum Sublayer Thickness: This is the maximum sublayer thickness in the same depth units as
specified on the General tab.

WARNING: When overriding this maximum sublayer thickness the user takes the risk that the
program could crash or give false results.
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4.3.6.3 Non-linear Sorption

In addition to linear sorption, there are two types of non-linear sorption can be modeled. These are
Freundlich or Langmuir, the theory for these types is described in the Introduction .

To add this feature check the Non-linear Sorption box on the Special Features tab. The Non-linear
Sorption form will be shown on the right side of the tab. 

The following can be specified:

Sorption Type: This can be either None, Freundlich, or Langmuir. The layer data will depend on the type
of sorption selected.

Maximum Number of Iterations: The iterative procedure used to determine K, repeats until either the
maximum change in concentration between iterations is less than 0.1% or the maximum number of
iterations is reached.

Minimum Reference Concentration: This is the minimum value that will be used when calculating the
secant (linear) distribution coefficient, K. If the average concentration in the sublayer is less than this
value, then the Reference value is used.

Freundlich Non-linear Sorption

The following can be entered for each layer specified on the Layers tab.

Coefficient Kf: This is an empirically determined parameter for the layer.

Exponent E: This is an empirically determined parameter for the layer

Langmuir Non-linear Sorption
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The following can be entered for each layer specified on the Layers tab.

Parameter Sm: This is an empirically determined parameter for the layer.

Parameter b: This is an empirically determined parameter for the layer.

4.3.6.4 Passive Sink

This special feature allows you to incorporate one or more passive sinks or a phase change with depth
into a model. A passive sink is a depth interval in which there is a horizontal velocity which will have the
effect of removing contaminant from beneath the landfill. Typically, a passive sink is used to represent
intermediate aquifers or secondary leachate collection systems [Rowe and Fraser, 1993].

In the Passive Sink feature the model is divided into a number of depth intervals, and in each interval the
user can specify the Darcy velocity, rate of removal, rate of inflow, and phase parameter. The set of depth
intervals should cover the entire thickness of the model, between the top and bottom boundary. If a fixed
outflow bottom boundary is used, the depth interval should stop at the top of the base aquifer (i.e., it
should not include the base aquifer). 

Note: When using both the Time Varying Properties option and the Passive Sink option, the passive sink
information is specified in the Time Varying Properties  special feature.

WARNING: This option should only be used by someone with the hydrogeologic and engineering
background necessary to appreciate the subtleties associated with the physical situation and the steps
necessary for appropriate modeling of the physical situation.

THIS OPTION SHOULD NOT BE USED FOR AN IMPORTANT PROJECT WITHOUT THE GUIDANCE
OF THE PROGRAM DEVELOPERS.

To add this feature check the Passive Sink box on the Special Features tab. The Passive Sink form will
be shown on the right side of the tab. 
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The following can be specified:

Inflow Rate: This option is used to specify the inflow rate with depth.

Phase Change: This option is used to incorporate a phase change with depth.

Landfill Length: If the is a normal model type and the bottom boundary is not fixed outflow, the landfill
length needs to be specified when using a passive sink. This is the landfill length in the direction of
groundwater flow.

Landfill Width: If the is a normal model type and the bottom boundary is not fixed outflow, the landfill
width needs to be specified when using a passive sink.

Interval Type: The depth intervals can either be specified or the layer depth intervals on the Layers Tab
can be used. If the depth intervals are being specified there are buttons at the top of the table to add and
delete depth intervals.

For each depth interval the following is specified:

Top Depth: This is the top depth of the depth interval. If the Interval Type is Layers, this is filled in by the
program. The set of depth intervals should cover the entire thickness of the model. 

Bottom Depth: This is the bottom depth of the depth interval. If the Interval Type is Layers, this is filled
in by the program.

Darcy Velocity: This is the Darcy Velocity for the depth interval. A negative value indicates an upward
flow or flow in towards the source. 
. 
Rate of Removal: This is the rate of removal of contaminant by the passive sink. According to the
principle of continuity of flow the rate of removal should be equal to:

R
r
 = (v

a1
 - v

a2
) L / h

where,
R

r
 = Rate of removal or outflow velocity (flow per unit area per unit time),

v
a1

 = Darcy velocity above the interval,

v
a2

 = Darcy velocity below the interval,

L = Landfill length,
h = thickness of the layer from which fluid is being removed.

An example would be a 600 m (L) long landfill with a 0.3 m thick (h) secondary leachate collection
system. The Darcy velocity above the secondary leachate collection system is 0.01 m/a (v

a1
), and below

is 0.003 m/a (v
a2

). The rate of removal is then:

R
r
 = (0.01 - 0.003) * 600 / 0.3 = 14 m3/a/m2 = 14 m/a

Rate of Inflow: If the Inflow Rate option has been selected on the previous tab, the Rate of Inflow field
will be shown. This is the rate of inflow into the passive sink. 
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Phase Parameter: If the Phase Change option has been selected on the previous tab, the Phase
Parameter field will be shown. This is a dimensionless phase parameter as discussed in the
Introduction .

4.3.6.5 Print Mass in Base

This option will print the total mass into the soil and the base, it is not normally used. To use this option
check the Print Mass into Base box on the Special Features tab. 

4.3.6.6 Radioactive/Biological Decay

To add this feature check the Radioactive/Biological Decay box on the Special Features tab. The
Radioactive/Biological Decay form will be shown on the right side of the tab. 

The following can be specified:

Source Decay: This allows the user to select whether first order decay of contaminant will be modelled
in the source. If selected the user will be asked to specify the half-life in the source. If not selected the
half-life in the source is assumed to be infinite (i.e., no first order decay).

Base Decay: This allows the user to select whether first order decay will be modelled in the base of the
deposit (eg. an underlying aquifer). If selected the user will be asked to specify the half-life in the base. If
not selected the half-life in the base is assumed to be infinite (i.e., no first order decay).

18
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Interval Type: The depth intervals can either be specified or the layer depth intervals on the Layers Tab
can be used. 

For each depth interval the following is specified:

Top Depth: This is the top depth of the depth interval. If the Interval Type is Layers, this is filled in by the
program. The set of depth intervals should cover the entire thickness of the model. 

Bottom Depth: This is the bottom depth of the depth interval. If the Interval Type is Layers, this is filled
in by the program.

Half-Life: This is the half-life for the depth interval.

4.3.6.7 Time Varying Properties

The program is normally capable of determining the concentrations any time without determining them at
previous times. However, if there is a complex source concentration history or a change in velocities or
layer properties with time then it is necessary to sequentially follow this history. For example, the
program can model a working landfill which experiences progressive failure of the leachate collection
system and resulting buildup in the leachate mound (i.e., an increase in Darcy velocity) over a period of
years [Rowe and Fraser, 1993a, 1993b].

This option allows the user to vary the source concentration, reference height of leachate, volume of
leachate collected, rate of concentration increase, Darcy velocity, outflow velocity, dispersivity, layer
properties, and decay rate with time. The Variable Properties option implements a “time-marching”
scheme, where the program stops and restarts the solution every time parameters are changed. In the
basic mode of operation the accuracy of the solution is independent of the number of sublayers.
However, if the Variable Properties option is used then the accuracy of this procedure depends on the
number of sublayers used in the model, and the user should experiment with the number of sublayers to
ensure that the results obtained are sufficiently accurate
(see Examples 10, 11, and 15).

WARNING: This option should only be used by someone with the hydrogeologic and engineering
background necessary to appreciate the subtleties associated with the physical situation and the steps
necessary for appropriate modeling of the physical situation.

THIS OPTION SHOULD NOT BE USED FOR A PROJECT OF IMPORTANCE WITHOUT THE
GUIDANCE OF THE PROGRAM DEVELOPERS.

To add this feature check the Time Varying Properties box on the Special Features tab. Time Varying
Properties form will be shown on the right side of the tab. 
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The following options can be selected at the top of this form:

Properties Increment within Periods: This allows the user to choose whether the properties increment
within time periods or are constant within time groups.If the properties increment within time periods, the
user can specify the number of increments and the increment size for each time period. For example, if
the Darcy velocity increased linearly from .01 m/a to .11 m/a between 10 and 20 years, the user could
specify 10 increments and a Darcy velocity increment of .01. If however, the properties remain constant
between time periods the user need only specify the values of the properties. For example, if the Darcy
velocity was .01 m/a between 0 and 10 years and then .02 m/a between 11 and 30 years, the user could
specify two groups the first from 0 to 10 years with a Darcy velocity of .01 m/a and the second from 11 to
30 years with a Darcy velocity of .02 m/a.

Variable Layer Properties: This option can be used to vary both source and layer properties with time.
The model is divided into a number of depth intervals and in each interval the user can specify the
Diffusion Coefficient (or Coefficient of Hydrodynamic Dispersion), Porosity, Density, and Distribution
Coefficient. If this option is selected the Layer Data table will be displayed as described below.

Variable Decay: This option is used to vary the radioactive or biological decay with time. The source,
base, and depth interval decay rates can be varied. If this option is selected the Layer Data table will be
displayed as described below.

Passive Sink: Check this box if the model contains a passive sink as well as time varying properties.
The Darcy Velocity and Rate of Removal can be specified for each depth interval in the Layer Data table
as described below.

Note: When using both the Variable Properties option and the Passive Sink option, the Darcy velocity
used is the product of the Darcy velocity specified in both of the options. For clarity, it is generally
recommended the user specify the Darcy velocity on the Time Period Data table as 1, and vary the
Passive Sink Darcy velocity with time.

Phase Change: This option is used to incorporate a phase change parameter for each depth interval in
the Layer Data table as described below.
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Inflow Rate: This option is used to specify the Rate of Inflow for each depth interval in the Layer Data
table as described below.

Time Period Data

This table is used to specify the data for each time period. At the top of the table there are buttons to
add and delete a time group; as well as to navigate between time periods. 

The following can be specified for each time period:

Number of Increments: If the Properties Increment within Periods this is the number of increments to
use in sub-dividing the time period. The concentrations will be calculated for the times at the end of each
increment, if there is only one increment specified for the time period will be calculated at the end time.
For example, if the time period started at 0 years and ended at 20 years and the number of increments
was 4, concentrations would be calculated at 5, 10, 15, and 20 years.

Start Time: This is the start time of the first time period, and is the time at which calculations begin
(usually zero). The start time is only specified for the first time period.

End Time: This is the end time of the time period, and will be the start time of the next time period.

Source Concentration: This is the source concentration at the beginning of the time period. The
calculated concentration from the end of the last period will be used if the user specifies a negative value
for the source concentration. For the first time period the source concentration does not decrease until
the end of the time period. To model a landfill with a depleting source, the concentration should be set for
the first time period and then -1 should be used for the following time periods. 

Note: The actual source concentration will vary with time due to the migration of contaminant into the soil
and the collection of leachate. This is automatically handled by the program.

Source Concentration Increment: This is the increment size by which to increase the source
concentration for each increment in the time period. This field will only be shown if the Properties
Increment within Periods option has been selected. If no additional mass is being added to the source
then this should be zero.

Darcy Velocity: This is the Darcy velocity at the beginning of this time period. If an increment in Darcy
velocity is specified, it will be added to this velocity to get the velocity at the start of the next increment.

Note: When using both the Variable Properties option and the Passive Sink option together, the Darcy
velocity used is the product of the Darcy velocity specified in both of the options. For clarity, it is
recommended the user specify the Darcy velocity on the Variable Properties option as 1, and vary the
Passive Sink Darcy velocity.

Darcy Velocity Increment: This is the increment size by which to increase the Darcy velocity for each
increment in the time period. This field will only be shown if the Properties Increment within Periods
option has been selected.

Dispersivity: This is the dispersivity for the model. When the Variable Properties option is used the
dispersivity () and diffusion coefficient (D

md
) can be specified independently. 

Base Velocity: If the bottom boundary condition is fixed outflow, the user can specify the base
horizontal Darcy velocity at the down-gradient edge of the landfill for the beginning of the time period. 
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Base Velocity Increment: This is the increment size by which to increase the base velocity for each
increment in the time period. This field will only be shown if the Properties Increment within Periods
option has been selected. 

Rate for Conc. If the top boundary condition is finite mass, the user can specify the rate at which the
source concentration changes per year. For the case where there is no additional mass added or
removed from the landfill this value should be set at zero. 

Volume Collected: When the top boundary condition is finite mass, the user needs to specify the
Volume of Leachate Collected for the beginning of the time period.

Volume Collected Increment: This is the increment by which to increase the volume of leachate
collected during each time increment. If the infiltration through the cover of the landfill is constant, the
increment in the volume of leachate collected should be equal and of opposite sign to the increment in
the Darcy velocity.This field will only be shown if the Properties Increment within Periods option has been
selected. 

Finite Mass Specification: If the top boundary condition is finite mass, the user can specify either the
Waste Properties or the Reference Height of Leachate.

Thickness of Waste: This is the vertical thickness of the waste for the time period, and is used to
calculate the mass of contaminant per unit area of waste. 

Waste Density: This is the apparent density of the waste for the time period (i.e. mass of waste per unit
volume of the landfill). 

Proportion of Mass: The available (leachable) mass of contaminant in the waste per unit mass of waste
for the time period (eg. mass of chloride in waste/total mass of waste). 

Water Content: This is the volumetric water content of the waste for the time period. 

Conversion Rate Half-Life: The generation coefficient is calculated based on the conversion rate half-
life K, such that = ln 2 / K. A value of = 0 implies no generation of concentration with time. In the
program = 0 is obtained by specifying K = 0 (this is the default case). 

Reference Height of Leachate: The reference height of leachate represents the volume of leachate that
would contain the total leachable mass of the contaminant of interest at the initial source
concentration.Thus, the reference height (H

r
) is equal to the mass of contaminant (M) per unit area

divided by the initial source concentration (c
o
) (i.e. H

r
 = M/c

o
).

Layer Data

If the Variable Layer Properties, Variable Decay, or Passive Sink options are selected the layer data for
each time period and increment should be specified in the Layer Data table. This table shows the layer
data for the currently selected time period and increment.  If the Properties Increment within Periods
option is selected, the Increment within the time period can be changed using the buttons at the top of
the table.

If the Variable Decay option is selected the following can be specified for each time period and
increment.
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Source Decay: This allows the user to select whether first order decay of contaminant will be modelled
in the source for this time period. If selected the user will be asked to specify the half-life in the source. If
not selected the half-life in the source is assumed to be infinite (i.e., no first order decay).

Base Decay: This allows the user to select whether first order decay will be modelled in the base of the
deposit for this time period (eg. an underlying aquifer). If selected the user will be asked to specify the
half-life in the base. If not selected the half-life in the base is assumed to be infinite (i.e., no first order
decay).

Interval Type: The layer data for each time period and increment should cover the full depth of the
model. The depth intervals can either be specified or the layer depth intervals on the Layers Tab can be
used. If the depth intervals are being specified there are buttons at the top of the table to add and delete
depth intervals.

Depending on the options selected the following can be specified:

Top Depth: This is the top depth of the depth interval for this time period and increment. The set of depth
intervals should cover the entire thickness of the model. 

Bottom Depth: This is the bottom depth of the depth interval.
 
Darcy Velocity: If the Passive Sink option is selected, this is the Darcy Velocity for the depth interval. A
negative value indicates an upward flow or flow in towards the source. Note: When using both the
Variable Properties option and the Passive Sink option, the Darcy velocity used is the product of the
Darcy velocity specified in both of the options. For clarity, it is recommended the user specify the Darcy
velocity on the Time Period as 1, and vary it here.

Rate of Removal: If the Passive Sink option is selected, this is the rate of removal of contaminant by
the passive sink. According to the principle of continuity of flow the rate of removal should be equal to:

R
r
 = (v

a1
 - v

a2
) L / h

where,
R

r
 = Rate of removal or outflow velocity (flow per unit area per unit time),

v
a1

 = Darcy velocity above the interval,

v
a2

 = Darcy velocity below the interval,

L = Landfill length,
h = thickness of the layer from which fluid is being removed.

An example would be a 600 m (L) long landfill with a 0.3 m thick (h) secondary leachate collection
system. The Darcy velocity above the secondary leachate collection system is 0.01 m/a (v

a1
), and below

is 0.003 m/a (v
a2

). The rate of removal is then:

R
r
 = (0.01 - 0.003) * 600 / 0.3 = 14 m3/a/m2 = 14 m/a

Rate of Inflow: If the Inflow Rate option has been selected on the previous tab, the Rate of Inflow field
will be shown. This is the rate of inflow into the passive sink. 

Phase Parameter: If the Phase Change option has been selected on the previous tab, the Phase
Parameter field will be shown. This is a dimensionless phase parameter as discussed in the
Introduction .18
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Diffusion Coefficient: If the Variable Layer Properties is selected, this is the diffusion coefficient for the
depth interval. 

Porosity:  If the Variable Layer Properties is selected, this is the porosity for the depth interval. It must
be greater than 0 and less than or equal to 1. If the interval is being used to represent a geomembrane
the porosity should be set to 1. 

Density: If the Variable Layer Properties is selected, this dry density of the depth interval and time
period. 

Distribution Coefficient: If the Variable Layer Properties is selected, this is the distribution coefficient
for the depth interval and time period. In the basic mode (ie. where Langmuir Non-linear sorption and
Freundlich Non-linear sorption have not been
selected) the sorption-desorption of a conservative species of contaminant is assumed to be linear. 

Half-Life: If the Variable Decay option is selected, this is the half-life for the depth interval.

4.3.6.8 Monte Carlo Simulation

In the description of a soil deposit and a contaminant source (eg. a landfill) the values of all the input data
are not always known with certainty. For example, the length of time that the primary leachate collection
system will function before becoming clogged [Rowe and Fraser, 1993a, 1993b]. However, if the
probability distribution can be estimated for the variable then Monte Carlo simulation can be used to
predict the expected contaminant concentrations.

This feature supports the use of Monte Carlo simulation, to evaluate the effects of uncertainty in the
values of some of the input data. The input data are described using probability distributions, from which
data values are randomly chosen for each simulation pass. Numerous simulations are performed, and
the results describe the probability distribution of the function being simulated, in this program the
probability distribution is that of the peak concentration at various depths. Once the distributions of peak
concentrations are determined, the user can make statistical predictions of the peak concentration; such
as, the probability of the peak concentration exceeding a specific value.

Monte Carlo simulation can not be used at the same time as a Sensitivity Analysis. This is a
computationally intensive feature, and the user should be aware that it may take anywhere from a few
minutes to hours to complete with computation time depending on the speed of the computer, the
number of simulations to be performed, the number of layers, and the Talbot integration parameter ‘N’.
For this reason the Auto Run  option can not be used with this feature.

To add this feature check the Monte Carlo Simulation box on the Special Features tab. The Monte Carlo
Simulation form will be shown on the right side of the tab. 
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The following can be specified:

Number of Simulations: This is the number of simulation analyses (realizations) to make, during each
simulation the probability distributions of each variable are randomly sampled and the concentrations
calculated. To obtain sufficiently reliable results at least 500 simulations are recommended, and for
some cases between 1000 to 10000 simulations (realizations) may be required. The user should
experiment with this parameter to determine the sensitivity of the results to the number of simulations. 

Number of Data Ranges: This is the number of data ranges to divide the probability distributions into in
the output of the results of the simulation. A maximum of 20 ranges may be specified. This parameter
does not affect the accuracy of the results and is for display purposes only.

List All Results: By selecting this option, the user can obtain a list of all the simulation results. Listing
all the results will include the results of every simulation pass in the output, the output file that is
obtained may be extremely large. This option can be used to list all the results for a limited number of
simulations (e.g. 10), to obtain a better idea of how the program is functioning, prior to running it for all
the simulations.

Variables

Each variable represents one data item in the input data to be modified in the Monte Carlo simulation and
is specified in the variable table. At the top of the table there are buttons to add and delete a variable. For
each variable the following is specified:

Distribution Type: A distribution must be entered for each variable, the distribution types can be
different for different variables. There are five types of probability distributions that can be entered:

Uniform Distribution: This is used to specify a uniform probability distribution, in which there is
the equal probability that a data point has any value between a specified minimum and
maximum. The probability distribution curve would be a horizontal straight line. The user will
need to specify the Minimum and Maximum data values in the Parameters to the right of the
table.
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Triangular Distribution: This is used to specify a triangular probability distribution function,
where the probability is a maximum for a given value (mode) then linearly drops off on each side
of this value. The probability distribution curve would be a triangle. The user will need to specify
the Minimum, Mode, and Maximum data values in the Parameters to the right of the table.

General Distribution: This is used to specify a set of data and probability pairs that will be
linearly interpolated. The probability distribution curve would be a continuous function, which is
approximated by a set of straight line segments. The set of values must cover the entire data
range, and the probability values do not have to sum to 1. The data and probability pairs can be
entered in the Parameters to the right of the table.

Normal Distribution: This is used to specify a normal distribution for the variable. The
distribution is symmetrical in shape similar to a bell, and is sometimes called a Gaussian
distribution. To define the distribution the user needs to specify the Mean and Standard Deviation
in the Parameters to the right of the table.

Lognormal Distribution: A lognormal distribution can be specified for the variable with this
option. This distribution is similar to the normal distribution except that it is based on the
logarithm of the random variable (eg. Darcy velocity or layer thickness). The user will need to
specify the Mean of the log of the variable and the Standard Deviation of the log of the variable in
the Parameters to the right of the table.

Variable Type: This is the type of data for which the user wishes to enter a probability distribution.
There are 6 types of data that can be used:

Initial Source Concentration: This is the Initial Source Concentration of the top boundary, and
can only be used if the top boundary condition is NOT zero flux.

Darcy Velocity: This is the Darcy Velocity of the model.

Layer Thickness: This allows the user to specify a distribution for the thickness of a layer. The
user will be asked to specify the layer for which to vary the thickness.

Diffusion Coefficient: This is the Diffusion Coefficient of a layer, the user will be asked to
specify the layer for which to vary the Diffusion Coefficient. 

Distribution Coefficient: This is the Distribution Coefficient of a layer, the user will be asked to
specify the layer for which to vary the Distribution Coefficient. If the layer selected is fractured
the distribution coefficient along the fracture will be varied.

Variable Properties End Time: This is the End Time of a Variable Properties Time Group, the
user will be asked to specify the Time Group for which to vary End Time. When varying the end
time of a time group the program will shift the end times of subsequent time groups to maintain
their relative position, and will try to keep the end times of any previous time groups the same.
This variable type will not show up if the Variable Properties feature has not been previously
selected.

Variable Value: If the variable type is Layer Thickness, Diffusion Coefficient, or Distribution Coefficient
this is the layer to use for the variable. If the variable type is Variable Properties End Time this the end
time of the time period to vary.
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4.3.6.9 Sensitivity Analysis

In the description of a soil deposit and a contaminant source (eg. a landfill) the values of all the input data
are not always known with certainty. For example, the length of time that the primary leachate collection
system will function before becoming clogged [Rowe and Fraser, 1993a, 1993b]. However, if the
minimum and maximum values (Uniform Distribution) of the parameter can be estimated then Sensitivity
Analysis can be used to predict the expected range of contaminant concentrations.

This feature is vary similar to Monte Carlo simulation; except, that when performing a Sensitivity Analysis
only one variable may be evaluated at a time. Monte Carlo simulation can not be used at the same time
as a Sensitivity Analysis.  This is a computationally intensive feature, and the user should be aware that
it may take anywhere from a few minutes to hours to complete with computation time depending on the
speed of the computer, the number of simulations to be performed, the number of layers, and the Talbot
integration parameter ‘N’. For this reason the Auto Run  option can not be used with this feature.

To add this feature check the Sensitivity Analysis box on the Special Features tab. The Sensitivity
Analysis form will be shown on the right side of the tab. 

The following can be specified:

Number of Simulations: This is the number of simulation analyses (realizations) to make, during each
simulation the probability distributions of each variable are randomly sampled and the concentrations
calculated. To obtain sufficiently reliable results at least 500 simulations are recommended, and for
some cases between 1000 to 10000 simulations (realizations) may be required. The user should
experiment with this parameter to determine the sensitivity of the results to the number of simulations. 

Number of Data Ranges: This is the number of data ranges to divide the probability distributions into in
the output of the results of the simulation. A maximum of 20 ranges may be specified. This parameter
does not affect the accuracy of the results and is for display purposes only.

List All Results: By selecting this option, the user can obtain a list of all the simulation results. Listing
all the results will include the results of every simulation pass in the output, the output file that is
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obtained may be extremely large. This option can be used to list all the results for a limited number of
simulations (e.g. 10), to obtain a better idea of how the program is functioning, prior to running it for all
the simulations.

Variable Type: This is the type of data for which the user wishes to enter a uniform distribution. There
are 6 types of data that can be used:

Initial Source Concentration: This is the Initial Source Concentration of the top boundary, and
can only be used if the top boundary condition is NOT zero flux.

Darcy Velocity: This is the Darcy Velocity of the model.

Layer Thickness: This allows the user to specify a distribution for the thickness of a layer. The
user will be asked to specify the layer for which to vary the thickness.

Diffusion Coefficient: This is the Diffusion Coefficient of a layer, the user will be asked to
specify the layer for which to vary the Diffusion Coefficient. 

Distribution Coefficient: This is the Distribution Coefficient of a layer, the user will be asked to
specify the layer for which to vary the Distribution Coefficient. If the layer selected is fractured
the distribution coefficient along the fracture will be varied.

Variable Properties End Time: This is the End Time of a Variable Properties Time Group, the
user will be asked to specify the Time Group for which to vary End Time. When varying the end
time of a time group the program will shift the end times of subsequent time groups to maintain
their relative position, and will try to keep the end times of any previous time groups the same.
This variable type will not show up if the Variable Properties feature has not been previously
selected.

Minimum: This is the minimum value of the uniform distribution for the variable.

Maximum: This is the maximum value of the uniform distribution for the variable.

Layer Number: If the variable type is Layer Thickness, Diffusion Coefficient, or Distribution Coefficient
this is the layer to vary.

Time Group: If the variable type is Variable Properties End Time this is the end time of the time period
to vary.

4.3.7 Displaying the Subsurface Model

When a model has been created a representation of the model will be displayed on the Subsurface
Model tab.
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At the top of the tab there are buttons to adjust the options for the display and to print it to the default
printer.

4.3.7.1 Subsurface Model Options

When the Options button is pressed, the Subsurface Model Options form is displayed.
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The following can be edited on this form:

Width: This is the width of the model image in pixels.

Height: This is the height of the model image in pixels.

Draw text leaders: Check this box to draw leader lines from the model to the text (layer names).

Leader Line Style: Press this button to adjust the line style for the text leaders.

Layer Line Style: Press this button to adjust the line style for the layers.

Model Title Font: Press this button to adjust the font for the model title.

Model Text Font: Press this button to adjust the font for the text.
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4.4 Running a Model

After the data for the model has been entered, the model can be run to calculate the concentrations with
time and depth. To run a model click on the Run button at the top of the form. Alternatively, after the
model data has been entered the Auto option at the top of the form can be turned on. This option will
automatically run the model after any change has been made, and can be used to quickly view the
results of changes in the model.  The Monte Carlo Simulation and Sensitivity Analysis special features
are computationally intensive and the Auto option is not available when these features are selected.

The results of the model will be displayed on the two tabs on the right side of the form as described in
the section Displaying Model Output .187
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4.5 Displaying Model Output

After a model has been run, the results can be displayed in a variety of graphs (charts)  or a text
listing  on the two tabs on the right side of the form.

4.5.1 Displaying Charts

The chart type  to be displayed can be selected from the combo box at the top of the Graph tab. Also
at the top of the Graph tab are buttons to Edit the chart format, adjust the chart Options, Print the chart,
and export the chart data. These buttons are described in the sections below.

187
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4.5.1.1 Chart Types

If the model did not use the Monte Carlo Simulation or Sensitivity Analysis special features these charts
can be displayed:

· Depth vs Concentration
· Concentration vs Time
· Concentration vs Depth vs Time
· Depth vs Time
· Flux vs Time

or if the model used the Monte Carlo Simulation or Sensitivity Analysis feature these charts can be
displayed:

· Probability vs Concentration
· Probability vs Time
· Probability vs Variable Value

4.5.1.1.1  Depth vs Concentration

This chart will display the depth versus concentration for each of the times specified in the model. The
curve for each time can be turned on and off using the check boxes in the legend.
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4.5.1.1.2  Concentration vs Time

This chart will display the concentration versus time for each of the depths specified in the model. The
curve for each depth can be turned on and off using the check boxes in the legend.
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4.5.1.1.3  Concentration vs Depth vs Time

This chart will display the concentration versus depth versus time in 3D as nodal network with the
concentration determining the color of each 3D grid cell.
.
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4.5.1.1.4  Depth vs Time

This chart will display the depth versus time as colored grid, with the concentration determining the color.

4.5.1.1.5  Flux vs Time

This chart will display the top and bottom flux versus time. The curve for the top and bottom flux can be
turned on and off using the check boxes in the legend.
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4.5.1.1.6  Probability vs Concentration

This chart will display the probability versus concentration.

4.5.1.1.7  Probability vs Time

This chart will display the probability versus time.
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4.5.1.1.8  Probability vs Variable Value

This chart will display the probability versus variable value.
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4.5.1.2 Editing Chart Format

The format of the chart can be edited by clicking on the Edit button on the Graph tab. The Editing Chart
form will be displayed.
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This form shows a tree view on the left containing the various sections of the chart that can be formatted.
On the right are the options for the selected section. The initial format settings are specified in the
template used for the model.

The use of this form is described in the Editing Chart Formatting  for templates. Any changes that are
done when editing a model will not be saved. To save the changes, the changes need to be made to the
template.

4.5.1.3 Editing Chart Line Options

If the chart type is not Concentration vs Depth vs Time or Depth vs Time, the chart is displayed as series
of lines. The line options can be edited by pressing the Options button on the Graph tab. The Chart
Options form will be displayed.

77
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The initial options are specified in the template used for the model. The use of this form is described in
the Editing Chart Line Options  for templates. Any changes that are done when editing a model will
not be saved. To save the changes, the changes need to be made to the template.

4.5.1.4 Editing Chart Grid Options

If the chart type is Concentration vs Depth vs Time or Depth vs Time, the chart is displayed as a grid and
the grid options can be edited by pressing the Options button on the Graph tab. The Chart Options form
will be displayed.
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The initial options are specified in the template used for the model. The use of this form is described in
the Editing Chart Grid Options  for templates. Any changes that are done when editing a model will
not be saved. To save the changes, the changes need to be made to the template.

4.5.1.5 Printing the Chart

To preview and print a chart click on the Print button at the top of the tab. The Chart Preview form will be
displayed.

86
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Using this form the print settings can be adjusted and the chart printed.

4.5.1.6 Exporting Chart Data

The chart can be exported by clicking on the Export button at the top of the tab. The Export Dialog form
will be displayed.
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Using this form the chart can be exported to a bitmap or metafile. It is not recommended to use this form
to export the data, the Export Output Data to Excel  function should be used instead. 203
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4.5.2 Displaying Model Listing

A text listing of the model data and output is displayed on the List tab.

At the top of this tab, the Options button can be used to adjust the format of the listing. The initial format
settings are specified in the template used for the model. The use of this form is described in the Editing
Listing Format and Options  for templates. Any changes that are done when editing a model will not
be saved. To save the changes, the changes need to be made to the template.

Also at the top of the form is a toolbar for editing the selected text, saving the listing, and printing the
listing.
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4.6 Exporting Output Data

The output data from a model can be exported to an Excel file by selecting File > Export > Output Data
to Excel File. You will then be prompted to specify the file name of the Excel file. After the data has been
exported you will have the option to open it in Excel. The file is stored in "xlsx" format.
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4.7 Importing Output Data

In addition to the calculated results of the model, imported output data can also be displayed on the
concentration vs depth and concentration vs time charts. This imported data can be from other models,
experimental results, or theoretical results. The imported data can be extracted from an Excel file, other
models in the project, or created and entered directly. After the imported data has been entered in can
be edited or deleted.

4.7.1 Importing Other Model Output Data

Output data from a different model in the project can be imported to compare the results of two different
models. To import this data select File > Import > Other Model Output Data. The Select Pollute Model
form on the will be displayed.

After the model has been selected, a list of times from the model will be displayed. Select the time to
import then click the Ok button.
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After the time has been selected, you will be asked to provide a name for the imported dataset.

The data will then be imported and the name will appear in the chart legend. The imported data will only
show up in charts and will not be displayed in the listing.

4.7.2 Importing Output Data from Excel

To import the data from an Excel file select File > Import > Output Data from Excel File. You will then be
asked to select the file to import.



POLLUTEv8206

© 2021 GAEA Technologies Ltd.

After the file has been selected, the Import Excel Data form will be displayed. On the right of this form is
the Excel sheets from the file and on the left of the form the following can be specified:

Name: This is the name to use for the imported data. It will show up in the legend for the charts.

Time Units: This is used to select the time units for the imported data.

Depth Units: This is used to select the depth units for the imported data.

Concentration Units: This is used to select the concentration units for the imported data.

Import Table

The data to be imported from the Excel sheets on the right must be specified in the Import Table. For
each time to be imported the range of cells for the depth and concentration must be selected. At the top
of the Import Table there are buttons to Add and Delete a time.

The time can be selected by first selecting the time cell in the Import Table and then clicking on the time
in sheets on the right side of the form. After a time has been selected the range of cells for the depth and
concentration can be specified by first clicking on the cell in the Import Table, then selecting the first cell
in the sheets on the right side of the form and while holding down the left mouse button selecting the last
cell in the range.



Chapter 4 Models 207

© 2021 GAEA Technologies Ltd.

After all of the data to be imported has been specified in the Import Table, press the Import button to
import the data.

4.7.3 Creating an Imported Dataset

Data can also be imported into the model by creating a dataset and entering the data. To create a new
data select File > New > Imported Dataset.The Create New Dataset form will be displayed.

The following can be specified on this form:

Name: This is the name to use for the imported data. It will show up in the legend for the charts.

Time Units: This is used to select the time units for the imported data.

Depth Units: This is used to select the depth units for the imported data.

Concentration Units: This is used to select the concentration units for the imported data.
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Import Table

The time, depth, and concentration data to import can be entered in the Import Table. At the top of the
table there are buttons to add and delete a data point.

When all of the data points have been entered press the Ok button to create the dataset.

4.7.4 Editing an Imported Dataset

After the data has been created or imported it can be edited by selecting Edit > Imported Dataset. The
Select Imported Dataset form will be displayed.

Select the dataset to edit and then click on the Ok button. The Edit Dataset form will be displayed.



Chapter 4 Models 209

© 2021 GAEA Technologies Ltd.

The following can be edited on this form:

Name: This is the name to use for the imported data. It will show up in the legend for the charts.

Time Units: This is used to select the time units for the imported data.

Depth Units: This is used to select the depth units for the imported data.

Concentration Units: This is used to select the concentration units for the imported data.

Import Table

The time, depth, and concentration data can be edited in the Import Table. At the top of the table there
are buttons to add and delete a data point.

After all of the edits are complete, click on the Ok button to save the changes.
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4.7.5 Deleting an Imported Dataset

Imported datasets can be deleted from the model by selecting File > Delete > Imported Dataset. The
Delete Imported Dataset form will be displayed.

Select the dataset to delete then click on the Ok button. Only the imported dataset will be deleted. This
will not delete the original Excel file or other Model data.
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4.8 Saving a Model

To save any changes to a model click on the Save button at the top of the form. If the save button is not
enabled, then no changes have been made yet.

To save the model under a new name click on the SaveAs button at the top of the form. The Save As
form will be displayed.

At the top of this form a new unique name can be specified. There is a list of existing models in the
bottom of the form to make it easier to specify a unique name.

In addition, the model can be saved as a template by checking the Save As Template box. After being
saved as a template it can be used to create other models.

 



POLLUTEv8212

© 2021 GAEA Technologies Ltd.



Chapter 4 Models 213

© 2021 GAEA Technologies Ltd.

4.9 Deleting a Model

To delete a model select File > Delete > Pollute Model when the project is open but no model is open.
The Delete Pollute Model form will be displayed.

Select the model then press the Delete button to delete the model.
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4.10 Converting a Model

Models that have been created with templates other than the Blank (Regular) can be converted to a
regular model by selecting Edit > Convert to Regular Pollute Model. The Convert Pollute Model will be
displayed.

This form will list the models that were not created using the regular (Blank) template. Select the model
to convert then press the Convert button.
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4.11 Exporting a Model

Models can be imported and exported from one computer to another as XML exchange files. To export a
model select File > Export > Pollute Model when the project is open but no model is open. The Export
Pollute Model form will be displayed.

Select the model to export then click on the Export button. After this you will be prompted to specify the
name of the XML file to store the exported model.
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4.12 Importing a Model

Models can be imported and exported from one computer to another as XML exchange files. To import a
model select File > Import > Pollute Model when the project is open but no model is open. You will then
be prompted to specify the name of the file to import.



Chapter 5 Data and User
Management

Pollute & Migrate
User Guide



POLLUTEv8218

© 2021 GAEA Technologies Ltd.

Chapter 5 Data and User Management

This application provides functionality for both data and user management. In addition, it also provides for
data security. The application can be used either as a standalone program or in a network configuration.
When used in a network configuration, the network license manager handles the licensing and user
administration. 
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5.1 Security and User Administration

This application has several features to assist in the administration of users and to provide data security. 

5.1.1 User Administration

When the application is started users (both local and network) must login to the application. When users
are setup in the application they are assigned a username, password, and user type (privilege). Different
privilege levels are used to control access to functions of the program and data. The different user types
are administrator, power user, limited user, and guest. The functionality of different privilege levels is
described in the User Privilege Level Functionality  section below. 

If it is a network version, the user must login as a network user that is setup in the Network License
Manager program . If it is a local single user computer version of the application, local users can be
setup by the administrator by going to Tools > Manage Local Users.The Manage Users form will be
displayed showing the current local users

At the top of this form there are buttons to Add, Edit or Remove a user. 

221
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5.1.1.1 Adding a Local User

To add a local user click on the Add button at the top of the Manage Users form, the Add User form
below will be displayed. This form is used to enter the user name, password, and user type for the
account. The user name should be unique for each user. 

5.1.1.2 Editing a Local User

To edit a local user select the user in the list and click on the Edit button at the top of the Manage Users
form, the Edit User form below will be displayed. This form is used to edit the user name, password, and
user type for the account. The user name should be unique for each user. 
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5.1.1.3 Removing a Local User

After a local user has been created it can be removed by selecting it on the Manager Users form and
clicking on the Remove button.

5.1.1.4 User Privilege Level Functionality

The features and functionality that can be assessed in the application is controlled by the privilege level
of the user. In the sections below an "x" beneath a privilege level indicates that this functionality is
granted for that level. 

Admin Power Limited Guest

Main Features

Manage Users x

Manage Licenses x

Export Main Database x

Restore Main Database x

Restore Project Database x

Preferences (limited individually) x x x

Symbol Libraries x x

Unit Conversion x x x x

Unit Precision x x

Clear Recent x x x

Project Features

Edit Project Categories x x

New Project x x x

Open Project x x x x

Edit Project Information x x x

Delete Project x x x

Georeference to Point on Map x x x

Georeference Manually x x x

Assign Local Project Coordinates x x x

Query Projects x x x x

Import XML Project x x x

Import Project Database x x x

Export XML Project x x x

Export Project Database x x x

Model Template Features

Create a Template x x x

Open Template x x x

Delete Template x x

Export Template x x x

Import Template x x x
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Model Features

New Model x x x

Open Model x x x x

Delete Model x x x

Export Model x x x

Import Model x x x

5.1.2 Project Security

To provide data security to some projects a password can be added specifically for that project. This
password must then be entered every time the project is opened. To add a password when creating a
new project , check the box for Set Password and enter the Password on the New Project form.94



Chapter 5 Data and User Management 223

© 2021 GAEA Technologies Ltd.

To add or change a password for an existing project, open the project  and select Edit > Project
Information to display the Project Information form. Then check the box for Set Password and enter the
Password 
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5.2 Database Management

The data in this application is stored in a main database and project databases. These databases are
backed up at regular intervals and if necessary can be restored from backup copies. 

5.2.1 Backing up a database

The main database and current project database are backed up at regular intervals. These intervals are
set in the preferences for the program.  A project database will only be backed up if the project is
currently open.

5.2.2 Restoring a database

If necessary due to data corruption or some other problem, a database can be restored from a backup.
The sections below describe how to restore the main database and project databases. 

5.2.2.1 Restoring the Main Database

To restore the main database, select Tools > Databases > Restore > Main Database and the Select
Backup Database form below will be displayed. 

This form lists the backups by date and time. Select the database to restore from the list and then click
on the Ok button. If you choose to proceed with the restoration, the main database will be replaced by
the backup and the application will be restarted.
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5.2.2.2 Restoring a project database

To restore a project database, select Tools > Databases > Restore > Project Database and the Select
Project form below will be displayed. To backup a project database, no project can be currently open.

This form lists the projects in the application. Select the project to restore from a backup and then press
the Select button. The Select Backup Database form below will be displayed. 
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This form lists the backups by date and time. Select the database to restore from the list and then click
on the Ok button. 
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5.3 Network License Management

The application can be licensed on individual computers, a network, or a combination of both. When
licensed on a network the licensing is based on concurrent usage, where the number of concurrent users
must be less than or equal to the maximum number of users licensed. This means that the program can
be installed on any number of computers in the office but only the licensed number of concurrent users
can use it at the same time.

The sections below describe the installation for both the server and client computers and how to manage
the network using the License Manager.

5.3.1 Installation

When the application is managed on a network the databases and datastore for the application are also
normally stored on the network server. There are two ways to install the databases and datastore on the
server. The easiest method is to install the  application on the server and select the location of the
database and datastore directories when the application is first run on the server. Alternatively, if you
prefer not to have the application on the server you can install it on a client computer and set the
database and datastore directories to the server when the application is first run on the client.

After the databases and datastore have been installed on the server it is important not to overwrite them
each time the application is installed on a client computer. To do this make sure you answer "No" to the
last question about installing the databases and datastore when the program is first run on a client
computer. Instead database and datastore directories should be set to the server when the application is
first run.

It is important to make sure that the directories on the server where the databases and
datastore are located are shared and have their file access permissions set to "Full Control" for
all users.

5.3.1.1 Server Installation

To get the network up and running, the network license service and network license monitor program first
need to be installed on the server. The following steps occur during the installation:

· The Network License Monitor program is installed on your computer
· The Network License Manager service is installed.
· Shortcuts are placed on your Programs menu

5.3.1.1.1  Starting the Service

After the network service has been installed on the server it needs to be started before it can be used.
This is done automatically when the server is restarted or it can be done manually through the Windows
Services Manager. To do it manually open the Services list from Administrative tools in the Windows
Control Panel. Select the PM License Manager in the Services list and then select Start.
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5.3.1.1.2  Uninstalling the Service

To uninstall the network service automatically, select Uninstall Network License Service from the
application shortcuts on the Programs menu. The service will then be uninstalled the next time the server
is restarted. To uninstall the service immediately, it needs to be stopped first and then uninstalled. 

To stop the service, open the Services list from Administrative tools in the Windows Control Panel.
Select the PM License Manager in the Services list and then select Stop. Then uninstall the network
service as described above.

5.3.1.2 Client Installation

The installation of the application on a client is the same as the single user installation. The only
difference from the single user installation is that the network option should be selected during the first-
run setup stage of the program. In addition, after the databases and datastore have been installed on the
server it is important not to overwrite them each time the application is installed on a client computer. To
do this make sure you use the default database and datastore directories (on the local C drive) during
program installation. 

5.3.1.2.1  Setting the Database and Datastore Folders

After the program has been installed on the client, the database and datastore folders need to be set to
the server. To do this run the program and log in as an administrator (this option is not available to non-
administrator users). Select File > Preferences and go to the Datasources tab. On this tab set the folder
paths for the database and datastore to the ones on the server.
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5.3.1.2.2  Setting Netw ork Options

If the network option was not selected during the installation on the client computer, then it can be set in
the preferences for the application. Select File > Preferences, and select the Network License tab on the
left.
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To get the licenses from the network, set Networked to yes and enter the network name or IP address.
The port number. should always be 3002 for the network.This information is displayed on the Network
Monitor form on the network. In the box below the network settings select the licenses to request
from the network.

5.3.2 License Manager

The licensing of the application on a network is handled through a service called PM License Manager
and an application called Pollute and Migrate License Monitor. The service handles the logging in of
users and grants license requests and has no user interface. The network monitor provides a user
interface for adding/removing users and managing licenses.

When the Pollute and Migrate License Monitor is being run as a process the program icon will be
displayed in the system tray. A popup menu can be displayed by right clicking on the program icon in
the system tray. This menu can be used to display the network monitor form, manage licenses, manage
users, show the network log, and shutdown the network monitor. Shutting down the network license
manager will stop the network license manager process but will not stop the network service.
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To display the network license monitor form double-click on the icon or select it from the popup menu. 

On the right side of the Network License Monitor form a list of users that are currently logged into the
program is displayed. And on the left side is a box displaying the network server name and port. These
network properties are the ones required to be entered into the preferences of the application on client
computers, as described in the section on setting client network options . The port should always be
3002.

Below the Network Properties box are buttons for managing licenses, managing users, showing the
network log, and adjusting settings. These buttons are described in the sections below. The close button
will hide the monitor and put an icon in the system tray and the shutdown button will shutdown the
monitor.

5.3.2.1 Manage Licenses

To use the application modules on client computers they must be licensed on the network. The modules
will run in demo mode on the client computers until the network is licensed. To manage the licenses for
the application modules click on the Manage Licenses button on the License Monitor form, the License
Manager form will be displayed.
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On the left side of the form is a list showing the licensing of the application modules. If the module is
licensed the Licensed box will be checked and the maximum number of users will be displayed. When
the module is selected the details for the license will be displayed in the box on the right side of the
form.

At the top of the form there are buttons to register (unlock), export serial numbers, import unlock codes
and update the maximum users. If the module has not been licensed the Register, Export and Import
buttons will be enabled, after the module has been licensed these buttons will be not enabled.

5.3.2.1.1  Register License

To license and unlock a module, select the module and click on the Register button at the top of the
License Manager form. 



Chapter 5 Data and User Management 233

© 2021 GAEA Technologies Ltd.

This form displays the unique serial number for the network that is based on the specific computer
hardware of the server. The network and user unlock codes are based on this unique serial number and
invoice number. To obtain the unlock codes, fill in the invoice number and click on the Obtain code
button. This will take you to a form on the GAEA's web site that can be filled out and sent to GAEA for
the codes. After we receive the request we will email you back the codes. If you would prefer to contact
us directly for the codes you can email us at support@gaea.ca.

After you receive the codes from GAEA, enter them on the form along with the invoice number and click
on the Store codes button. You must enter the correct invoice number for the codes to work.

5.3.2.1.2  Export Serial Number

Another way to license the application is to export the serial number to a file and email the file to GAEA.
We will then send you back an unlock code file that can be imported. To export the serial number select
the module and click on the Export button at the top of the License Manager form. 

mailto:support@gaea.ca
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The unique serial number for the module is displayed at the top of this form and can not be changed.
Enter all of the information on this form, including the invoice number. After entering an email address
and file name the Email and Export buttons will be enabled. To email GAEA the serial number file click
on the Email button. To export the serial number to a file click on the Export button, this file will then
need to be emailed to us at support@gaeatech.com. 

5.3.2.1.3  Import Unlock Codes

After the serial number file has been exported and emailed to GAEA, we will email you an unlock code
file that can be imported. To import this file, select the module on the License Manager form and click on
the Import button at the top of the form. The Import Registration form will be displayed.

mailto:support@gaeatech.com
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At the top of the Import Registration form the file with the unlock codes can be selected. After the file has
been selected the module details will be shown and the unlock codes can be stored by clicking on he
Store Codes button.

5.3.2.1.4  Update Maximum Users

After the application has been licensed, the maximum number of users can be updated by clicking on
the Update button at the top of the License Manager form. To update the maximum number of users
enter the user unlock code from GAEA and click on the Store user code button.



POLLUTEv8236

© 2021 GAEA Technologies Ltd.

5.3.2.2 Manager Users

Prior to using the application on a client computer a user must have a user account setup in the license
monitor program. This user account is used to login to the application on the client computer. When user
accounts are setup they are assigned a username, password, and user type (privilege). Different privilege
levels are used to control access to functions of the program and data. The different user types are
administrator, power user, limited user, and guest. The functionality of different privilege levels is
described in the User Privilege Level Functionality  section below.

To manage the user accounts click on the Manage Users button on the Network Monitor form. The
Manage Users form displays the current user accounts and is used to add, edit, remove, export and
import user accounts.

221
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5.3.2.2.1  Adding a User

To add a user account click on the Add button at the top of the Manage Users form, the Add User form
below will be displayed. This form is used to enter the user name, password, and user type for the
account. The user name should be unique for each user. 

5.3.2.2.2  Editing a User

To edit a local user select the user in the list and click on the Edit button at the top of the Manage Users
form, the Edit User form below will be displayed. This form is used to edit the user name, password, and
user type for the account. The user name should be unique for each user. 
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5.3.2.2.3  Removing a User

After a user account has been created it can be removed by selecting it on the Manager Users form and
clicking on the Remove button.

5.3.2.2.4  Export User Accounts

When the licensing is being moved between servers the user accounts can be transferred by exporting
them to a file on the original server and then importing this file on the new server. To export the user
accounts click on the Export button at the top of the Manage Users form. You will then be prompted to
specify the name of the user data file.

5.3.2.2.5  Import User Accounts

After the user accounts have been exported to a user data file, this file can be imported on the new
server by clicking on the Import button at the top of the Manage Users form. 

5.3.2.3 Active Locks

The licenses that are currently being used can be shown by clicking on the Active Locks button on the
License Monitor form. The Active Locks form will display the license (lock name), owner (user), location
(IP address) and the date and time the license was granted.
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5.3.2.4 Show Log

To show a log of network license events click on the Show Log button the License Monitor form, the
Event Viewer form will be displayed. 
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The details for an event can be displayed by double-clicking on the event in the list. A log file in XML
format can be created containing the events by clicking on the Save button at the top of the form. The
events in the list can be removed by clicking on the Clear button at the top of the form.

5.3.2.4.1  Display Event Details

When an event on the Event Viewer form is double-clicked, the details of the event will be displayed in
the Event Details form.
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5.3.2.5 Settings

The network server name and port can be adjusted by clicking on the Settings button on the License
Monitor form. The Network Settings form below will be displayed. The port should be set to 3002, it is not
recommended to adjust this setting without first discussing it with GAEA.
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Appendix A Examples

All the examples in this appendix have been stored in the Examples project. When reviewing these
examples, you can either use the models in the Examples project or create a new project and create the
models using the New Model button. In the examples below, it is assumed that the models in the
Examples project are being used.

Case 1

This example shows how to create a Subtitle D landfill with a composite liner and constant concentration
source. The flow through the composite liner is calculated using a leakage rate calculation as proposed
by Giroud et. al. (1992).

Case 2

This example shows the case of pure diffusion with constant source and base concentrations.

Case 3

This example edits the previously entered data in Case 2 to include advective transport and fixed outflow
in the base stratum.
 
Case 4

This example shows how to add a finite mass source with leachate collection to Case 3. Also shows
how to calculate the Reference Height of Leachate and the Volume of Leachate Collected. Uses the
automatic search for the peak concentration.

Case 5

This example illustrates use of the program to model a hydraulic trap, using essentially the same data
as in Case 4. 

Case 6

This example has a 1 m thick compacted clay liner underlain by a 3 m thick fractured till layer. The
source is finite mass with a leachate collection system, and the base is an aquifer with fixed outflow.
Different sorption in the liner and the fractured till isalso considered. 

Case 7

In this example the lateral migration of a radioactive contaminant is modelled, in a fractured porous rock
with a single set of parallel fractures. The base of the porous rock is assumed to extend to a
considerable distance from the source and is represented by an infinite thickness boundary condition.
This example illustrates the case where the default integration is not adequate. The maximum sublayer
thickness feature is also used in this example.

Case 8

This examples uses an Initial Concentration Profile in analyzing a laboratory diffusion test for Potassium.
The specimen consists of a 4.5 cm thick clay sample with a background concentration of Potassium of
10 mg/L. In this example the Reference Height of Leachate is equal to the actual height of leachate
above the sample.
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Case 9

Freundlich non-linear sorption is considered in analyzing a laboratory diffusion test for Phenol in this
example. The sample is a 7 cm thick undisturbed clay, with a 6.5 cm leachate column above for a
source. 

Case 10

In this example the Variable Properties option is used to examine time-varying advective-dispersive
transport from a landfill. A landfill with a finite mass and a leachate collection system with an inward
Darcy Velocity (i.e., a hydraulic trap) is considered. The leachate collection system is assumed to begin
to fail after 19 years. After failure of the leachate collection system the leachate mound builds over a 10
year period, causing a reversal in the hydraulic gradient and a loss of the hydraulic trap.

Case 11

This example demonstrates the use of a time-varying source concentration and an initial concentration
profile. A landfill cell is initially filled with fresh water, and no waste is deposited for 7 years. The landfill is
situated in a clay with a pore water chloride concentration, during the initial 7 years the chloride from the
clay diffuses into the cell water. Between 7 and 10 years the cell is filled with waste and the chloride
concentration increases linearly to 2100 mg/L. The source concentration then remains constant between
10 and 13 years. Between 13 and 15 years the source concentration decreases linearly to 1180 mg/L.
The source concentration then remains constant between 15 and 19 years.

Case 12

In this example the results of the program are compared with an analytical solution developed by Tang et
al. (1981). The analysis is for a single fracture system. It is shown that the program gives exactly the
same results as the analytical solution.

Case 13

The results of the program are compared to the results obtained by an analytical solution given by
TDAST. The TDAST program was developed by Javandel et al. (1984), and is for a 2-dimensional plane
dispersion problems in an infinitely deep porous media. Concentrations obtained by both methods are in
close agreement for a dispersion coefficient of 0.01 m2/a. However, at higher dispersion coefficients, for
example 5 or 10 m2/a, the methods are not in agreement. This is because for the geometry and time
frame
considered in this problem, a 2-dimensional solution is required and POLLUTEv7 considers only 1-
dimensional migration in the layer below the source.

Case 14

In this example a landfill with primary and secondary leachate collection systems is modelled using the
Passive Sink option. The secondary leachate collection system is simulated using a passive sink to
model outflow from the collection system. The landfill contains a finite mass of a conservative species,
and is underlain by an aquifer with fixed outflow.

Case 15

In this example the model of Case 14 is extended to incorporate failure of the primary leachate collection
system after 20 years. This failure is modelled using the Variable Properties special feature. The use of
the Variable Properties and Passive Sink features together is illustrated in this example.
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Case 16

This example illustrates the use of the Monte Carlo simulation feature, in conjunction with the Variable
Properties and Passive Sink features. The landfill model used in Case 15 is modified to simulate
uncertainty in the time of failure of the primary leachate collection system. In this example the failure
time is given a triangular distribution, with a minimum of 15 years, a mode of 25 years, and a maximum
of 50 years.

Case 17

This example demonstrates how to create a landfill with a composite primary liner, primary and
secondary leachate collection systems, and a compacted clay secondary liner.

Case 18

In this example a phase change in the secondary leachate collection system is modelled using the
Phase Change special feature. The phase change occurs in the secondary leachate collection system at
the interface between the unsaturated and saturated zones, assumed to be .2 and .1 meters thick
respectively. The landfill contains a constant concentration of DCM, which experiences biological decay
in the landfill, primary and secondary liners, and the aquifer. 

Case 19

In this example a multiphase diffusion test performed by Buss et al. (1995) is modelled. This test involved
the migration of toluene from a ‘constant’ source through a 0.1 cm thick HDPE geomembrane, a 18.2 cm
thick airspace and into a 12.3 cm water reservoir (assumed to be well mixed).

Case 20

This example uses the same date as Case 16 for Monte Carlo simulation, except a Sensitivity Analysis
is performed. In this example the failure time has a minimum of 15 years and a maximum of 50 years.
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6.1 Example 1: Subtitle D Landfill

This example shows how to create a Subtitle D landfill with a composite liner and constant concentration
source. The flow through the composite liner is calculated using a leakage rate calculation as proposed
by Giroud et. al. (1992).

6.1.1 Description

This example illustrates the use of the program to model a U.S. RCRA Subtitle D landfill. The landfill
consists of a composite liner and a primary leachate collection system. The composite liner is
composed of a 60 mil (1.5 mm) geomembrane in good contact with a 0.9 m thick compacted clay liner.
Small holes with an area of 0.1 cm2 and a frequency of 1 per acre (2.5 per hectare) are assumed for the
geomembrane. The method proposed by Giroud et al (1992) is used to calculate the flow (leakage)
through the composite liner, these calculations are performed automatically by the program. 

The landfill has a length (L) of 200 m in the direction parallel to groundwater flow in the underlying aquifer.
Consideration is being given to a volatile organic contaminant with an initial source concentration of 1500
µg/L, which is assumed to remain constant with time over the time period being examined in this
example. The leachate head on the composite liner is assumed to be constant at 0.3 m. 

The flow in the aquifer must be established based on hydrogeologic data and is represented in terms of
the horizontal Darcy velocity (the “Base Outflow Velocity”) in the aquifer at the down-gradient edge of the
landfill. 

The parameters used for this example are listed below:

Property Symbol Value Units

Geomembrane Contact Good    -

Geomembrane Holes Circles    -

Hole Area 0.1 cm2

Hole Frequency 1 /acre

Source Concentration co 1500 µg/L

Source Type Constant   -

Landfill Length L 200  m

Leachate Head on Liner 0.3  m

Geomembrane Thickness 60 mil

Geomembrane Diffusion Coef. 3.0x10-5 m2/a

Clay Thickness Hs 0.9  m

Clay Diffusion Coef. D 0.02 m2/a

Distribution Coefficient Kd 0.5 mL/g

Soil Porosity n 0.35   -

Dry Density 1.9 g/cm3

Aquifer Thickness h 3 m

Aquifer Porosity nb 0.3   -

Base Outflow Velocity vb 10 m/a

For more information regarding:

• Leakage through composite liners - see Giroud et al (1992).



Appendix A Examples 247

© 2021 GAEA Technologies Ltd.

• Diffusion through geomembranes - see Hughes and Monteleone, (1987); Lord et al (1988).
• Diffusion, sorption, and effective porosity in clays (D, K

d
, n) - see Rowe et al (1988)

• Modeling, hydrogeology, and engineering interaction - see Rowe (1992), Rowe et al, 1994.
• Theory used - see Rowe and Booker (1985, 1991), Rowe et al (1994)

6.1.2 Data Entry

Open the Examples project and open Case 1. 

General Tab

On the General tab, the title and layers present in the model are specified as shown above. In this
example there is a geomembrane, clay liner and aquifer. At the bottom of the tab the run parameters can
be specified. The concentrations can either be calculated at specified times or the time of the maximum
concentration can be found. 

Source & Hydraulic Heads Tab
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On this tab the Source Type, Source Concentration and Landfill Length are specified. In this example,
the source type is constant concentration. If the source type was finite mass additional information for
the source would need to be entered as discussed in Case 4.

The Hydraulic Heads is used to specify the leachate head on the primary liner and the groundwater level
relative to the top of the aquifer. These heads are used to calculate the Darcy velocity through the liner.

Geomembranes Tab
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On this tab the Name, Thickness, Diffusion Coefficient, Phase Parameter, and method to calculate the
leakage through the geomembrane is specified. If the method is Rowe et. al. 2004 or Giroud & Bonaparte
1992, an additional tab will be displayed to enter the hole parameters. If the method is equivalent K, then
the Hydraulic Conductivity of the geomembrane can be entered on this tab. In this example the leakage
method used is Giroud & Bonaparte 1992. Using this method the parameters for the holes in the
geomembrane are specified. These parameters include the Type of Contact, Hole Type, Use of
Permeation, and Hole Frequency. If the type of holes is Circles then the Hole Area can be specified, if
the type is Long then the Hole Length and Width can be specified. 

At the bottom of the tab, the Calculate Leakage button can be used to calculate and display the Darcy
velocity (leakage) through the primary liner.

Clay Liners Tab
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The Clay Liners tab below is used to specify the properties of the clay liner below the geomembrane.
These properties include the Name, Symbol, Thickness, Density, Hydraulic Conductivity, Diffusion
Coefficient, Distribution Coefficient, and Porosity.

Aquifer Tab

The Aquifer tab is used to specify the Name, Symbol, Thickness and Porosity of the Aquifer. At the
bottom of the tab the Outflow Rate in the Aquifer can be specified. This rate should be at greater than or
equal to the minimum calculated by the program. In this example, the minimum is 0.002619 m/a.

6.1.3 Model Execution
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To run the model and calculate the concentrations press the Run button on the toolbar.

6.1.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Concentration vs Depth

The Concentration vs. Depth chart can be displayed by selecting the Concentration vs Depth item for the
Chart Type.

Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab.
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POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 1: Subtitle D Landfill with constant source concentration

THE DARCY VELOCITY (Flux) THROUGH THE LAYERS  Va = 3.9284E-5 m/a

 Layer Properties 

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Geomembrane 60 mil 1 3E-5 m²/a 1 0 cm³/g 950 kg/m³

Clay Liner 0.9 m 10 0.02 m²/a 0.35 0.5 mL/g 1.9 g/cm³

 Boundary Conditions

    Constant Concentration

          Source Concentration = 1500 µg/L

    Fixed Outflow Bottom Boundary

          Landfill Length = 200 m

          Landfill Width = 0 m

          Base Thickness = 3 m

          Base Porosity  = 0.3

          Base Outflow Velocity  = 10 m/a

 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Calculated Concentrations at Selected Times and Depths 

Time

a

Depth

m

Concentration

µg/L

10 0.000E+00 1.500E+03

1.524E-03 6.823E+02

9.152E-02 4.917E+02

1.815E-01 3.370E+02

2.715E-01 2.190E+02
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3.615E-01 1.345E+02

4.515E-01 7.798E+01

5.415E-01 4.254E+01

6.315E-01 2.176E+01

7.215E-01 1.028E+01

8.115E-01 4.107E+00

9.015E-01 3.970E-01

20 0.000E+00 1.500E+03

1.524E-03 8.259E+02

9.152E-02 6.636E+02

1.815E-01 5.198E+02

2.715E-01 3.966E+02

3.615E-01 2.942E+02

4.515E-01 2.117E+02

5.415E-01 1.471E+02

6.315E-01 9.768E+01

7.215E-01 6.006E+01

8.115E-01 3.082E+01

9.015E-01 6.430E+00

30 0.000E+00 1.500E+03

1.524E-03 9.082E+02

9.152E-02 7.636E+02

1.815E-01 6.309E+02

2.715E-01 5.115E+02

3.615E-01 4.062E+02

4.515E-01 3.148E+02

5.415E-01 2.365E+02

6.315E-01 1.698E+02

7.215E-01 1.126E+02

8.115E-01 6.246E+01

9.015E-01 1.675E+01

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
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6.2 Example 2: Pure Diffusion

This example shows the case of pure diffusion with constant source and base concentrations.

6.2.1 Description

This example illustrates the use of the program for the simple case of pure diffusion of a conservative
species (i.e., no sorption). The hydrogeology is comprised of a 4 m thick layer with a constant
contaminant concentration source at the top, and an underlying aquifer at the base. There is a
sufficiently high flushing velocity in the aquifer that the concentration at the bottom of the layer can be
assumed to be zero and the aquifer is not explicitly modelled. 

The following parameters are assumed for the example:

Property Symbol Value Units

Darcy Velocity va 0 m/a

Diffusion Coefficient 0.01 m2/a

Distribution Coefficient Kd 0 cm3/g

Soil Porosity n 0.4   -

Dry Density 1.5 g/cm3

Soil Layer Thickness H 4 m

Number of Sub-layers 4   -

Base Concentration cb 0 g/L

6.2.2 Data Entry

Open the Examples project and open Case 2. 

General Tab
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To edit the general model data either click on the General tab. On the General tab the Title, Number of
Layers, Maximum Depth, Darcy velocity, and Laplace Transform parameters can be specified.. In this
example there will only be one layer and since it is for diffusion only the Darcy velocity is zero.

The times and depths to calculate the concentrations can be specified in the Run Parameters at the
bottom of the tab. IIn this example, the concentrations will be calculated at 5 times: 10, 50, 100, 150,
and 200 years.

Layers Tab
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The data for the layer can be specified on the Layer tab. In this example, the diffusion coefficient of 0.01
is specified for the layer.

Boundaries Tab

The boundary conditions for the model can be specified on the Boundaries tab In this example, the top
boundary has a constant concentration of 1 and the bottom boundary has a constant concentration of 0.

6.2.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

6.2.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Concentration vs Depth

The Concentration vs. Depth chart can be displayed by selecting the Concentration vs Depth item for the
Chart Type.
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Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab.

POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 2: Pure diffusion

THE DARCY VELOCITY (Flux) THROUGH THE LAYERS  Va = 0 m/year
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 Layer Properties 

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Aquitard 4 m 4 0.01 m²/a 0.4 0 cm³/g 1.5 g/cm³

 Boundary Conditions

    Constant Concentration

          Source Concentration = 1 mg/L

    Constant Concentration Bottom Boundary

          Base Concentration = 0 mg/L

 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Calculated Concentrations at Selected Times and Depths 

Time

yr

Depth

m

Concentration

mg/L

10 0.000E+00 1.000E+00

1.000E+00 2.535E-02

2.000E+00 7.744E-06

3.000E+00 2.011E-11

4.000E+00 0.000E+00

50 0.000E+00 1.000E+00

1.000E+00 3.173E-01

2.000E+00 4.550E-02

3.000E+00 2.699E-03

4.000E+00 0.000E+00

100 0.000E+00 1.000E+00

1.000E+00 4.795E-01

2.000E+00 1.573E-01

3.000E+00 3.349E-02

4.000E+00 0.000E+00

150 0.000E+00 1.000E+00

1.000E+00 5.636E-01

2.000E+00 2.477E-01

3.000E+00 7.937E-02

4.000E+00 0.000E+00

200 0.000E+00 1.000E+00

1.000E+00 6.166E-01

2.000E+00 3.146E-01
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3.000E+00 1.212E-01

4.000E+00 0.000E+00

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
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6.3 Example 3: Advective Diffusive Transport

This example edits the previously entered data in Case 2 to include advective transport and fixed outflow
in the base stratum.

6.3.1 Description

In this example the input data file from Case 2 will be edited to include advective transport and a
permeable base stratum (aquifer) with a fixed outflow. The hydrogeology is comprised of a 4 m thick
aquitard layer with a constant contaminant concentration in the landfill source at the top, and a 20 m
thick underlying aquifer at the base. 

Although the aquifer is 20 m thick it is generally unrealistic to model dilution (mixing) of contaminant
through the full thickness. The actual thickness that should be modelled depends on the hydrogeologic
conditions, the length of monitoring screens, and the local regulations. In this example dilution (mixing)
of the contaminant will only be considered in the upper 3m of the aquifer, and hence the aquifer
thickness used is h = 3 m.

Since the aquifer (i.e., the contaminant receptor) is being modelled as a boundary condition the actual
deposit thickness that is explicitly modelled is the 4 m thick aquitard, and the concentration given in the
output at the 4 m depth is the concentration in the upper 3 m of the aquifer. It is assumed that this is
uniformly distributed in the 3 m and that no contaminant moved lower than 3 m into the aquifer (if the
aquifer thickness, h, were to be increased, the concentration in the aquifer would drop).

In the underlying aquifer the inflow of water beneath the up gradient edge of the landfill is given by a
Darcy velocity of 20 m/a. 

The “base velocity” is the outflow velocity beneath the down-gradient edge of the landfill and corresponds
to the inflow velocity (20 m/a) at the up gradient edge plus the inflow from the landfill. 

Based on continuity of flow the initial flow in the aquifer, q
in
, is given by the inflow velocity (v

in
 = 20 m/a in

this example) multiplied by the thickness of the aquifer being considered (h = 3 m in this example) and
the width of the landfill (the landfill dimension perpendicular to the direction of groundwater flow, W = 300
m in this example), thus: 

q
in
 = v

in
 * h * W = 20 * 3 * 300 = 18000 m2/a

The flow into the aquifer from the landfill, q
a
, is the downward Darcy velocity (v

a
 = 0.1 m/a in this case)

multiplied by the length (L = 200 m) and width (W = 300 m) of the landfill, thus:

q
a
 = v

a
 * L * W = 0.1 * 200 * 300 = 6000 m3/a

Hence the outflow at the down-gradient edge of the landfill is:

q
out

 = q
in
 + q

a
 = 18000 + 6000 = 24000 m3/a

And the “Base Outflow Velocity”, v
b
, is the outflow divided by the width of the landfill (W = 300 m) and the

thickness of the aquifer being considered (h = 3 m), therefore:

v
b
 = q

out
 / (W * h) = 24000 / (3 * 300) = 26.67 m/a
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The following parameter are assumed for the example:

Property Symbol Value Units

Darcy Velocity va 0.1 m/a

Diffusion Coefficient D 0.01 m2/a

Distribution Coefficient Kd 0 cm3/g

Soil Porosity n 0.4   -

Dry Density 1.5 g/cm3

Soil Layer Thickness H 4 m

Number of Sub-layers 4   -

Source Concentration cb 1 g/L

Landfill Length L 200 m

Landfill Width W 300 m

Thickness of Aquifer h 3 m

Porosity of Aquifer nb 0.3

Base Outflow Velocity vb 26.67 m/a

The landfill length (L) is measured in the direction parallel to groundwater flow. And the landfill width (W)
is the direction perpendicular to groundwater flow, since this is not a 3D analysis this parameter has no
effect on the results.

Warning: The evaluation of the base flow velocity, vb, requires consideration of the local

hydrogeology and the potential effect of the proposed landfill on flow conditions. For some
situations, the aquitard has sufficiently low hydraulic conductivity and the aquifer has
sufficiently high transmissivity that simple hand continuity calculations as indicated above are
appropriate. In other cases some more sophisticated flow models may be required. The
parameters used in any modeling should be selected by a hydrogeologist/engineer with
sufficient knowledge and experience to understand the existing flow system and the flow
system that is likely to exist after the landfill construction.

Note: The concentration at 4 m is the concentration at the bottom of the aquitard and in the 3 m thick
aquifer part of the aquifer beneath the landfill. This example was selected to have a downward flow (v

a
 =

0.1 m/a) so large that advection controls and in fact for the constant source boundary condition it is
possible to calculate the peak impact in the aquifer from a simple hand calculation, viz.

c
max

 = q
a
 * c

o
 / q

out
 = 6000 * 1 / 24000 = 0.25 g/L

[As an exercise the user may wish to repeat the calculation for va = 0.005 m/a, vb = 20.34 m/a. Based
on the simple hand calculation above, this would give cmax = 0.0164 g/L = 16.4 mg/L.]

6.3.2 Data Entry

Open the Examples project and open Case 3. 

General Tab
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On the General tab above the Darcy velocity of 0.1 m/a can be specified. The run parameters for this
model is the same as that in Case 2.

The run parameters for this model are specified at the bottom of the tab. In this example the automatic
search for the peak base concentration option is going to be used. The search depth will be 4 m (the
bottom of the layer) and the lower and upper time limits will be 25 and 400 years. 

Layers Tab
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The layer data for this model is the same as that in Case 2.

Boundaries Tab

The boundary conditions for the model can be specified on the Boundaries tab. In this example, the top
boundary has a constant concentration of 1 and the bottom boundary is represented as an aquifer with a
fixed outflow velocity as shown on the Boundary Condition form below.
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6.3.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

6.3.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Concentration vs Depth

The Concentration vs. Depth chart can be displayed by selecting the Concentration vs Depth item for the
Chart Type.
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Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab.

POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 3: Advective diffusive transport
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THE DARCY VELOCITY (Flux) THROUGH THE LAYERS  Va = 0.1 m/year

 Layer Properties 

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Aquitard 4 m 4 0.01 m²/a 0.4 0 cm³/g 1.5 g/cm³

 Boundary Conditions

    Constant Concentration

          Source Concentration = 1 mg/L

    Fixed Outflow Bottom Boundary

          Landfill Length = 200 m

          Landfill Width = 300 m

          Base Thickness = 3 m

          Base Porosity  = 0.3

          Base Outflow Velocity  = 26.67 m/a

 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Calculated Concentrations at Selected Times and Depths 

Time

yr

Depth

m

Concentration

mg/L

5 0.000E+00 1.000E+00

1.000E+00 8.257E-01

2.000E+00 1.116E-02

3.000E+00 2.255E-08

4.000E+00 6.655E-11

10 0.000E+00 1.000E+00

1.000E+00 9.998E-01

2.000E+00 8.892E-01

3.000E+00 1.490E-01

4.000E+00 2.805E-05

15 0.000E+00 1.000E+00

1.000E+00 1.000E+00

2.000E+00 9.995E-01

3.000E+00 9.271E-01

4.000E+00 4.101E-02

20 0.000E+00 1.000E+00
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1.000E+00 1.000E+00

2.000E+00 1.000E+00

3.000E+00 9.994E-01

4.000E+00 1.930E-01

25 0.000E+00 1.000E+00

1.000E+00 1.000E+00

2.000E+00 1.000E+00

3.000E+00 1.000E+00

4.000E+00 2.426E-01

30 0.000E+00 1.000E+00

1.000E+00 1.000E+00

2.000E+00 1.000E+00

3.000E+00 1.000E+00

4.000E+00 2.491E-01

50 0.000E+00 1.000E+00

1.000E+00 1.000E+00

2.000E+00 1.000E+00

3.000E+00 1.000E+00

4.000E+00 2.500E-01

100 0.000E+00 1.000E+00

1.000E+00 1.000E+00

2.000E+00 1.000E+00

3.000E+00 1.000E+00

4.000E+00 2.500E-01

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
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6.4 Example 4: Finite Mass Source

This example shows how to add a finite mass source with leachate collection to Case 3. Also shows
how to calculate the Reference Height of Leachate and the Volume of Leachate Collected. Uses the
automatic search for the peak concentration.

6.4.1 Description

In this example the input data file from Case 3 will be edited to include a source with a finite mass of
waste and a leachate collection system. The hydrogeology is comprised of a 4 m thick layer with a finite
mass source at the top, and an underlying aquifer at the base with fixed outflow as discussed in Case 3.
All of the parameters are the same as in Case 3, except the vertical Darcy velocity will be 0.03 m/a, the
horizontal inflow velocity will be 4 m/a and there will be a finite mass top boundary condition. The finite
mass top boundary condition requires the input of the Reference Height of Leachate (H

r
), Rate of

Increase in Concentration (C
r
), and the Volume of Leachate Collected (Q

c
).

It is assumed in this example that the waste has an average thickness of 6.25 m and a density of 600

kg/m3, and that chloride represents 0.2% of the total mass of the waste. Thus, the total mass of chloride
per unit area of the landfill (m

tc
) is calculated by multiplying the proportion of chloride by the density of

the waste and the thickness of the waste.

i.e. m
tc

 = 0.002 * 600 * 6.25 kg/m2

A peak concentration (c
o
) for chloride of 1000 mg/L (i..e., 1 kg/m3) is assumed. The Reference Height of

Leachate is then:

H
r
 = m

tc
 / c

o
 = 0.002 * 600 * 6.25 / 1 = 7.5 m

If the peak concentration is reached relatively early in the life of the landfill and the analysis starts at this
time, then there will be no increase in concentration with time. The Rate of Increase in Concentration (C

r
)

would then be zero. 

The Volume of Leachate (Q
c
) collected is equal to the difference between the infiltration through the cover

(q
o
 = 0.3 m/a here) and the exfiltration through the base (v

a
 = 0.03 m/a here), and is given by:

Q
r
 = q

o
 - v

a
 = 0.3 - 0.3 = 0.27 m/a

In this example the inflow in the aquifer at the up gradient edge of the landfill will be 4 m/a and the outflow
at the down gradient edge (v

b
) is then:

v
b
 = (v

b
(in)*h*W + v

a
*L*W)/(h*W) = v

a
(in) + v

a
*L/h = 4 + 0.03*200/3 = 6 m/a

The following parameters are assumed for the example:

Property Symbol Value Units

Darcy Velocity va 0.03 m/a

Diffusion Coefficient D 0.01 m2/a

Distribution Coefficient Kd 0 cm3/g



Appendix A Examples 269

© 2021 GAEA Technologies Ltd.

Soil Porosity n 0.4   -

Dry Density 1.5 g/cm3

Soil Layer Thickness H 4 m

Number of Sub-layers 4   -

Source Concentration co 1000 mg/L

Rate of Increase in co cr 0 mg/L/a

Ref. Height of Leachate Hr 7.5 m

Volume Collected Qc 0.27 m/a

Landfill Length L 200 m

Landfill Width W 300 m

Thickness of Aquifer h 3 m

Porosity of Aquifer nb 0.3

Base Outflow Velocity vb 6 m/a

Upper and Lower Time Limits 25, 400 a

The landfill length is measured in the direction parallel to groundwater flow. And the landfill width is the
direction perpendicular to groundwater flow, since this is not a 3D analysis this parameter has no effect
on the results.

6.4.2 Data Entry

Open the Examples project and open Case 4. 

General Tab
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The general data for this example is the same as in Case 3, except for the Darcy velocity. To edit the
Darcy velocity either click on the title or select the General Data menu item from the Data Entry menu.
On the General Data form below the Darcy velocity of 0.03 m/a can be specified. 

Provided the initial estimate for these time limits are reasonable the program will find the maximum even
if it lies outside these limits. The default values for the Accuracy and Maximum number of Search
Attempts should prove sufficient for this example and most other problems.

The run parameters for this model are the same as in Case 4. 

Layers Tab

The layer data for this model is the same as that in Case 3.

Boundaries Tab
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The boundary conditions for the model can be specified on the Boundaries tab. In this example, the top
boundary has a finite mass and the bottom boundary is represented as an aquifer with a fixed outflow
velocity.

6.4.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

6.4.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Depth vs Concentration

The Depth vs Concentration chart can be displayed by selecting the Depth vs Concentration item for the
Chart Type.
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Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab.The maximum concentration in the aquifer in this example is 136 mg/L. This peak occurs at
70 years.

POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 4: Finite mass source

THE DARCY VELOCITY (Flux) THROUGH THE LAYERS  Va = 0.03 m/year
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 Layer Properties 

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Aquitard 4 m 4 0.01 m²/a 0.4 0 cm³/g 1.5 g/cm³

 Boundary Conditions

    Finite Mass Top Boundary

          Initial Concentration = 1000 mg/L

          Rate of Increase = 0 mg/L/yr

          Volume of Leachate Collected = 0.27 m/a

          Thickness of Waste = 0 m

          Waste Density  = 0 kg/m³

          Proportion of Mass = 0

          Volumetric Water Content = 0

          Conversion Rate Half Life = 0 year

          Reference Height of Leachate = 7.5 m

    Fixed Outflow Bottom Boundary

          Landfill Length = 200 m

          Landfill Width = 300 m

          Base Thickness = 3 m

          Base Porosity  = 0.3

          Base Outflow Velocity  = 6 m/a

 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Maximum Base Concentration Parameters

    Depth to Search = 4 m

    Lower Time Limit = 25 yr

    Upper Time Limit = 400 yr

    Base Concentration Accuracy = 0.1

    Maximum Search Attempts = 25

  Maximum Base Concentration and Time of Occurrence

Time

yr

Depth

m

Concentration

mg/L

Preceeding

Time

Preceeding

Concentration

Exceeding

Time

Exceeding

Concentration

7.0233E+01 0.0000E+00 6.1040E+01

1.0000E+00 1.0820E+02

2.0000E+00 1.8998E+02

3.0000E+00 3.1335E+02
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4.0000E+00 1.3589E+02 6.8517E+01 1.3550E+02 7.1949E+01 1.3548E+02

    Number of Search Attempts = 5

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
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6.5 Example 5: Hydraulic Trap - Finite Mass Source

This example illustrates use of the program to model a hydraulic trap, using essentially the same data
as in Case 4. 

6.5.1 Description

This example illustrates the use of the program for the case where there is a hydraulic trap (i.e., flow is
into the landfill). The parameters are essentially the same as in Case 4, (where there was a finite mass
source with a leachate collection system and a fixed outflow base) except that the Darcy velocity has
been changed and the base aquifer is now assumed to be only 1 m thick with a porosity of 0.35 and is
underlain by a low permeability layer. We also now choose to ignore the width of the landfill and take W
= 1 m. This is the same as modeling a 1 m strip through the landfill. This width, W, has no effect on the
results.

The calculation and values for the Reference Height of Leachate is the same as in Case 4. Again it is
assumed that the average infiltration through the cover, (qo) is 0.3 m/a. For this example the Darcy
velocity (v

a
) into the base of the landfill is assumed to be -0.001 m/a. The negative value for the Darcy

velocity implies that the flow is upward. Neglecting the small volume of groundwater collected the average
Volume of Leachate Collected (Q

c
) is:

Q
c
 = q

o
 = 0.3 m/a

In this example the inflow in the aquifer at the up gradient edge of the landfill will be 4 m/a and the outflow
at the down gradient edge (v

b
) is then:

v
b
 = v

b
(in) + v

a
*L/h = 4 - 200*0.001 = 3.8 m/a

The following parameters are assumed for the example:

Property Symbol Value Units

Darcy Velocity va 0.001 m/a

Diffusion Coefficient D 0.01 m2/a

Distribution Coefficient Kd 0 cm3/g

Soil Porosity n 0.4   -

Dry Density 1.5 g/cm3

Soil Layer Thickness H 4 m

Number of Sub-layers 4   -

Source Concentration co 1000 mg/L

Rate of Increase in co cr 0 mg/L/a

Ref. Height of Leachate Hr 7.5 m

Volume Collected Qc 0.3 m/a

Landfill Length L 200 m

Landfill Width W 1 m

Thickness of Aquifer h 1 m

Porosity of Aquifer nb 0.35

Base Outflow Velocity vb 6 m/a
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6.5.2 Data Entry

Open the Examples project and open Case 5. 

General Tab

The general data for this example is the same as in Case 4, except for the Darcy velocity. To edit the
Darcy velocity click on the General tab. The Darcy velocity of -0.001 m/a can be specified.

Layers Tab
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The layer data for this model is the same as that in Case 4.

Boundaries Tab

The boundary conditions for the model can be specified on the Boundaries tab. In this example, the top
boundary has a finite mass and the bottom boundary is represented as an aquifer with a fixed outflow
velocity.
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6.5.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

6.5.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Depth vs Concentration

The Depth vs Concentration chart can be displayed by selecting the Depth vs Concentration item for the
Chart Type.

Output Listing
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To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab. The peak at 208 years was found, even though the upper time limit specified by the user
was 400 years. The peak concentration in the aquifer at the down gradient edge of the landfill is only
about 2 mg/L, compared to the initial source concentration of 1000 mg/L. This peak is reached after 208
years. Thus with a working hydraulic trap some contaminant reaches the base aquifer despite the inward
gradient, however for this diffusion coefficient and combination of parameters the impact is negligible. 

POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 5: Hydraulic trap - Finite mass source

THE DARCY VELOCITY (Flux) THROUGH THE LAYERS  Va = -0.001 m/year

 Layer Properties 

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Aquitard 4 m 4 0.01 m²/a 0.4 0 cm³/g 1.5 g/cm³

 Boundary Conditions

    Finite Mass Top Boundary

          Initial Concentration = 1000 mg/L

          Rate of Increase = 0 mg/L/yr

          Volume of Leachate Collected = 0.3 m/a

          Thickness of Waste = 0 m

          Waste Density  = 0 kg/m³

          Proportion of Mass = 0

          Volumetric Water Content = 0

          Conversion Rate Half Life = 0 year

          Reference Height of Leachate = 7.5 m

    Fixed Outflow Bottom Boundary

          Landfill Length = 200 m

          Landfill Width = 1 m

          Base Thickness = 1 m

          Base Porosity  = 0.35

          Base Outflow Velocity  = 3.8 m/a
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 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Maximum Base Concentration Parameters

    Depth to Search = 4 m

    Lower Time Limit = 25 year

    Upper Time Limit = 400 year

    Base Concentration Accuracy = 0.01

    Maximum Search Attempts = 25

  Maximum Base Concentration and Time of Occurrence

Time

yr

Depth

m

Concentration

mg/L

Preceeding

Time

Preceeding

Concentration

Exceeding

Time

Exceeding

Concentration

2.0828E+02 0.0000E+00 7.7427E-01

1.0000E+00 2.2363E+01

2.0000E+00 2.4529E+01

3.0000E+00 1.4300E+01

4.0000E+00 2.2199E+00 2.0800E+02 2.2199E+00 2.0857E+02 2.2198E+00

    Number of Search Attempts = 8

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
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6.6 Example 6: Fractured Layer and Sorption

This example has a 1 m thick compacted clay liner underlain by a 3 m thick fractured till layer. The
source is finite mass with a leachate collection system, and the base is an aquifer with fixed outflow.
Different sorption in the liner and the fractured till isalso considered. 

6.6.1 Description

This example illustrates the use of the program for the case where one of the layers are fractured and
there is and sorption of the contaminant species. The “barrier” consists of a 1 m thick compacted clay
layer overlying a 3 m thick fractured till. A reactive species (i.e., one that will sorb on to the clay) is
modelled in this case. The same finite mass source and leachate collection system is used as in the
previous examples. A Darcy velocity (v

a
) of 0.02 m/a through the deposit and an infiltration through the

cover (q
o
) of 0.3 m/a are assumed. The Volume of Leachate Collected (Q

c
) is then given by:

Q
c
 = q

o
 - v

a
 = 0.3 - 0.02 = 0.28 m/a

As in the previous examples the inflow in the aquifer at the up gradient edge of the landfill is 4 m/a. The
outflow (v

b
) at the down gradient edge of the landfill is then:

v
b
 = 4 + 200*0.02 = 8 m/a

The following parameters are defined for this example:

Property Symbol Value Units

Darcy Velocity va 0.02 m/a

Diffusion Coefficient D 0.01 m2/a

Distribution Coefficient Kd 1.5 cm3/g

Soil Porosity n 0.4   -

Dry Density 2 g/cm3

Soil Liner Thickness HL 1 m

Number of Sub-layers 1   -

Fractured Till Thickness HT 3 m

Number of Sub-layers 1 -

Fracture spacing in x direction 2H1 1 m

Fracture opening in x 2h1 10  µm

Fracture spacing in y direction 2H
2 1 m

Fracture opening in y 2h
2 10  µm

Dispersion along fractures D
f 0.06 m2/a

Fracture Distribution Coefficient K
f 0 cm3/g

Matrix Diffusion Coefficient D
m 0.01 m2/a

Matrix Distribution Coefficient K
m 1.5 cm3/g

Matrix Porosity n
m 0.4 -

Dry Density of Matrix 2 g/cm3

Source Concentration co 1000 mg/L

Rate of Increase in co cr 0 mg/L/a
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Ref. Height of Leachate Hr 7.5 m

Volume Collected Qc 0.28 m/a

Landfill Length L 200 m

Landfill Width W 1 m

Thickness of Aquifer h 1 m

Porosity of Aquifer nb 0.35

Base Outflow Velocity vb 8 m/a

Lower and Upper Time Limits 20, 300 a

6.6.2 Data Entry

Open the Examples project and open Case 6. 

General Tab

On the General tab the Darcy velocity of 0.02 m/a can be specified. The run parameters for this model
are specified at the bottom of this tab where the parameters for searching for the maximum concentration
can be specified.

Layers Tab
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The layer data for the two layers can be specified on the Layers tab. The first layer in this model is a
compacted clay with no fractures. The second layer is a fractured till with 2 dimensional fractures. When
this layer is selected the parameters for the two sets of fractures can be specified. The x and y
directions for a 2-dimensional fracture system refer to two sets of vertical fractures which are
approximately perpendicular to each other. Fracture opening size is the gap between the walls of the
fractures in m for metric units.

Boundaries Tab
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The boundary conditions for the model are the can be specified on the Boundaries tab. In this example,
the top boundary has a finite mass and the bottom boundary is represented as an aquifer with a fixed
outflow velocity.

6.6.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

6.6.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Depth vs Concentration

The Depth vs Concentration chart can be displayed by selecting the Depth vs Concentration item for the
Chart Type.
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Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab. The peak concentration occurred at 618 years, which is outside the lower and upper time
limits specified. In this example the program was able to find the peak since the bounds were reasonably
close to the peak time of occurrence. 

POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 6: Fractured layer and sorption
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THE DARCY VELOCITY (Flux) THROUGH THE LAYERS  Va = 0.02 m/year

 Layer Properties 

 
Layer Fracture

Spacing

1

Opening

Size

1

Number

1

Fracture

Spacing

2

Opening

Size

2

Number

2

Fracture

Spacing

3

Opening

Size

3

Number

3

Fractured Till 1 1E-5 10 1 1E-5 10

 
Layer Dispersion

Coefficient in

Fractures

Distribution

Coefficient in

Fractures

Fracture Porosity Retardation

Coefficient in Matrix

Fractured Till 0.06 0 2.0000E-05 8.5000E+00

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Compacted Clay 1 m 1 0.01 m²/a 0.4 1.5 cm³/g 2 g/cm³

Fractured Till 3 m 1 0.01 m²/a 0.4 1.5 cm³/g 2 g/cm³

 Boundary Conditions

    Finite Mass Top Boundary

          Initial Concentration = 1000 mg/L

          Rate of Increase = 0 mg/L/yr

          Volume of Leachate Collected = 0.28 m/a

          Thickness of Waste = 0 m

          Waste Density  = 0 kg/m³

          Proportion of Mass = 0

          Volumetric Water Content = 0

          Conversion Rate Half Life = 0 year

          Reference Height of Leachate = 7.5 m

    Fixed Outflow Bottom Boundary

          Landfill Length = 200 m

          Landfill Width = 1 m

          Base Thickness = 1 m

          Base Porosity  = 0.35

          Base Outflow Velocity  = 8 m/a

 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Maximum Base Concentration Parameters
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    Depth to Search = 4 Search

    Lower Time Limit = 20 Lower

    Upper Time Limit = 300 Upper

    Base Concentration Accuracy = 0.01

    Maximum Search Attempts = 25

  Maximum Base Concentration and Time of Occurrence

Time

yr

Depth

m

Concentration

mg/L

Preceeding

Time

Preceeding

Concentration

Exceeding

Time

Exceeding

Concentration

6.1816E+02 0.0000E+00 1.7644E-03

1.0000E+00 2.9323E-01

4.0000E+00 2.6868E+01 6.1770E+02 2.6868E+01 6.1861E+02 2.6869E+01

    Number of Search Attempts = 10

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
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6.7 Example 7: Fractured Rock and Radioactive Decay

In this example the lateral migration of a radioactive contaminant is modelled, in a fractured porous rock
with a single set of parallel fractures. The base of the porous rock is assumed to extend to a
considerable distance from the source and is represented by an infinite thickness boundary condition.
This example illustrates the case where the default integration is not adequate. The maximum sublayer
thickness feature is also used in this example.

6.7.1 Description

This example illustrates the use of the program for lateral migration of a radioactive contaminant in a
fractured porous rock with a single set of parallel fractures. It considers advective-dispersive transport
along the fractures and diffusion into the rock matrix. The deposit is assumed to extend a considerable
distance from the source (effectively an infinite distance) but we are only interested here in what happens
over the first 50 m after 30 years.. 

It is assumed that the source concentration, c
o
, is 1 unit and that the half life of the radioactive species

is 100 years. The source is considered to have a sufficiently large supply that there is no significant
change in source concentration due to mass movement into the rock. However the source does
experience radioactive decay.

This example is also being used to illustrate the Maximum Sublayer Thickness Special Feature, for
specifying sublayer thicknesses that are greater than 5 units.

The following parameters are defined for this example:

Property Symbol Value Units

Darcy Velocity va 0.08 m/a

Fractured Rock Thickness HT 50 m

Number of Sub-layers 5 -

Fracture spacing 2H1 0.05 m

Fracture opening 2h1 10  µm

Dispersion along fractures D
f 6 m2/a

Fracture Distribution Coefficient K
f 0 cm3/g

Matrix Diffusion Coefficient D
m 0.0018 m2/a

Matrix Distribution Coefficient K
m 0 cm3/g

Matrix Porosity n
m 0.05 -

Dry Density of Matrix 2 g/cm3

Source Concentration co 1

Half life of contaminant 100 a

Time period of interest 30 a

6.7.2 Data Entry

Open the Examples project and open Case 7. 
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General Tab

On the General tab the integration parameters for the Laplace Transform have been increased for this
example. These parameters will need to be adjusted if the output shows that the default parameters are
insufficient.

The times and depths to calculate the concentrations is set in the Run Parameters at the bottom of the
tab. The concentrations can either be calculated at specified times or the time of the maximum
concentration can be found. In this example the concentrations will be calculated at a time of 30 years
and at 4 depths: 10, 30, 40, and 50 m.

Layers Tab
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On this tab the data for the layer and fracture can be added.

Boundaries Tab

In this example, the top boundary has a constant concentration and the bottom boundary is represented
as a layer with infinite thickness. For the Infinite Thickness boundary condition, the properties of the last
layer in the Layer Data are assumed to extend infinitely.

Special Features

The radioactive decay and maximum sublayer thickness for this example are specified using the Special
Features tab.
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Maximum Sublayer Thickness

The Maximum Sublayer Thickness special feature allows the user to override the default maximum
sublayer thickness of 5 units. This maximum is set to avoid problems with exponential overflow which
can sometimes occur if the sublayers are too large. When overriding the default you take the risk that
the program will crash or give false results - caveat emptor!.

To change the maximum sublayer thickness, check the Maximum Sublayer Thickness box on the tab.
On the Maximum Sublayer Thickness sub-tab a value of 10.01 is used, each sublayer may be up to
10.01 m thick in this example. The reason for changing this parameter is to allow the calculation of depth
at 10 m intervals in the 50 m layer.

Radioactive/Biological Decay

To specify the radioactive decay, check the Radioactive/Biological Decay box on the tab. On the
Radioactive/Biological Decay sub-tab the source and base decay can be specified. The data for the



POLLUTEv8292

© 2021 GAEA Technologies Ltd.

depth ranges can also be entered. In this example there is one depth range, corresponding to the entire
thickness of the layer, with a half-life of 100 years.

6.7.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

6.7.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Depth vs Concentration

The Depth vs Concentration chart can be displayed by selecting the Depth vs Concentration item for the
Chart Type.
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Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab. 

POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 7: Fractured rock and radioactive decay

THE DARCY VELOCITY (Flux) THROUGH THE LAYERS  Va = 0.08 m/year
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 Layer Properties 

 
Layer Fracture

Spacing

1

Opening

Size

1

Number

1

Fracture

Spacing

2

Opening

Size

2

Number

2

Fracture

Spacing

3

Opening

Size

3

Number

3

Fractured

Rock

0.05 m 1E-5 m 10

 
Layer Dispersion

Coefficient in

Fractures

Distribution

Coefficient in

Fractures

Fracture Porosity Retardation

Coefficient in Matrix

Fractured Rock 6 m²/a 0 m³/kg 2.0000E-04 1.0000E+00

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Fractured Rock 50 m 5 0.0018 m²/a 0.05 0 m³/kg 2 g/cm³

 Boundary Conditions

    Constant Concentration

          Source Concentration = 1 mg/L

    Infinite Thickness Bottom Boundary

 Radioactive or Biological Decay

          Radioactive or Biological Decay Source Half Life = 100  yr

          Radioactive or Biological Decay Base Half Life = 100  yr

    First Order Radioactive or Biological Decay Depth Ranges

Minimum Depth Maximum Depth Half Life

0  m 50  m 100  yr

 Laplace Transform Parameters 

     TAU = 7     N = 40     SIG = 0     RNU = 4

 Calculated Concentrations at Selected Times and Depths 

Time

year

Depth

m

Concentration

mg/L

30 0.000E+00 8.123E-01

1.000E+01 8.123E-01

3.000E+01 8.123E-01

4.000E+01 7.881E-01
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5.000E+01 2.588E-01

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.

Below is the results using the default Laplace Transform parameters. These results are clearly wrong! The other
values are correct. We can get the correct value at 50 m by increasing the amount of integration as indicated in the
previous output listing.

 Calculated Concentrations at Selected Times and Depths 

Time

year

Depth

m

Concentration

mg/L

30 0.000E+00 8.123E-01

1.000E+01 8.123E-01

3.000E+01 8.123E-01

4.000E+01 7.883E-01

5.000E+01 -1.384E+02
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6.8 Example 8: Diffusion with Initial Concentration Profile

This examples uses an Initial Concentration Profile in analyzing a laboratory diffusion test for Potassium.
The specimen consists of a 4.5 cm thick clay sample with a background concentration of Potassium of
10 mg/L. In this example the Reference Height of Leachate is equal to the actual height of leachate
above the sample.

6.8.1 Description

The results of a laboratory diffusion test are analyzed in this example [see Rowe, Caers & Barone, 1988;
Barone, Yanful, Quigley & Rowe, 1989]. In this example the diffusion of Potassium in a clay is
examined. The clay has an initial background concentration of Potassium of 10 mg/L. 

The leachate source has an initial concentration (c
o
) of 400 mg/L, and the physical height of the leachate

in the reservoir above the soil was 6 cm. At the base of the specimen there was an impermeable barrier
(i.e., zero flux). 

Following are the parameters used in this example:

Property Symbol Value Units

Darcy Velocity va 0 m/a

Diffusion Coefficient D 0.648 cm2/d

Distribution Coefficient Kd 2.68 cm3/g

Soil Porosity nm 0.39 -

Dry Density 1.68 g/cm3

Soil Layer Thickness H 4.5 cm

Number of Sub-layers 10 -

Source Concentration co 400 mg/L

Ref. Height of Leachate Hr 6 cm

Background Concentration 10 mg/L

When using an initial concentration profile (eg. background 10 mg/L in this example) the user should
have at least three layers, with the top and bottom layer being very thin. In this example layers 1 and 3
are taken to be 0.1 cm thick and layer 2 (the main layer) is taken to be 4.5 - 0.2 = 4.3 cm thick.

6.8.2 Data Entry

Open the Examples project and open Case 8. 

General Tab
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On the General tab the Darcy velocity is set to zero for pure diffusion. The concentrations can either be
calculated at specified times or the time of the maximum concentration can be found. In this example
the concentrations will be calculated at 5 times: 3, 6, 9,
12, and 15 years.

Layers Tab

There are no fractures in these layers. For pure diffusion even if there were fractures it should be
modelled as if the soil was unfractured, since there would be no flow in the fractures for pure diffusion.

Boundaries Tab



POLLUTEv8298

© 2021 GAEA Technologies Ltd.

In this example, the top boundary has a finite mass and the bottom boundary is represented as a zero
flux layer. 

Special Features

The initial concentration profile for this example is specified using the Special Features tab.

Initial Concentration Profile

To specify the initial concentration profile, check the Initial Concentration Profile box on the Special
Features tab. 
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6.8.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

.

6.8.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Depth vs Concentration

The Depth vs Concentration chart can be displayed by selecting the Depth vs Concentration item for the
Chart Type.
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Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab. 

POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 8: Diffusion with initial concentration profile

THE DARCY VELOCITY (Flux) THROUGH THE LAYERS  Va = 0 m/year
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 Layer Properties 

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Clay 0.1 cm 1 0.648 cm²/day 0.39 2.68 cm³/g 1.68 g/cm³

Clay 4.3 cm 10 0.648 cm²/day 0.39 2.68 cm³/g 1.68 g/cm³

Clay 0.1 cm 1 0.648 cm²/day 0.39 2.68 cm³/g 1.68 g/cm³

 Boundary Conditions

    Finite Mass Top Boundary

          Initial Concentration = 400 mg/L

          Rate of Increase = 0 mg/L/yr

          Volume of Leachate Collected = 0 m/a

          Thickness of Waste = 0 m

          Waste Density  = 0 kg/m³

          Proportion of Mass = 0

          Volumetric Water Content = 0

          Conversion Rate Half Life = 0 year

          Reference Height of Leachate = 6 cm

    Zero Flux Bottom Boundary

 INITIAL CONCENTRATION PROFILE

          Time = 0 yr

          Flux into Soil = 0 m²/a

          Flux into Base = 0 m²/a

Top Depth Bottom Depth Concentration

0  cm 4.5  cm 10  mg/L

 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Calculated Concentrations at Selected Times and Depths 

Time

day

Depth

cm

Concentration

mg/L

3 0.000E+00 2.910E+02

1.000E-01 2.569E+02

5.300E-01 1.164E+02

9.600E-01 3.779E+01

1.390E+00 1.426E+01

1.820E+00 1.038E+01
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2.250E+00 1.002E+01

2.680E+00 1.000E+01

3.110E+00 1.000E+01

3.540E+00 1.000E+01

3.970E+00 1.000E+01

4.400E+00 1.000E+01

4.500E+00 1.000E+01

6 0.000E+00 2.596E+02

1.000E-01 2.398E+02

5.300E-01 1.491E+02

9.600E-01 7.573E+01

1.390E+00 3.391E+01

1.820E+00 1.664E+01

2.250E+00 1.140E+01

2.680E+00 1.022E+01

3.110E+00 1.003E+01

3.540E+00 1.000E+01

3.970E+00 1.000E+01

4.400E+00 1.000E+01

4.500E+00 1.000E+01

9 0.000E+00 2.394E+02

1.000E-01 2.253E+02

5.300E-01 1.586E+02

9.600E-01 9.690E+01

1.390E+00 5.273E+01

1.820E+00 2.758E+01

2.250E+00 1.602E+01

2.680E+00 1.172E+01

3.110E+00 1.040E+01

3.540E+00 1.008E+01

3.970E+00 1.001E+01

4.400E+00 1.000E+01

4.500E+00 1.000E+01

12 0.000E+00 2.243E+02

1.000E-01 2.135E+02

5.300E-01 1.610E+02

9.600E-01 1.088E+02

1.390E+00 6.682E+01

1.820E+00 3.859E+01

2.250E+00 2.256E+01

2.680E+00 1.480E+01

3.110E+00 1.160E+01

3.540E+00 1.046E+01

3.970E+00 1.012E+01

4.400E+00 1.004E+01

4.500E+00 1.003E+01

15 0.000E+00 2.124E+02

1.000E-01 2.036E+02

5.300E-01 1.605E+02

9.600E-01 1.158E+02
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1.390E+00 7.699E+01

1.820E+00 4.814E+01

2.250E+00 2.948E+01

2.680E+00 1.891E+01

3.110E+00 1.365E+01

3.540E+00 1.134E+01

3.970E+00 1.045E+01

4.400E+00 1.020E+01

4.500E+00 1.019E+01

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
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6.9 Example 9: Freundlich Non-linear Sorption

Freundlich non-linear sorption is considered in analyzing a laboratory diffusion test for Phenol in this
example. The sample is a 7 cm thick undisturbed clay, with a 6.5 cm leachate column above for a
source. 

6.9.1 Description

In this example a laboratory test is simulated using diffusion and Freundlich non-linear sorption. The
sample is a 7 cm thick clay with an impermeable base and a finite mass source of Phenol. The leachate
source has an initial concentration (c

o
) of 50 mg/L, and the physical height of the leachate in the

reservoir above the soil was 6.5 cm. Parameters for the Freundlich isotherm were obtained
experimentally from batch tests, these are K

f
=2 and =0.628.

Following are the parameters used in this example:

Property Symbol Value Units

Darcy Velocity va 0 m/a

Diffusion Coefficient D 0.019 cm2/hr

Sorption Coefficient Kf 2 cm3/g

Soil Porosity n 0.46 -

Dry Density 1.47 g/cm3

Soil Layer Thickness H 7 cm

Number of Sub-layers 14 -

Source Concentration co 50 mg/L

Ref. Height of Leachate Hr 6.5 cm

When using non-linear sorption the accuracy of the solution is dependent on the number of
sub-layers used.

6.9.2 Data Entry

Open the Examples project and open Case 9. 

General Tab
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On the General tab the Darcy velocity is set to zero for pure diffusion. The concentrations can either be
calculated at specified times or the time of the maximum concentration can be found. In this example
the concentrations will be calculated at 4 times: 200, 400, 600, and 800 years.

Layers Tab

When using non-linear sorption the Distribution Coefficient is automatically calculated. The value entered
on this tab is ignored by the program.There are no fractures in the layer. For pure diffusion even if there
were fractures it should be modelled as if the soil was unfractured, since there would be no flow in the
fractures for pure diffusion through the matrix.

Boundaries Tab
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In this example, the top boundary has a finite mass and the bottom boundary is represented as a zero
flux layer.

 
Special Features

The non-linear sorption for this example is specified using the Special Features tab.

Non-linear Sorption
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To specify the Freundlich non-linear sorption, check the Non-linear Sorption box on the Special Features
tab. The Non-linear Sorption Data sub-tab can be used to specify the type of sorption as either
Freundlich or Langmuir.

The Freundlich non-linear sorption parameters are determined experimentally. The iterative procedure
used to determine the distribution coefficient is repeated until either the maximum change in
concentrations between iterations is less than 0.1% or the
maximum number of iterations is reached. Minimum reference concentration is the minimum value that
will be used in calculating the distribution coefficient. If the average concentration in a sub-layer is less
than this minimum reference value, then the reference value is used in the calculation of the distribution
coefficient.

6.9.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

.

6.9.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Depth vs Concentration

The Depth vs Concentration chart can be displayed by selecting the Depth vs Concentration item for the
Chart Type.
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Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab. 

POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 9: Freundlich Non-linear sorption 

THE DARCY VELOCITY (Flux) THROUGH THE LAYERS  Va = 0 m/year
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 Layer Properties 

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Clay 7 cm 14 0.019 cm²/hr 0.46 0 cm³/g 1.47 g/cm³

 Non-Linear Sorption 

     Maximum Number of Iterations = 10

     Minimum Reference Concentration = 0.1 mg/L

     Freundlich Sorption Isotherm S = Kf * c^E

Layer Kf E

Clay 2 0.628

 Boundary Conditions

    Finite Mass Top Boundary

          Initial Concentration = 50 mg/L

          Rate of Increase = 0 mg/L/yr

          Volume of Leachate Collected = 0 m/a

          Thickness of Waste = 0 m

          Waste Density  = 0 kg/m³

          Proportion of Mass = 0

          Volumetric Water Content = 0

          Conversion Rate Half Life = 0 year

          Reference Height of Leachate = 6.5 cm

    Zero Flux Bottom Boundary

 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Calculated Concentrations at Selected Times and Depths 

Time

hr

Depth

cm

Concentration

mg/L

200 0.000E+00 3.915E+01

5.000E-01 3.022E+01

1.000E+00 2.143E+01

1.500E+00 1.367E+01

2.000E+00 7.618E+00

2.500E+00 3.521E+00

3.000E+00 1.233E+00
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3.500E+00 2.728E-01

4.000E+00 3.002E-02

4.500E+00 1.801E-03

5.000E+00 6.511E-05

5.500E+00 1.412E-06

6.000E+00 1.834E-08

6.500E+00 1.499E-10

7.000E+00 5.539E-12

400 0.000E+00 3.562E+01

5.000E-01 3.009E+01

1.000E+00 2.439E+01

1.500E+00 1.884E+01

2.000E+00 1.376E+01

2.500E+00 9.404E+00

3.000E+00 5.917E+00

3.500E+00 3.349E+00

4.000E+00 1.645E+00

4.500E+00 6.591E-01

5.000E+00 1.935E-01

5.500E+00 3.828E-02

6.000E+00 5.748E-03

6.500E+00 6.747E-04

7.000E+00 1.213E-04

600 0.000E+00 3.321E+01

5.000E-01 2.914E+01

1.000E+00 2.486E+01

1.500E+00 2.057E+01

2.000E+00 1.643E+01

2.500E+00 1.261E+01

3.000E+00 9.239E+00

3.500E+00 6.408E+00

4.000E+00 4.156E+00

4.500E+00 2.478E+00

5.000E+00 1.324E+00

5.500E+00 6.085E-01

6.000E+00 2.267E-01

6.500E+00 6.795E-02

7.000E+00 3.012E-02

800 0.000E+00 3.136E+01

5.000E-01 2.812E+01

1.000E+00 2.469E+01

1.500E+00 2.119E+01

2.000E+00 1.772E+01

2.500E+00 1.441E+01

3.000E+00 1.135E+01

3.500E+00 8.617E+00

4.000E+00 6.273E+00

4.500E+00 4.347E+00

5.000E+00 2.841E+00

5.500E+00 1.736E+00
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6.000E+00 9.974E-01

6.500E+00 5.794E-01

7.000E+00 4.451E-01

   Convergence Check for Non-linear Sorption

Time

hr

Iterations Maximum Change

200 10 0.162

400 9 0.0977

600 9 0.0325

800 8 0.0783

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.



POLLUTEv8312

© 2021 GAEA Technologies Ltd.

6.10 Example 10: Time-varying Transport

In this example the Variable Properties option is used to examine time-varying advective-dispersive
transport from a landfill. A landfill with a finite mass and a leachate collection system with an inward
Darcy Velocity (i.e., a hydraulic trap) is considered. The leachate collection system is assumed to begin
to fail after 19 years. After failure of the leachate collection system the leachate mound builds over a 10
year period, causing a reversal in the hydraulic gradient and a loss of the hydraulic trap.

6.10.1 Description

This example illustrates the use of the programs to study time-varying rates of advective-dispersive
transport from a landfill, using the Variable Properties special feature. The landfill contains a finite mass
of a conservative species, and has a leachate collection system. Initially there is an inward hydraulic
gradient causing a hydraulic trap. After 20 years the collection of leachate is terminated and the leachate
mound begins to build reaching it’s maximum height after another 10 years. The increased leachate
mound causes a reversal in the hydraulic gradient, that results in a reversal of the Darcy velocity and the
loss of the hydraulic trap.

The analysis starts at time zero which corresponds to the completion of the landfill and the development
of a peak leachate concentration (c

o
) of 1000 mg/L. It is assumed that the average waste thickness is

6.25 m with a density of 600 kg/m3, and that the contaminant represents 0.2% of the total mass of the
waste. Thus the total mass of contaminant per unit area of landfill is:

m
tc 

= 0.002 * 600 = 6.25 kg/m2

The Reference Height of Leachate (H
r
) is then calculated by dividing the total mass of contaminant per

unit area (m
tc

) by the contaminant concentration (c
o
).

H
r
 = (0.002 * 600 * 6.25) / 1 = 7.5 m

It is also assumed that the peak concentration in the landfill is reached relatively early in the life of the
landfill, and that the analysis starts at this time. Consequently there is no increase in concentration with
time and the Rate of Increase in Concentration (c

r
) with time is zero. 

The average infiltration through the cover (qo) is assumed to be 0.3 m/a. If the average exfiltration through
the base of the landfill is va (which varies with time), then the Volume of Leachate Collected is:

Q
c
 = q

o
 - v

a
 = 0.3 - v

a

In this example the landfill is situated in a 4 m thick clay, which in underlain by an aquifer. The landfill is
assumed to be 200 m long in the direction parallel to the groundwater flow in the aquifer. At the up
gradient edge of the landfill the inflow in the aquifer is given by a Darcy velocity of 2 m/a. The outflow
Darcy velocity at the down gradient edge of the landfill (v

b
) is assumed to be 2 m/a from years 0 to 20,

then increasing between 20 and 30 years according to the relationship:

v
b
 = 2 + 200 * v

a

After 30 years the outflow Darcy velocity (v
b
) is 6.2 m/a.
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When using the Variable Properties special feature it is possible to independently specify the diffusion
coefficient (D

m
) and the dispersivity. In this example the dispersivity is assumed to be zero for inward

flow (i.e., va < 0), and is 0.4 m for outward flow (i.e., v
a
 > 0). The coefficient of hydrodynamic dispersion

(D) is then calculated by:

D = D
m

 + α * v
a
/n

where n is the porosity, in this example 0.4.

Following are the parameters used in this example:

Property Symbol Value Units

Darcy Velocity va variable m/a

Diffusion Coefficient D 0.02 m2/a

Distribution Coefficient Kd 0 cm3/g

Dispersivity (va < 0) 0 m

Dispersivity (va > 0) 0.4 m

Soil Porosity n 0.4 -

Dry Density 1.5 g/cm3

Soil Layer Thickness Hr 4 m

Number of Sub-layers 12 -

Source Concentration c0 1000 mg/L

Ref. Height of Leachate H
r 7.5 m

Volume of Leachate Collected Qc variable m/a

Landfill Length L 200 m

Landfill Width W 1 m

Aquifer Thickness Hr 1 m

Aquifer Porosity nb 0.3

Aquifer Outflow Velocity vb variable m/a

When using the Variable Properties special feature the accuracy of the solution is dependent on the
number of sub-layers used.

This example is for a hypothetical landfill and is used to illustrate how to prepare an input file
and run an analysis using the Variable Properties option. The example is not a prescription for
modeling contaminant migration during operation and failure of a landfill.Each landfill has its
own unique characteristics and no general prescription can be made. The Variable Properties
option should only by used by someone with the hydrogeologic and engineering background
necessary to appreciate the subtleties associated with the physical situation and the steps
necessary for appropriate modeling of this physical situation. 

6.10.2 Data Entry

Open the Examples project and open Case 10. 

General Tab
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In the General tab the Darcy velocity can be specified. If the Time-varying Properties special feature is
used, any Darcy velocity entered will be ignored. The concentrations can either be calculated at specified
times or the time of the maximum concentration can be found. When the time-varying properties special
feature is used the times to calculate the concentrations are specified in the Time-Varying Properties. In
this example the concentrations will be calculated at 5 depths: 0, 1, 2, 3, and 4 m

Layers Tab

The layer data for the layer can be specified on the Layers tab.

Boundaries Tab
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In this example, the top boundary has a finite mass and the bottom boundary is represented by a fixed
outflow aquifer. If the Time-varying Properties special feature is selected, any parameters entered for the
Finite Mass will be ignored and the source parameters will be entered in the Time-Varying Properties
sub-tab of the Special Features tab.

Special Features

The time-varying properties for this example is specified using the Special Features tab. 

Time Varying Properties

To specify the time-varying properties, check the Time-Varying Properties box on the Special Features
tab. The Time-Varying Data sub-tab is used to specify the time varying properties. In this example there
are 3 time periods viz. 0 to 20 years, 20 to 30 years, and 30 to 130 years.
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In the first time period, specifying only one time increment means that the concentrations will only be
calculated at the end time (i.e., 20 years). A negative Darcy velocity indicates the flow is upwards.Since
the first time period corresponds to an operating leachate collection system and there is no additional
mass entering the landfill; there is no increase in source concentration, Darcy velocity, volume of
leachate collected, or base velocity
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The data for time period two can be specified by pressing the Next button. This time period is from 20 to
30 years.Between the years 20 and 30 the velocities increase linearly with time, this will be
approximated by a series of incremental increase at 1 year intervals. Thus there are 10 increments
starting at year 21 and ending at year 30. Specifying the source concentration as -1 causes the
calculated concentration at the end of the previous period to be used as the concentration at the
beginning of this period. 

The Darcy velocity and dispersivity are the values at the beginning of the time period. When operation of
the leachate collection system is terminated the leachate mound begins to rise causing the Darcy
velocity to reverse direction and become positive. A positive Darcy velocity results in the dispersivity
becoming 0.4.

The increment in Darcy velocity represents the change for each one year increment. Assuming the
infiltration through the cover is constant the increment in the volume of leachate collected will be equal
and opposite to the increment in the Darcy velocity. The increment in the base velocity is equal to the
increment in the Darcy velocity multiplied by the length of the landfill (i.e., 0.0021 * 200 = 0.42 m/a).
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The data for time period three can be entered by clicking on the Next button, this time period is from 30
to 130 years. During the 100 years between 30 and 130 years the velocities remain constant. By
specifying 10 increments the concentrations will be calculated and listed every 10 years during this
period. The Darcy velocity is the resulting velocity from the build-up of leachate after the failure of the
leachate collection system. 

Since the leachate collection has completely failed by the start of this time period and the leachate
mound has fully developed, there is no further increase in the velocities. Note that there will still be some
leachate collected by the toe drains, which are assumed to be functioning even though the leachate
collection system has failed.

The volume of leachate collected by the toe drains is equal to the infiltration through the cover minus the
downward Darcy velocity (i.e., 0.3 - 0.021 = 0.279 m/a). And the base velocity is equal to the inflow plus
the Darcy velocity times the landfill length (i.e., 2 + 200*0.021 = 6.2 m/a).

6.10.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

.
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6.10.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Depth vs Concentration

The Depth vs Concentration chart can be displayed by selecting the Depth vs Concentration item for the
Chart Type.

Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab. 

POLLUTEv8
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Version 8.00 Beta
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Case 10: Time-varying advective-dispersive transport

THE VARIABLE VELOCITY AND/OR CONCENTRATION OPTION HAS BEEN USED. NOTE THAT THE ACCURACY OF THE

CALCULATIONS WITH THIS OPTION WILL DEPEND ON THE NUMBER OF SUBLAYERS USED.

 Layer Properties 

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Aquitard 4 m 12 0.02 cm²/a 0.4 0 m³/kg 1.5 g/cm³

 Boundary Conditions

    Finite Mass Top Boundary

    Fixed Outflow Bottom Boundary

          Landfill Length = 200 m

          Landfill Width = 1 m

          Base Thickness = 1 m

          Base Porosity  = 0.3

 Variation in Properties with Time

  Time Periods with the same Source and Velocity

Period Start Time No. of

 Steps

Time Step Source Conc Rate of

Change

Height of

Leachate

Volume

Collected

1 0  yr 1 20  yr 1000  mg/L 0 7.5  m 0.3  m/a

2 20  yr 10 1  yr -1  mg/L 0 7.5  m 0.3  m/a

3 30  yr 10 10  yr -1  mg/L 0 7.5  m 0.279  m/a

 
Period Start Time End Time Proportion Mass Dispersivity Base Velocity

1 0  yr 20  yr -0.001  m/a 0  m 2  m/a

2 20  yr 30  yr 0  m/a 0.4  m 2  m/a

3 30  yr 130  yr 0.021  m/a 0.4  m 6.2  m/a

 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Calculated Concentrations at Selected Times and Depths 
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Time

year

Depth

m

Concentration

mg/L

20 0.000E+00 4.493E+02

1.000E+00 0.000E+00

2.000E+00 0.000E+00

3.000E+00 0.000E+00

4.000E+00 0.000E+00

21 0.000E+00 4.317E+02

1.000E+00 1.000E-06

2.000E+00 1.000E-06

3.000E+00 1.000E-06

4.000E+00 9.673E-07

22 0.000E+00 4.140E+02

1.000E+00 1.000E-06

2.000E+00 1.000E-06

3.000E+00 1.000E-06

4.000E+00 9.373E-07

23 0.000E+00 3.968E+02

1.000E+00 1.001E-06

2.000E+00 1.000E-06

3.000E+00 1.000E-06

4.000E+00 9.095E-07

24 0.000E+00 3.803E+02

1.000E+00 2.075E-06

2.000E+00 1.000E-06

3.000E+00 1.000E-06

4.000E+00 8.842E-07

25 0.000E+00 3.645E+02

1.000E+00 3.657E-04

2.000E+00 1.000E-06

3.000E+00 9.998E-07

4.000E+00 8.613E-07

26 0.000E+00 3.495E+02

1.000E+00 2.295E-02

2.000E+00 1.001E-06

3.000E+00 9.995E-07

4.000E+00 8.408E-07

27 0.000E+00 3.352E+02

1.000E+00 3.112E-01

2.000E+00 1.088E-06

3.000E+00 9.988E-07

4.000E+00 8.226E-07

28 0.000E+00 3.215E+02

1.000E+00 1.726E+00

2.000E+00 7.774E-06

3.000E+00 9.978E-07

4.000E+00 8.068E-07

29 0.000E+00 3.085E+02

1.000E+00 5.600E+00

2.000E+00 2.971E-04

3.000E+00 9.977E-07
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4.000E+00 7.931E-07

30 0.000E+00 2.960E+02

1.000E+00 1.295E+01

2.000E+00 5.209E-03

3.000E+00 1.064E-06

4.000E+00 7.815E-07

40 0.000E+00 1.981E+02

1.000E+00 1.340E+02

2.000E+00 2.090E+01

3.000E+00 7.031E-01

4.000E+00 1.518E-03

50 0.000E+00 1.335E+02

1.000E+00 1.575E+02

2.000E+00 7.950E+01

3.000E+00 1.634E+01

4.000E+00 5.856E-01

60 0.000E+00 9.010E+01

1.000E+00 1.379E+02

2.000E+00 1.154E+02

3.000E+00 5.128E+01

4.000E+00 6.323E+00

70 0.000E+00 6.092E+01

1.000E+00 1.093E+02

2.000E+00 1.218E+02

3.000E+00 8.301E+01

4.000E+00 2.051E+01

80 0.000E+00 4.123E+01

1.000E+00 8.260E+01

2.000E+00 1.112E+02

3.000E+00 9.947E+01

4.000E+00 3.836E+01

90 0.000E+00 2.792E+01

1.000E+00 6.081E+01

2.000E+00 9.372E+01

3.000E+00 1.013E+02

4.000E+00 5.314E+01

100 0.000E+00 1.892E+01

1.000E+00 4.404E+01

2.000E+00 7.521E+01

3.000E+00 9.350E+01

4.000E+00 6.134E+01

110 0.000E+00 1.283E+01

1.000E+00 3.155E+01

2.000E+00 5.844E+01

3.000E+00 8.093E+01

4.000E+00 6.283E+01

120 0.000E+00 8.705E+00

1.000E+00 2.242E+01

2.000E+00 4.439E+01

3.000E+00 6.701E+01
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4.000E+00 5.926E+01

130 0.000E+00 5.907E+00

1.000E+00 1.585E+01

2.000E+00 3.316E+01

3.000E+00 5.371E+01

4.000E+00 5.264E+01

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
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6.11 Example 11: Time-varying Source Concentration

This example demonstrates the use of a time-varying source concentration and an initial concentration
profile. A landfill cell is initially filled with fresh water, and no waste is deposited for 7 years. The landfill is
situated in a clay with a pore water chloride concentration, during the initial 7 years the chloride from the
clay diffuses into the cell water. Between 7 and 10 years the cell is filled with waste and the chloride
concentration increases linearly to 2100 mg/L. The source concentration then remains constant between
10 and 13 years. Between 13 and 15 years the source concentration decreases linearly to 1180 mg/L.
The source concentration then remains constant between 15 and 19 years.

6.11.1 Description

In this example there is a time-varying source concentration history and diffusive transport of a
conservative species (i.e., no sorption) from a landfill. Time zero corresponds to the excavation of a
landfill cell, the cell then filled quickly with water to a depth of 6 m. No waste was added to the cell for 7
years. The landfill is situated in a clay that contains chloride in its pore water at a concentration of 120
mg/L. During the 7 years that the cell contained water the chloride began to diffused out of the clay pore
water and into the cell water. Between the years 7 and 10, waste was added to the cell and the source
concentration of chloride increased linearly with time reaching a peak value at year 10 of 2100 mg/L. The
source concentration of chloride then remained relatively constant between the years 10 and 13. During
the years 13 to 15 the source concentration decreased linearly with time to a value of 1180 mg/L at year
15. The source concentration then remained relatively constant again from years 15 to 19. This example
will calculate the predicted chloride distribution with depth at year 19.

There is no leachate collection system in the landfill, and the water level in the waste corresponds to the
natural water level. The hydraulic gradient is zero, and hence the Darcy velocity is zero. And the clay is
sufficiently thick that it can be assumed to be infinite for the time period under consideration.

When using the Variable Properties special feature it is possible to independently specify the diffusion
coefficient (D

m
) and the dispersivity. In this example the dispersivity is assumed to be zero since there is

no flow. Clearly if there is no flow then the value of the dispersivity is not relevant since the coefficient of
hydrodynamic dispersion (D) is then calculated by:

D = D
m

 + α * v
a
 /n

The Reference Height of Leachate for this example is the same as the depth of water in the cell (i.e., 6
m). In this example the source concentration is assigned specific values at various times by setting the
value of the Reference Height of Leachate very large. Setting the Reference Height of Leachate very large
will ensure that the source concentration remains constant during that time interval.

Following are the parameters used in this example:

Property Symbol Value Units

Darcy Velocity va 0 m/a

Diffusion Coefficient Dm 0.00663 m2/a

Distribution Coefficient Kd 0 cm3/g

Dispersivity 0 m

Soil Porosity n 0.37 -

Dry Density 1.6 g/cm3

Soil Layer Thickness infinite m
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Thickness of Interest Hr 1.5 m

Number of Sub-layers 15 -

Source Concentration c0 variable mg/L

Ref. Height of Leachate H
r 6 m

Volume of Leachate Collected Qc 0 m/a

When using the Variable Properties special feature the accuracy of the solution is dependent on the
number of sub-layers used.

This example is for a hypothetical landfill and is used to illustrate how to prepare an input file
and run an analysis using the Variable Properties option. The example is not a prescription for
modeling contaminant migration from a landfill. Each landfill has its own unique
characteristics and no general prescription can be made. The Variable Properties option
should only by used by someone with the hydrogeologic and engineering background
necessary to appreciate the subtleties associated withthe physical situation and the steps
necessary for appropriate modeling of this physical situation. 

6.11.2 Data Entry

Open the Examples project and open Case 11. 

General Tab

In the General tab the Darcy velocity can not be specified if the Time-varying Properties special feature is
used. Any Darcy velocity entered will be ignored. When the time-varying properties special feature is
used the times to calculate the concentrations are specified in the Time-Varying Properties sub-tab of
the Special Features tab.. 
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Layers Tab

The layer data for the layer can be specified on the Layers tab. Although the clay layer is assumed to be
infinite, the concentrations for only the top 1.5 m will be calculated. This is the depth interval where the
contaminant plume is expected.

Boundaries Tab

In this example, the top boundary has a finite mass and the bottom boundary is represented by a layer of
infinite thickness. If the Time-varying Properties special feature has been selected, any parameters
entered for the Finite Mass tab will be ignored and the will be entered in the Time-Varying Properties sub-
tab of the Special Features tab.

Special Features
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The initial concentration profile and time-varying properties for this example are specified using the
Special Features tab.

Initial Concentration Profile

To specify the initial concentration profile, check the Initial Concentration Profile box on the Special
Features tab. The Concentration Profile sub-tab can be used to specify the type of profile as either Depth
Intervals or Sublayers. The concentration profile can be specified as a constant for given depth intervals
or as a different value for every sublayer. In this example the background concentration is uniform with
depth, and can be specified as a constant 120 mg/L over 1 depth interval.

Time Varying Properties

To specify the time-varying properties, check the Time-Varying Properties box on the Special Features
tab. The Time-Varying Data sub-tab can be used to the time periods and whether there are variable layer
properties and variable decay. In this example there are 5 time periods viz. 0 to 7 years, 7 to 10 years,
10 to 13 years, 13 to 15 years, and 15 to 19 years.
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In the first time period, specifying only one time increment means that the concentrations will only be
calculated at the end time (i.e., 7 years).The beginning source concentration is zero, since fresh water is
initially filling the cell.
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The data for time period two can be specified by clicking on the Next button. This time period is from 7 to
10 years. Between the years 7 and 10 the source concentration increases linearly with time at a rate of
700 mg/L per year. Only one time increment is necessary, since we are not interested in calculating the
concentrations at any intermediate times. Specifying the source concentration as -1 causes the
calculated concentration at the end of the previous period to be used as the concentration at the
beginning of this period. The Leachate Reference Height is set very high in order to ignore the effects of
source depletion.

Next the data for time period three should be entered, this time period is from 10 to 13 years. During the
3 years between 10 and 13 years the source concentration remains constant. Specifying the beginning
concentration as -1 indicates to use the calculated concentration at the end of the previous time period
as the concentration at the start of this time period. The Leachate Reference Height is set very high in
order to ignore the effects of source depletion.
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Next the data for time period four should be entered, this time period is from 13 to 15 years. Between the
years 13 and 15 the source concentration decreases linearly with time at the rate of 460 mg/L per year.
Specifying the beginning concentration as -1 indicates to use the calculated concentration at the end of
the previous time period as the concentration at the start of this time period. The Leachate Reference
Height is set very high in order to ignore the effects of source depletion.
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Data for the last time period can be entered by clicking on the Next button, this time period is from 15 to
19 years. For the 4 years between 15 and 19 the source concentration is assumed to remain constant at
1180 mg/L. The Leachate Reference Height is set very high in order to ignore the effects of depletion of
the source.

6.11.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

.

6.11.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Depth vs Concentration

The Depth vs Concentration chart can be displayed by selecting the Depth vs Concentration item for the
Chart Type.
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Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab. 

POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 11: Time varying source concentration with background

THE VARIABLE VELOCITY AND/OR CONCENTRATION OPTION HAS BEEN USED. NOTE THAT THE ACCURACY OF THE

CALCULATIONS WITH THIS OPTION WILL DEPEND ON THE NUMBER OF SUBLAYERS USED.
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 Layer Properties 

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Clay 1.5 m 15 0.00663 cm²/day 0.37 0 m³/kg 1.6 g/cm³

 Boundary Conditions

    Finite Mass Top Boundary

    Infinite Thickness Bottom Boundary

 INITIAL CONCENTRATION PROFILE

          Time = 0 yr

          Flux into Soil = 0 m²/a

          Flux into Base = 0 m²/a

Top Depth Bottom Depth Concentration

0  m 0.1  m 120  mg/L

0.1  m 0.2  m 120  mg/L

0.2  m 0.3  m 120  mg/L

0.3  m 0.4  m 120  mg/L

0.4  m 0.5  m 120  mg/L

0.5  m 0.6  m 120  mg/L

0.6  m 0.7  m 120  mg/L

0.7  m 0.8  m 120  mg/L

0.8  m 0.9  m 120  mg/L

0.9  m 1  m 120  mg/L

1  m 1.1  m 120  mg/L

1.1  m 1.2  m 120  mg/L

1.2  m 1.3  m 120  mg/L

1.3  m 1.4  m 120  mg/L

1.4  m 1.5  m 120  mg/L

1.5  m 1.6  m 120  mg/L

 Variation in Properties with Time

  Time Periods with the same Source and Velocity

Period Start Time No. of

 Steps

Time Step Source Conc Rate of

Change

Height of

Leachate

Volume

Collected

1 0  yr 1 7  yr 0  mg/L 0 6  m 0  m/a

2 7  yr 1 3  yr -1  mg/L 700 1E15  m 0  m/a

3 10  yr 1 3  yr -1  mg/L 0 1E15  m 0  m/a

4 13  yr 1 2  yr -1  mg/L -460 1E15  m 0  m/a

5 15  yr 1 4  yr 1180  mg/L 0 1E15  m 0  m/a
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Period Start Time End Time Proportion Mass Dispersivity Base Velocity

1 0  yr 7  yr 0  m/a 0  m 0  m/a

2 7  yr 10  yr 0  m/a 0  m 0  m/a

3 10  yr 13  yr 0  m/a 0  m 0  m/a

4 13  yr 15  yr 0  m/a 0  m 0  m/a

5 15  yr 19  yr 0  m/a 0  m 0  m/a

 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Calculated Concentrations at Selected Times and Depths 

Time

year

Depth

m

Concentration

mg/L

7 0.000E+00 3.429E-01

1.000E-01 1.097E+02

2.000E-01 1.199E+02

3.000E-01 1.200E+02

4.000E-01 1.200E+02

5.000E-01 1.200E+02

6.000E-01 1.200E+02

7.000E-01 1.200E+02

8.000E-01 1.200E+02

9.000E-01 1.200E+02

1.000E+00 1.200E+02

1.100E+00 1.200E+02

1.200E+00 1.200E+02

1.300E+00 1.200E+02

1.400E+00 1.200E+02

1.500E+00 1.200E+02

10 0.000E+00 2.100E+03

1.000E-01 7.684E+01

2.000E-01 1.182E+02

3.000E-01 1.200E+02

4.000E-01 1.200E+02

5.000E-01 1.200E+02

6.000E-01 1.200E+02

7.000E-01 1.200E+02

8.000E-01 1.200E+02

9.000E-01 1.200E+02

1.000E+00 1.200E+02

1.100E+00 1.200E+02

1.200E+00 1.200E+02

1.300E+00 1.200E+02

1.400E+00 1.200E+02

1.500E+00 1.200E+02

13 0.000E+00 2.100E+03

1.000E-01 1.935E+02
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2.000E-01 1.117E+02

3.000E-01 1.197E+02

4.000E-01 1.200E+02

5.000E-01 1.200E+02

6.000E-01 1.200E+02

7.000E-01 1.200E+02

8.000E-01 1.200E+02

9.000E-01 1.200E+02

1.000E+00 1.200E+02

1.100E+00 1.200E+02

1.200E+00 1.200E+02

1.300E+00 1.200E+02

1.400E+00 1.200E+02

1.500E+00 1.200E+02

15 0.000E+00 1.180E+03

1.000E-01 2.810E+02

2.000E-01 1.212E+02

3.000E-01 1.187E+02

4.000E-01 1.200E+02

5.000E-01 1.200E+02

6.000E-01 1.200E+02

7.000E-01 1.200E+02

8.000E-01 1.200E+02

9.000E-01 1.200E+02

1.000E+00 1.200E+02

1.100E+00 1.200E+02

1.200E+00 1.200E+02

1.300E+00 1.200E+02

1.400E+00 1.200E+02

1.500E+00 1.200E+02

19 0.000E+00 1.180E+03

1.000E-01 3.584E+02

2.000E-01 1.442E+02

3.000E-01 1.196E+02

4.000E-01 1.198E+02

5.000E-01 1.200E+02

6.000E-01 1.200E+02

7.000E-01 1.200E+02

8.000E-01 1.200E+02

9.000E-01 1.200E+02

1.000E+00 1.200E+02

1.100E+00 1.200E+02

1.200E+00 1.200E+02

1.300E+00 1.200E+02

1.400E+00 1.200E+02

1.500E+00 1.200E+02

 NOTICE 
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Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
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6.12 Example 12: POLLUTE vs. Analytical Solution

In this example the results of the program are compared with an analytical solution developed by Tang et
al. (1981). The analysis is for a single fracture system. It is shown that the program gives exactly the
same results as the analytical solution.

6.12.1 Description

The results obtained from POLLUTE are compared to those obtained by an analytical solution developed
by Tang et al. (1981) for a single fracture system. A conservative contaminant is considered with a
constant source concentration of 1. The fractures are 10 µm wide, have a groundwater (seepage) velocity
along the fracture of 730 m/a, a dispersivity of zero, and a diffusion coefficient along the fractures of 0.077

m2/a. In this comparison the fracture spacing is 1 m. Because of the very low matrix diffusion coefficient
there is no interaction between fractures over the time frame considered, thus the same result would be
obtained if the fracture spacing were increased to 10 m. The Darcy velocity, which occurs along the
fractures, can be calculated by multiplying the fractures per m times the fracture width times the
seepage velocity:

v
a
 = 10x10-6 * 1 * 730 = 0.73x10-2

A porosity of 0.05 and tortuosity (the ratio of effective diffusion coefficient to the molecular diffusion
coefficient in water) of 0.0000983 were assumed for the matrix material. The matrix diffusion coefficient is
then given by multiplying the fracture diffusion coefficient and the tortuosity:

D
m

 = 0.077 * 0.0000983 = 7.5691x10-6

The following parameters are defined for this example:

Property Symbol Value Units

Darcy Velocity va 7.30E-03 m/a

Soil Thickness H 400 m

Number of Sub-layers 4 -

Fracture spacing 2H1 1 m

Fracture opening 2h
1 10E-6 m

Dispersion along fractures D
f 0.077 m2/a

Fracture Distribution Coef. Kf 0 cm3/g

Matrix Diffusion Coefficient Dm 7.57E-6 m2/a

Matrix Distribution Coef. Km 1 cm3/g

Matrix Porosity nm 0.05 -

Dry Density of Matrix 0 g/cm3

Source Concentration c0 1 mg/L

6.12.2 Data Entry

Open the Examples project and open Case 12. 
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General Tab

The general data for this example can be specified on the General tab. The Darcy velocity can be

specified as 0.73x10-2. The Run Parameters can be specified at the bottom of the tab. In this example
the concentrations will be calculated at 25 years and at 4 depths: 100, 200, 300, and 400 m.

Layers Tab
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The layer data for the layer can be specified on the Layers tab. The data for the one dimensional
fractures can be specified when the layer is selected. The fracture opening size is the gap between the
walls of the fracture. 

Boundaries Tab
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The boundary conditions for the model can be specified on the Boundaries tab. In this example, the top
boundary has a constant concentration and the bottom boundary is represented by a layer of infinite
thickness.

Special Features

The maximum sublayer thickness for this example can be specified using the Special Features tab.

Maximum Sublayer Thickness

The default maximum sublayer thickness is 5 depth units. This maximum is set to avoid problems with
exponential overflow, which can sometimes occur if the sublayers are too thick. To override the default
maximum sublayer thickness the Maximum Sublayer Thickness feature is used, when over riding this
default the user takes the chance that the program will “crash” or give false results - caveat emptor.
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To specify the maximum sublayer thickness check the Maximum Sublayer Thickness box item from the
Special Features tab, By specifying the maximum sublayer thickness as 100.01 the sublayers can be
up to 100.01 units thick. In this example the sublayers are 100 units thick.

6.12.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

6.12.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Output Comparison

The results given by analytical solution can be compared to the output by creating a new imported
dataset using File > New > Imported Dataset.
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The calculated concentrations from the POLLUTE program and the analytical solution by Tang et al.
(1981) are listed below. Both solutions give identical results.

Depth POLLUTE Analytical Solution

(m) (mg/L) (mg/L)

100 0.593 0.593

200 0.2838 0.2838

300 0.1069 0.1069

400 0.0311 0.0311

Depth vs Concentration

The Depth vs Concentration chart can be displayed by selecting the Depth vs Concentration item for the
Chart Type.
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Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab. 

POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 12: POLLUTE vs Analytical solution

THE DARCY VELOCITY (Flux) THROUGH THE LAYERS  Va = 0.0073 m/year
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 Layer Properties 

 
Layer Fracture

Spacing

1

Opening

Size

1

Number

1

Fracture

Spacing

2

Opening

Size

2

Number

2

Fracture

Spacing

3

Opening

Size

3

Number

3

Soil 1 m 1E-5 m 10

 
Layer Dispersion

Coefficient in

Fractures

Distribution

Coefficient in

Fractures

Fracture Porosity Retardation

Coefficient in Matrix

Soil 0.077 m²/a 0 m³/kg 1.0000E-05 1.0000E+00

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Soil 400 m 4 7.569E-6 m²/a 0.05 0 m³/kg 0 g/cm³

 Boundary Conditions

    Constant Concentration

          Source Concentration = 1 mg/L

    Infinite Thickness Bottom Boundary

 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Calculated Concentrations at Selected Times and Depths 

Time

year

Depth

m

Concentration

mg/L

25 0.000E+00 1.000E+00

1.000E+02 5.930E-01

2.000E+02 2.838E-01

3.000E+02 1.069E-01

4.000E+02 3.111E-02

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
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6.13 Example 13: Comparison with Analytical Method

The results of the program are compared to the results obtained by an analytical solution given by
TDAST. The TDAST program was developed by Javandel et al. (1984), and is for a 2-dimensional plane
dispersion problems in an infinitely deep porous media. Concentrations obtained by both methods are in
close agreement for a dispersion coefficient of 0.01 m2/a. However, at higher dispersion coefficients, for
example 5 or 10 m2/a, the methods are not in agreement. This is because for the geometry and time
frame considered in this problem, a 2-dimensional solution is required and POLLUTEv7 considers only 1-
dimensional migration in the layer below the source.

6.13.1 Description

In this example the results of POLLUTE are compared to those obtained by the analytical solution given
by TDAST. TDAST is a computer program for 2-D plane dispersion in an infinitely deep porous media,
developed by Javandel et al. (1984). An infinitely thick layer is considered, however for comparison
purposes the calculations will be restricted to the first 10 m. Below the layer the bottom boundary is
assumed to extend to infinity and have the same properties as the layer above. 

The following parameters are assumed for the example:

Property Symbol Value Units

Darcy Velocity va 1.0 m/a

Diffusion Coefficient D 0.01 m2/a

Distribution Coefficient Kd 0 cm3/g

Soil Porosity n 1 -

Dry Density 0 g/cm3

Soil Layer Thickness H 10 m

Number of Sub-layers 20 -

Source Concentration c0 1 g/L

Times of Interest 4 a

6.13.2 Data Entry

Open the Examples project and open Case 13. 

General Tab
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The general data for this example can be specified on the General tab. In this example there is one layer
and the Darcy velocity is 1 m/a. The times and depths to calculate the concentrations can be specified
at the bottom of this tab. menu. In this
example the concentrations will be calculated at 4 years and at 14 depths from 0.5 to 10 m.

Layers Tab
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The layer data for the layer can be specified on the Layers tab. When there is no sorption (i.e., the
distribution coefficient is zero) the dry density is not used and can be specified as zero. 

Boundaries Tab

The boundary conditions for the model can be specified on the Boundaries tab. In this example, the top
boundary has a constant concentration and the bottom boundary is represented by a layer of infinite
thickness. 
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6.13.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

6.13.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Output Comparison

The results given by TDAST can be compared to the output by creating a new imported dataset using
File > New > Imported Dataset.
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Concentrations obtained by both methods are in close agreement for a dispersion coefficient of 0.01

m2/a. However, it should be noted that at higher values of dispersion coefficient, for example 5 or 10

m2/a, the POLLUTE program will not give the same result as TDAST. This is because POLLUTE
considers only 1-dimensional migration in the layer below the source, whereas TDAST considers 2-
dimensional migration.

Depth vs Concentration

The Depth vs Concentration chart can be displayed by selecting the Depth vs Concentration item for the
Chart Type.

Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab. 
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POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 13: Comparison with analytical method

THE DARCY VELOCITY (Flux) THROUGH THE LAYERS  Va = 1 m/year

 Layer Properties 

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Soil 10 m 20 0.01 m²/a 1 0 m³/kg 0 g/cm³

 Boundary Conditions

    Constant Concentration

          Source Concentration = 1 mg/L

    Infinite Thickness Bottom Boundary

 Laplace Transform Parameters 

     TAU = 7     N = 100     SIG = 0     RNU = 10

 Calculated Concentrations at Selected Times and Depths 

Time

year

Depth

m

Concentration

mg/L

4 0.000E+00 1.000E+00

5.000E-01 1.000E+00

1.000E+00 1.000E+00

1.500E+00 1.000E+00

2.000E+00 1.000E+00

2.500E+00 1.000E+00

3.000E+00 9.998E-01

3.500E+00 9.646E-01

4.000E+00 5.141E-01

4.500E+00 4.133E-02

5.000E+00 2.277E-04

6.000E+00 1.928E-09

7.000E+00 1.927E-09
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8.000E+00 1.927E-09

9.000E+00 1.927E-09

1.000E+01 1.927E-09

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
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6.14 Example 14: Primary and Secondary Collection

In this example a landfill with primary and secondary leachate collection systems is modelled using the
Passive Sink option. The secondary leachate collection system is simulated using a passive sink to
model outflow from the collection system. The landfill contains a finite mass of a conservative species,
and is underlain by an aquifer with fixed outflow.

6.14.1 Description

In this example a landfill with both a primary and a secondary leachate collection system is modelled
using the Passive Sink special feature. The landfill contains a finite mass of a conservative contaminant
species, and is underlain by an aquifer with fixed outflow. A passive sink is used to model the secondary
leachate collection system, which is assumed to be composed of a 0.3 m thick granular layer. The
Darcy velocity is assumed to be 0.01 m/a downward from the landfill to the secondary leachate collection
system, and 0.0 m/a between the secondary leachate collection system and the aquifer (i.e., the water
table is assumed to be at the base of the secondary leachate collection system).

The analysis starts at time zero which corresponds to the completion of the landfill and the development
of a peak leachate concentration (co) of 1000 mg/L. It is assumed that the average waste thickness is
6.25 m with a density of 600 kg/m3, and that the contaminant represents 0.2% of the total mass of the
waste. Thus the total mass of contaminant per unit area of landfill is:

m
tc

 = 0.002 * 600 * 6.25 = 7.5 kg/m2

The Reference Height of Leachate (H
r
) is then calculated by dividing the total mass of contaminant per

unit area (m
tc

) by the contaminant concentration (c
o
).

H
r 
= 0.002 * 600 * 6.25 / 1 = 7.5 m

It is also assumed that the peak concentration in the landfill is reached relatively early in the life of the
landfill, and that the analysis starts at this time. Consequently there is no increase in concentration with
time and the Rate of Increase in Concentration (cr) with time is zero. 

The average infiltration through the cover (q
o
) is assumed to be 0.3 m/a. If the average exfiltration through

the base of the landfill (v
a
) is 0.01 m/a, then the Volume of Leachate Collected is:

Q
c
 = q

o
 - v

a
 = 0.3 - 0.01 = 0.29 m/a

The strata beneath the landfill consists of a 1 m clay layer, a 0.3 m granular layer (i.e., secondary
leachate collection system), a 2 m aquitard layer, underlain by a 1 m thick aquifer. The landfill is
assumed to be 200 m long in the direction parallel to the groundwater flow in the aquifer. At the up
gradient edge of the landfill the inflow in the aquifer is given by a Darcy velocity of 4 m/a. 

The outflow Darcy velocity at the down gradient edge of the landfill (vb) is then by multiplying the landfill
length (200 m) by the Darcy velocity below the secondary leachate collection system (0.0 m/a) and
adding the inflow, viz:

v
b
 = 4 + 200 / 1 * v

a
 = 4 m/a
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When using the Passive Sink Properties special feature the deposit is divided into layers which can have
vertical and horizontal flows In the example 3 layers are necessary, the first is from the base of the
landfill to the top of the secondary leachate collection system, the second is the secondary leachate
collection system, and the third is from the base of the secondary leachate collection system to the
aquifer. In the first layer there is a vertical downwards Darcy velocity of 0.01 m/a and no horizontal flow.
The second layer has a horizontal flow which is equal to the difference in Darcy velocity between the
layers above and below, multiplied by the landfill length and divided by the layer thickness, viz:

v
s
 = (v

a1
 - v

a2
) * L /h = (0.01 - 0.0) * 200 / 0.3 = 6.67 m/a

In the third layer there is no vertical or horizontal advective flow, there will however still be diffusive flow.

Following are the parameters used in this example:

Property Symbol Value Units

Darcy Velocity va variable m/a

Sink Outflow Velocity vs variable m/a

Diffusion Coefficient D variable m2/a

Distribution Coefficient Kd 0 cm3/g

Soil Porosity n 0.4 -

Granular Layer Porosity n 0.3 -

Dry Density 1.5 g/cm3

Layer 1 Thickness H 1 m

Layer 2 Thickness H 0.3 m

Layer 3 Thickness H 2 m

Source Concentration c
0 1000 mg/L

Ref. Height of Leachate Hr 7.5 m

Vol. of Leachate Collected Qc 0.29 m/a

Landfill Length L 200 m

Landfill Width W 1 m

Aquifer Thickness h 1 m

Aquifer Porosity nb 0.3 -

Aquifer Outflow Velocity vb 4 m/a

This example is for a hypothetical landfill and is used to illustrate how to prepare an input file
and run an analysis using the Passive Sink option. The example is not a prescription for
modeling contaminant migration during operation of a landfill. Each landfill has its own unique
characteristics and no general prescription can be made. The Passive Sink option should only
by used by someone with the hydro-geotechnical background necessary to appreciate the
subtleties associated with the physical situation and the steps necessary for appropriate
modeling of this physical situation. 

6.14.2 Data Entry

Open the Examples project and open Case 14. 
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General Tab

The general data for this example can be specified on the General tab. In this example the Darcy velocity
will be ignored, the Darcy velocity will be read during the input of the Passive Sink parameters. The
concentrations can either be calculated at specified times or the time of the maximum concentration can
be found. In this example the concentrations will be calculated at 10, 25, 50, 100, and 150 years.

Layers Tab

The layer data for the 3 layers can be specified on the Layers tab.
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Boundaries Tab

The boundary conditions for the model can be specified on the Boundaries tab. In this example the top
boundary has a finite mass and the bottom boundary is represented by a fixed outflow aquifer.

Special Features

The passive sink data for this model can be entered using the Passive Sink feature on the Special
Features tab.

Passive Sink

When the Passive Sink option is selected the depths and whether there is a phase change or inflow can
be specified. In this example there are 3 depth intervals. The first depth interval is for the clay liner, the
second for the secondary leachate collection system, and the third for the aquitard.
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6.14.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

6.14.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Depth vs Concentration

The Depth vs Concentration chart can be displayed by selecting the Depth vs Concentration item for the
Chart Type.
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Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab. 

POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 14:  Primary and Secondary Leachate Collection 

THE PASSIVE SINK OPTION HAS BEEN USED. NOTE THE USER IS RESPONSIBLE FOR ENSURING THAT VELOCITY

CHANGES ARE CONSISTENT WITH THE PASSIVE SINK.
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 Layer Properties 

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Clay 1 m 4 0.02 m²/a 0.4 0 m³/kg 1.5 g/cm³

Collection System 0.3 m 4 10 m²/a 0.3 0 m³/kg 1.5 g/cm³

Aquitard 2 m 4 0.02 m²/a 0.4 0 m³/kg 1.5 g/cm³

 Boundary Conditions

    Finite Mass Top Boundary

          Initial Concentration = 1000 mg/L

          Rate of Increase = 0 mg/L/yr

          Volume of Leachate Collected = 0.29 m/a

          Thickness of Waste = 0 m

          Waste Density  = 0 g/cm³

          Proportion of Mass = 0

          Volumetric Water Content = 0

          Conversion Rate Half Life = 0 year

          Reference Height of Leachate = 7.5 m

    Fixed Outflow Bottom Boundary

          Landfill Length = 200 m

          Landfill Width = 1 m

          Base Thickness = 1 m

          Base Porosity  = 0.3

          Base Outflow Velocity  = 4 m/a

 Velocity and Sink Profile

Time Period Minimum Depth Maximum Depth Vertical Velocity Horizontal Outflow

01 0  m 1  m 0.01  m/a 0  m/a

1  m 1.3  m 0.01  m/a 6.67  m/a

1.3  m 3.3  m 0  m/a 0  m/a

 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Calculated Concentrations at Selected Times and Depths 

Time

year

Depth

m

Concentration

mg/L

10 0.000E+00 6.589E+02

2.500E-01 5.818E+02



POLLUTEv8360

© 2021 GAEA Technologies Ltd.

5.000E-01 4.425E+02

7.500E-01 2.803E+02

1.000E+00 1.231E+02

1.075E+00 1.230E+02

1.150E+00 1.229E+02

1.225E+00 1.228E+02

1.300E+00 1.228E+02

1.800E+00 1.873E+01

2.300E+00 1.587E+00

2.800E+00 7.432E-02

3.300E+00 5.162E-04

25 0.000E+00 3.627E+02

2.500E-01 3.891E+02

5.000E-01 3.801E+02

7.500E-01 3.364E+02

1.000E+00 2.632E+02

1.075E+00 2.631E+02

1.150E+00 2.631E+02

1.225E+00 2.630E+02

1.300E+00 2.630E+02

1.800E+00 1.245E+02

2.300E+00 4.525E+01

2.800E+00 1.254E+01

3.300E+00 1.337E+00

50 0.000E+00 1.363E+02

2.500E-01 1.698E+02

5.000E-01 1.948E+02

7.500E-01 2.086E+02

1.000E+00 2.097E+02

1.075E+00 2.097E+02

1.150E+00 2.098E+02

1.225E+00 2.098E+02

1.300E+00 2.098E+02

1.800E+00 1.627E+02

2.300E+00 1.040E+02

2.800E+00 5.353E+01

3.300E+00 1.598E+01

100 0.000E+00 2.019E+01

2.500E-01 3.310E+01

5.000E-01 4.699E+01

7.500E-01 6.133E+01

1.000E+00 7.553E+01

1.075E+00 7.554E+01

1.150E+00 7.556E+01

1.225E+00 7.558E+01

1.300E+00 7.560E+01

1.800E+00 8.454E+01

2.300E+00 7.584E+01

2.800E+00 5.456E+01

3.300E+00 2.635E+01
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150 0.000E+00 3.300E+00

2.500E-01 7.810E+00

5.000E-01 1.322E+01

7.500E-01 1.948E+01

1.000E+00 2.649E+01

1.075E+00 2.649E+01

1.150E+00 2.650E+01

1.225E+00 2.651E+01

1.300E+00 2.652E+01

1.800E+00 3.452E+01

2.300E+00 3.469E+01

2.800E+00 2.753E+01

3.300E+00 1.491E+01

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
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6.15 Example 15: Leachate Collection with Failure

In this example the model of Case 14 is extended to incorporate failure of the primary leachate collection
system after 20 years. This failure is modelled using the Variable Properties special feature. The use of
the Variable Properties and Passive Sink features together is illustrated in this example.

6.15.1 Description

This example is similar to case 14 except the failure of the primary leachate collection system is also
modelled using the Variable Properties special feature. Prior to the failure of the primary leachate
collection system there is a downward Darcy velocity of 0.01 m/a between the landfill and the secondary
leachate collection system. The primary leachate collection system is assumed to fail between 20 and
30 years, causing the leachate mound in the landfill to rise resulting in an increase in the Darcy velocity.
After 30 years the collection system has completely failed and the Darcy velocity is now assumed to be
0.1 m/a. 

As in case 14 the landfill contains a finite mass of a conservative species, and is underlain by an aquifer
with fixed outflow. A passive sink is used to model the secondary leachate collection system, which is
assumed to be composed of a 0.3 m thick granular layer. The Darcy velocity is assumed to be initially
0.01 m/a downward from the landfill to the secondary leachate collection system, and 0.0 m/a between
the secondary leachate collection system and the aquifer (i.e., the water table is assumed to be at the
base of the secondary leachate collection system).

The analysis starts at time zero which corresponds to the completion of the landfill and the development
of a peak leachate concentration (co) of 1000 mg/L. As in example 14 the Reference Height of Leachate
is 7.5 m, and the Rate of Increase in Concentration is zero.

The average infiltration through the cover (q
o
) is assumed to be 0.3 m/a. If the average exfiltration through

the base of the landfill v
a
 (which varies with time), then the Volume of Leachate Collected is:

Q
c
 = q

o
 - v

a
 = 0.3 - v

a

The strata beneath the landfill, landfill dimensions, and aquifer characteristics are the same as in
example 14. 

Passive sink layers are divided the same as in example 14, except that the Darcy velocity in the first
layer and the outflow in the second layer will be variable. The Darcy velocity in the first layer will be 0.01
m/a between 0 and 20 years, then will increase linearly between 20 and 30 years to 0.1 m/a, and then
will be 0.1 m/a. In the second layer the horizontal outflow is equal to the difference in Darcy velocity
between the layers above and below, multiplied by the landfill length and divided by the layer thickness,
viz:

v
s
 = (v

a2
 - v

a1
) * 200/0.3 m/a

In the third layer there is no vertical or horizontal advective flow, there will however still be diffusive flow.
When using the Variable Properties special feature with the Passive special feature it is possible to
specify the Darcy velocities in both features. The Darcy velocity used by POLLUTE will be the result from
the multiplication of the two velocities. For most practical applications, it is recommended that the Darcy
velocity be entered as 1.0 in one of the features, and then the actual value entered in the other feature. In
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this example the Darcy velocity is entered as 1.0 in the Variable Properties special feature, and the
actual values are entered in the Passive Sink special feature. 

Using the Variable Properties special feature the dispersivity can also be specified, in this example it is
assumed to be 0.4 since there is outward flow from the landfill.

Following are the parameters used in this example:

Property Symbol Value Units

Darcy Velocity va variable m/a

Sink Outflow Velocity vs variable m/a

Diffusion Coefficient D 0.02 m2/a

Dispersivity 0.4 m

Distribution Coefficient K
d 0.0 cm3/g

Soil Porosity n 0.4 -

Granular Layer Porosity n 0.3 -

Dry Density 1.5 g/cm3

Layer 1 Thickness H 1 m

Layer 2 Thickness H 0.3 m

Layer 3 Thickness H 2 m

Source Concentration c0 1000 mg/L

Ref. Height of Leachate Hr 7.5 m

Vol. of Leachate Collected Qc variable m/a

Landfill Length L 200 m

Landfill Width W 1 m

Aquifer Thickness h 1 m

Aquifer Porosity n 0.3 -

Aquifer Outflow Velocity vb 4 m/a

When using the Variable Properties special feature the accuracy of the results is dependent on the
number of sublayers used.

This example is for a hypothetical landfill and is used to illustrate how to prepare an input file
and run an analysis using the Variable Properties and Passive Sink option. The example is not
a prescription for modeling contaminant migration during operation of a landfill. Each landfill
has its own unique characteristics and no general prescription can be made. These options
should only by used by someone with the hydrogeologic and engineering background
necessary to appreciate the subtleties associated with the physical situation and the steps
necessary for appropriate modeling of this physical situation. 

6.15.2 Data Entry

Open the Examples project and open Case 15. 
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General Tab

The general data for this example is the same as for Case 14, except that the title is different.

Layers Tab

The layer data for this example is the same as for Case 14

 
Boundaries Tab
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The boundary conditions for this example is the same as for Case 14.

Special Features

The time-varying data and passive sink data for this model can be entered using the Time-varying
Properties option in the Special Features tab. When both of these are options are selected the passive
sink data is entered as part of the time varying properties.

Time Varying Properties

To specify the time-varying properties, check the Time-Varying Properties box on the Special Features
tab. The Time-Varying Data sub-tab is used to specify the time period data and whether there are
variable layer properties and variable decay. In this example there are 5 time periods.
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In the first time period, specifying only one time increment means that the concentrations will only be
calculated at the end time (i.e., 20 years). The Darcy velocity is set to one here and will be entered in the
Passive Sink property on the left. Since this is the first time period the primary leachate collection
system is still functioning and there is no increase in any of the above parameters.
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The data for the second time period, from 20 to 30 years, can be specified by pressing the Next arrow.
The increment in the Leachate collected results from the increasing Darcy velocity during this period.
This increase in Darcy velocity will be taken into account in the Passive Sink property on the left side.

Next the data for time period three from 30 to 50 years can be entered.. Two increments are used to
calculate the concentrations at 40 and 50 years. At this point the primary leachate collection system
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has completely failed and there is no further increase in the Darcy velocity. The Volume of Leachate
collected is now equal to the infiltration through the cover 0.3 m/a minus the final Darcy velocity 0.1 m/a.

The data for time period four should can be entered by clicking on the next arrow. Five increments are
used to calculate the concentrations at 60, 70, 80, 90, and 100 years.
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Finally the data for time period five is entered.. Five increments are used to calculate the concentrations
at 120, 140, 160, 180, and 200 years.

6.15.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

6.15.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Depth vs Concentration

The Depth vs Concentration chart can be displayed by selecting the Depth vs Concentration item for the
Chart Type.
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Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab. 

POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 15: Leachate Collection with Failure. 

THE VARIABLE VELOCITY AND/OR CONCENTRATION OPTION HAS BEEN USED. NOTE THAT THE ACCURACY OF THE

CALCULATIONS WITH THIS OPTION WILL DEPEND ON THE NUMBER OF SUBLAYERS USED.
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THE PASSIVE SINK OPTION HAS BEEN USED. NOTE THE USER IS RESPONSIBLE FOR ENSURING THAT VELOCITY

CHANGES ARE CONSISTENT WITH THE PASSIVE SINK.

 Layer Properties 

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Clay 1 m 4 0.02 m²/a 0.4 0 mL/g 1.5 g/cm³

Collection System 0.3 m 4 10 m²/a 0.3 0 mL/g 1.5 g/cm³

Aquitard 2 m 4 0.02 m²/a 0.4 0 mL/g 1.5 g/cm³

 Boundary Conditions

    Finite Mass Top Boundary

    Fixed Outflow Bottom Boundary

          Landfill Length = 200 m

          Landfill Width = 1 m

          Base Thickness = 1 m

          Base Porosity  = 0.3

 Variation in Properties with Time

  Time Periods with the same Source and Velocity

Period Start Time No. of

 Steps

Time Step Source Conc Rate of

Change

Height of

Leachate

Volume

Collected

1 0  yr 1 20  yr 1000  mg/L 0 7.5  m 0.29  m/a

2 20  yr 5 2  yr -1  mg/L 0 7.5  m 0.2  m/a

3 30  yr 2 10  yr -1  mg/L 0 7.5  m 0.2  m/a

4 50  yr 5 10  yr -1  mg/L 0 7.5  m 0.2  m/a

5 100  yr 5 20  yr -1  mg/L 0 7.5  m 0.2  m/a

 
Period Start Time End Time Proportion Mass Dispersivity Base Velocity

1 0  yr 20  yr 1  m/a 0.4  m 4  m/a

2 20  yr 30  yr 1  m/a 0.4  m 4  m/a

3 30  yr 50  yr 1  m/a 0.4  m 4  m/a

4 50  yr 100  yr 1  m/a 0.4  m 4  m/a

5 100  yr 200  yr 1  m/a 0.4  m 4  m/a

 Velocity and Sink Profile

Time Period Minimum Depth Maximum Depth Vertical Velocity Horizontal Outflow

1 / 1 0  m 1  m 0.01  m/a 0  m/a

1  m 1.3  m 0.01  m/a 6.67  m/a

1.3  m 3.3  m 0  m/a 0  m/a
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2 / 1 0  m 1  m 0.028  m/a 0  m/a

1  m 1.3  m 0.028  m/a 18.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 2 0  m 1  m 0.046  m/a 0  m/a

1  m 1.3  m 0.046  m/a 30.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 3 0  m 1  m 0.064  m/a 0  m/a

1  m 1.3  m 0.064  m/a 42.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 4 0  m 1  m 0.082  m/a 0  m/a

1  m 1.3  m 0.082  m/a 54.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 5 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

3 / 1 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

3 / 2 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 1 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 2 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 3 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 4 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 5 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 1 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 2 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 3 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 4 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 5 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a
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1.3  m 3.3  m 0  m/a 0  m/a

 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Calculated Concentrations at Selected Times and Depths 

Time

yr

Depth

m

Concentration

mg/L

20 0.000E+00 4.395E+02

2.500E-01 4.454E+02

5.000E-01 4.211E+02

7.500E-01 3.712E+02

1.000E+00 3.033E+02

1.075E+00 3.033E+02

1.150E+00 3.032E+02

1.225E+00 3.032E+02

1.300E+00 3.032E+02

1.800E+00 1.307E+02

2.300E+00 4.108E+01

2.800E+00 9.391E+00

3.300E+00 7.095E-01

22 0.000E+00 4.137E+02

2.500E-01 4.158E+02

5.000E-01 4.017E+02

7.500E-01 3.701E+02

1.000E+00 3.224E+02

1.075E+00 3.223E+02

1.150E+00 3.223E+02

1.225E+00 3.224E+02

1.300E+00 3.225E+02

1.800E+00 1.411E+02

2.300E+00 4.899E+01

2.800E+00 1.236E+01

3.300E+00 1.062E+00

24 0.000E+00 3.895E+02

2.500E-01 3.927E+02

5.000E-01 3.861E+02

7.500E-01 3.679E+02

1.000E+00 3.372E+02

1.075E+00 3.371E+02

1.150E+00 3.372E+02

1.225E+00 3.373E+02

1.300E+00 3.376E+02

1.800E+00 1.530E+02

2.300E+00 5.647E+01

2.800E+00 1.551E+01

3.300E+00 1.518E+00
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26 0.000E+00 3.667E+02

2.500E-01 3.717E+02

5.000E-01 3.705E+02

7.500E-01 3.614E+02

1.000E+00 3.426E+02

1.075E+00 3.426E+02

1.150E+00 3.427E+02

1.225E+00 3.430E+02

1.300E+00 3.434E+02

1.800E+00 1.645E+02

2.300E+00 6.390E+01

2.800E+00 1.875E+01

3.300E+00 2.077E+00

28 0.000E+00 3.454E+02

2.500E-01 3.512E+02

5.000E-01 3.531E+02

7.500E-01 3.497E+02

1.000E+00 3.388E+02

1.075E+00 3.388E+02

1.150E+00 3.390E+02

1.225E+00 3.394E+02

1.300E+00 3.399E+02

1.800E+00 1.741E+02

2.300E+00 7.118E+01

2.800E+00 2.208E+01

3.300E+00 2.737E+00

30 0.000E+00 3.253E+02

2.500E-01 3.312E+02

5.000E-01 3.345E+02

7.500E-01 3.341E+02

1.000E+00 3.282E+02

1.075E+00 3.282E+02

1.150E+00 3.285E+02

1.225E+00 3.289E+02

1.300E+00 3.296E+02

1.800E+00 1.808E+02

2.300E+00 7.803E+01

2.800E+00 2.547E+01

3.300E+00 3.490E+00

40 0.000E+00 2.199E+02

2.500E-01 2.276E+02

5.000E-01 2.345E+02

7.500E-01 2.401E+02

1.000E+00 2.437E+02

1.075E+00 2.437E+02

1.150E+00 2.440E+02

1.225E+00 2.443E+02

1.300E+00 2.449E+02

1.800E+00 1.881E+02

2.300E+00 1.076E+02
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2.800E+00 4.712E+01

3.300E+00 1.035E+01

50 0.000E+00 1.488E+02

2.500E-01 1.546E+02

5.000E-01 1.602E+02

7.500E-01 1.656E+02

1.000E+00 1.704E+02

1.075E+00 1.705E+02

1.150E+00 1.706E+02

1.225E+00 1.709E+02

1.300E+00 1.713E+02

1.800E+00 1.603E+02

2.300E+00 1.120E+02

2.800E+00 5.985E+01

3.300E+00 1.789E+01

60 0.000E+00 1.008E+02

2.500E-01 1.050E+02

5.000E-01 1.093E+02

7.500E-01 1.138E+02

1.000E+00 1.183E+02

1.075E+00 1.184E+02

1.150E+00 1.185E+02

1.225E+00 1.187E+02

1.300E+00 1.190E+02

1.800E+00 1.282E+02

2.300E+00 1.023E+02

2.800E+00 6.254E+01

3.300E+00 2.307E+01

70 0.000E+00 6.828E+01

2.500E-01 7.132E+01

5.000E-01 7.456E+01

7.500E-01 7.808E+01

1.000E+00 8.201E+01

1.075E+00 8.206E+01

1.150E+00 8.215E+01

1.225E+00 8.230E+01

1.300E+00 8.249E+01

1.800E+00 9.970E+01

2.300E+00 8.728E+01

2.800E+00 5.698E+01

3.300E+00 1.817E+01

80 0.000E+00 4.629E+01

2.500E-01 4.847E+01

5.000E-01 5.087E+01

7.500E-01 5.358E+01

1.000E+00 5.679E+01

1.075E+00 5.682E+01

1.150E+00 5.689E+01

1.225E+00 5.699E+01

1.300E+00 5.713E+01
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1.800E+00 7.584E+01

2.300E+00 7.026E+01

2.800E+00 4.642E+01

3.300E+00 1.154E+01

90 0.000E+00 3.140E+01

2.500E-01 3.295E+01

5.000E-01 3.470E+01

7.500E-01 3.674E+01

1.000E+00 3.925E+01

1.075E+00 3.927E+01

1.150E+00 3.932E+01

1.225E+00 3.939E+01

1.300E+00 3.949E+01

1.800E+00 5.637E+01

2.300E+00 5.393E+01

2.800E+00 3.537E+01

3.300E+00 6.863E+00

100 0.000E+00 2.130E+01

2.500E-01 2.240E+01

5.000E-01 2.366E+01

7.500E-01 2.516E+01

1.000E+00 2.705E+01

1.075E+00 2.707E+01

1.150E+00 2.710E+01

1.225E+00 2.715E+01

1.300E+00 2.722E+01

1.800E+00 4.101E+01

2.300E+00 4.000E+01

2.800E+00 2.597E+01

3.300E+00 4.082E+00

120 0.000E+00 9.819E+00

2.500E-01 1.037E+01

5.000E-01 1.101E+01

7.500E-01 1.182E+01

1.000E+00 1.287E+01

1.075E+00 1.288E+01

1.150E+00 1.290E+01

1.225E+00 1.293E+01

1.300E+00 1.296E+01

1.800E+00 2.176E+01

2.300E+00 2.284E+01

2.800E+00 1.723E+01

3.300E+00 8.038E+00

140 0.000E+00 4.534E+00

2.500E-01 4.811E+00

5.000E-01 5.153E+00

7.500E-01 5.595E+00

1.000E+00 6.199E+00

1.075E+00 6.204E+00

1.150E+00 6.213E+00
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1.225E+00 6.226E+00

1.300E+00 6.243E+00

1.800E+00 1.201E+01

2.300E+00 1.374E+01

2.800E+00 1.149E+01

3.300E+00 6.350E+00

160 0.000E+00 2.099E+00

2.500E-01 2.243E+00

5.000E-01 2.428E+00

7.500E-01 2.677E+00

1.000E+00 3.030E+00

1.075E+00 3.033E+00

1.150E+00 3.038E+00

1.225E+00 3.044E+00

1.300E+00 3.052E+00

1.800E+00 6.754E+00

2.300E+00 8.230E+00

2.800E+00 7.255E+00

3.300E+00 4.279E+00

180 0.000E+00 9.745E-01

2.500E-01 1.050E+00

5.000E-01 1.151E+00

7.500E-01 1.292E+00

1.000E+00 1.498E+00

1.075E+00 1.500E+00

1.150E+00 1.502E+00

1.225E+00 1.505E+00

1.300E+00 1.510E+00

1.800E+00 3.809E+00

2.300E+00 4.858E+00

2.800E+00 4.426E+00

3.300E+00 2.701E+00

200 0.000E+00 4.542E-01

2.500E-01 4.945E-01

5.000E-01 5.499E-01

7.500E-01 6.294E-01

1.000E+00 7.481E-01

1.075E+00 7.490E-01

1.150E+00 7.503E-01

1.225E+00 7.522E-01

1.300E+00 7.544E-01

1.800E+00 2.144E+00

2.300E+00 2.830E+00

2.800E+00 2.637E+00

3.300E+00 1.644E+00

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including
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warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
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6.16 Example 16: Monte Carlo Simulation

This example illustrates the use of the Monte Carlo simulation feature, in conjunction with the Variable
Properties and Passive Sink features. The landfill model used in Case 15 is modified to simulate
uncertainty in the time of failure of the primary leachate collection system. In this example the failure
time is given a triangular distribution, with a minimum of 15 years, a mode of 25 years, and a maximum
of 50 years.

6.16.1 Description

In this example, Monte Carlo simulation will be used to examine the effect of uncertainty in the service
life of a Primary Leachate Collection system. The landfill from example 15 will be used, except the time
that the Primary Leachate Collection system begins to fail will vary between 20 and 50 years with a
mode of 25 years. Case 15 should be reviewed prior to reading this example, where the implementation
of the Variable Properties and Passive Sink special features are described in detail.

The parameters for this example are the same as in Case 15, except for the addition of the Monte Carlo
parameters. 

Following are the parameters used in this example:

Property Symbol Value Units

Darcy Velocity va variable m/a

Sink Outflow Velocity vs variable m/a

Diffusion Coefficient D 0.02 m2/a

Dispersivity 0.4 m

Distribution Coefficient K
d 0.0 cm3/g

Soil Porosity n 0.4 -

Granular Layer Porosity n 0.3 -

Dry Density 1.5 g/cm3

Layer 1 Thickness H 1 m

Layer 2 Thickness H 0.3 m

Layer 3 Thickness H 2 m

Source Concentration c0 1000 mg/L

Ref. Height of Leachate Hr 7.5 m

Vol. of Leachate Collected Qc variable m/a

Landfill Length L 200 m

Landfill Width W 1 m

Aquifer Thickness h 1 m

Aquifer Porosity n 0.3 -

Aquifer Outflow Velocity vb 4 m/a

Minimum Failure Start Time 20 a

Modal Failure Start Time 25 a

Maximum Failure Start Time 50 a

This example is for a hypothetical landfill and is used to illustrate how to prepare an input file
and run an analysis using the Variable Properties and Passive Sink option. The example is not
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a prescription for modeling contaminant migration during operation of a landfill. Each landfill
has its own unique characteristics and no general prescription can be made. These options
should only by used by someone with the hydrogeologic and engineering background
necessary to appreciate the subtleties associated with the physical situation and the steps
necessary for appropriate modeling of this physical situation. This option should not be used for
an actual project of importance without the guidance of the program developers.

The use of the Monte Carlo simulation feature for the variation of Variable Properties time
periods should be done in consultation with the program developers, since it requires a very
thorough knowledge of the program.

6.16.2 Data Entry

Open the Examples project and open Case 16. 

General Tab

The general data for this example is the same as for Case 15.The run parameters for this example are
the same as for Case 15, except that the concentrations will be only be calculated at a depth off 3.3 m.
This depth corresponds to the base of the aquitard.

Layers Tab
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The layer data for this example is the same as for Case 15.

 
Boundaries Tab

The boundary conditions for this example is the same as for Case 15.

Special Features
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The time-varying data, passive sink, and Monte Carlo simulation data for this model can be entered using
the Time-varying Properties and Monte Carlo options in the Special Features tab. When these are
options are selected the passive sink data is entered as part of the time varying properties.

Time Varying Properties

To specify the time-varying properties, check the Time-Varying Properties box on the Special Features
tab. The Time-Varying Data sub-tab is used to specify the time period data and whether there are
variable layer properties and variable decay. In this example there are 5 time periods.

In the first time period, specifying only one time increment means that the concentrations will only be
calculated at the end time (i.e., 20 years). The Darcy velocity is set to one here and will be entered in the
Passive Sink property on the left. Since this is the first time period the primary leachate collection
system is still functioning and there is no increase in any of the above parameters.
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The data for the second time period, from 20 to 30 years, can be specified by pressing the Next arrow.
The increment in the Leachate collected results from the increasing Darcy velocity during this period.
This increase in Darcy velocity will be taken into account in the Passive Sink property on the left side.

Next the data for time period three from 30 to 50 years can be entered.. Two increments are used to
calculate the concentrations at 40 and 50 years. At this point the primary leachate collection system
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has completely failed and there is no further increase in the Darcy velocity. The Volume of Leachate
collected is now equal to the infiltration through the cover 0.3 m/a minus the final Darcy velocity 0.1 m/a.

The data for time period four should can be entered by clicking on the next arrow. Five increments are
used to calculate the concentrations at 60, 70, 80, 90, and 100 years.
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Finally the data for time period five is entered.. Five increments are used to calculate the concentrations
at 120, 140, 160, 180, and 200 years.

Monte Carlo Simulation

The Monte Carlo simulation data can be specified by selecting the Monte Carlo Simulation sub-tab on
the Special Features tab. The number of simulations, variables, and data ranges can be specified. The
number of simulations is usually between 1000 and
10000. However, the time to compute this many simulations may be quite large. It is suggested as a trial
to use less than 50 simulations. In this example we are only going to have one variable.
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6.16.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

6.16.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Probability vs Concentration

The Probability vs Concentration chart can be displayed by selecting the Probability vs Concentration
item for the Chart Type. Using the chart of the probability of peak chloride concentration predictions can
be made about the concentration in the aquifer. For example, in this case, the expected maximum
concentration is 23.493 mg/L.
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Probability vs Time

The Probability vs Time chart can be displayed by selecting the Probability vs Time item for the Chart
Type. Using this chart the expected time of the maximum concentration can be predicted. In this
example, the expected time is 68.439 years.
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Probability vs Variable Value

The Probability vs Variable Value chart can be displayed by selecting the Probability vs Variable Value
item for the Chart Type. Using this chart the distribution of the variable can be checked against the
distribution that was specified. In this example, the specified distribution was a triangular distribution with
a minimum of 15, mode of 25 and maximum of 50.
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Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab. 

POLLUTEv8
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Case 16: Monte Carlo Simulation
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THE VARIABLE VELOCITY AND/OR CONCENTRATION OPTION HAS BEEN USED. NOTE THAT THE ACCURACY OF THE

CALCULATIONS WITH THIS OPTION WILL DEPEND ON THE NUMBER OF SUBLAYERS USED.

THE PASSIVE SINK OPTION HAS BEEN USED. NOTE THE USER IS RESPONSIBLE FOR ENSURING THAT VELOCITY

CHANGES ARE CONSISTENT WITH THE PASSIVE SINK.

 Layer Properties 

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 16: Monte Carlo Simulation

THE VARIABLE VELOCITY AND/OR CONCENTRATION OPTION HAS BEEN USED. NOTE THAT THE ACCURACY OF THE

CALCULATIONS WITH THIS OPTION WILL DEPEND ON THE NUMBER OF SUBLAYERS USED.

THE PASSIVE SINK OPTION HAS BEEN USED. NOTE THE USER IS RESPONSIBLE FOR ENSURING THAT VELOCITY

CHANGES ARE CONSISTENT WITH THE PASSIVE SINK.

 Layer Properties 

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Clay 1 m 4 0.02 m²/a 0.4 0 cm³/g 1.5 g/cm³

Collection System 0.3 m 4 10 m²/a 0.3 0 cm³/g 1.5 g/cm³

Aquitard 2 m 4 0.02 m²/a 0.4 0 cm³/g 1.5 g/cm³

 Boundary Conditions

    Finite Mass Top Boundary

    Fixed Outflow Bottom Boundary

          Landfill Length = 200 m

          Landfill Width = 1 m

          Base Thickness = 1 m

          Base Porosity  = 0.3

 Variation in Properties with Time

  Time Periods with the same Source and Velocity

Period Start Time No. of

 Steps

Time Step Source Conc Rate of

Change

Height of

Leachate

Volume

Collected

1 0  yr 1 20  yr 1000  mg/L 0 7.5  m 0.29  m/a

2 20  yr 5 2  yr -1  mg/L 0 7.5  m 0.2  m/a
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3 30  yr 2 10  yr -1  mg/L 0 7.5  m 0.2  m/a

4 50  yr 5 10  yr -1  mg/L 0 7.5  m 0.2  m/a

5 100  yr 5 20  yr -1  mg/L 0 7.5  m 0.2  m/a

 
Period Start Time End Time Proportion Mass Dispersivity Base Velocity

1 0  yr 20  yr 1  m/a 0.4  m 4  m/a

2 20  yr 30  yr 1  m/a 0.4  m 4  m/a

3 30  yr 50  yr 1  m/a 0.4  m 4  m/a

4 50  yr 100  yr 1  m/a 0.4  m 4  m/a

5 100  yr 200  yr 1  m/a 0.4  m 4  m/a

 Velocity and Sink Profile

Time Period Minimum Depth Maximum Depth Vertical Velocity Horizontal Outflow

1 / 1 0  m 1  m 0.01  m/a 0  m/a

1  m 1.3  m 0.01  m/a 6.67  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 1 0  m 1  m 0.028  m/a 0  m/a

1  m 1.3  m 0.028  m/a 18.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 2 0  m 1  m 0.046  m/a 0  m/a

1  m 1.3  m 0.046  m/a 30.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 3 0  m 1  m 0.064  m/a 0  m/a

1  m 1.3  m 0.064  m/a 42.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 4 0  m 1  m 0.082  m/a 0  m/a

1  m 1.3  m 0.082  m/a 54.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 5 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

3 / 1 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

3 / 2 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 1 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 2 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 3 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 4 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a
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1.3  m 3.3  m 0  m/a 0  m/a

4 / 5 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 1 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 2 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 3 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 4 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 5 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Monte Carlo Simulation Results 

     Number of Simulations = 2000

     Number of Variables = 1

     Number of Data Ranges = 20

     Variable # 1

       Variable Properties End Time

          Time Period = 1

          Triangular Distribution     ( Minimum = 15    Maximum = 50    Mode = 25 )

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Clay 1 m 4 0.02 m²/a 0.4 0 cm³/g 1.5 g/cm³

Collection System 0.3 m 4 10 m²/a 0.3 0 cm³/g 1.5 g/cm³

Aquitard 2 m 4 0.02 m²/a 0.4 0 cm³/g 1.5 g/cm³
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 Boundary Conditions

    Finite Mass Top Boundary

    Fixed Outflow Bottom Boundary

          Landfill Length = 200 m

          Landfill Width = 1 m

          Base Thickness = 1 m

          Base Porosity  = 0.3

 Variation in Properties with Time

  Time Periods with the same Source and Velocity

Period Start Time No. of

 Steps

Time Step Source Conc Rate of

Change

Height of

Leachate

Volume

Collected

1 0  yr 1 20  yr 1000  mg/L 0 7.5  m 0.29  m/a

2 20  yr 5 2  yr -1  mg/L 0 7.5  m 0.2  m/a

3 30  yr 2 10  yr -1  mg/L 0 7.5  m 0.2  m/a

4 50  yr 5 10  yr -1  mg/L 0 7.5  m 0.2  m/a

5 100  yr 5 20  yr -1  mg/L 0 7.5  m 0.2  m/a

 
Period Start Time End Time Proportion Mass Dispersivity Base Velocity

1 0  yr 20  yr 1  m/a 0.4  m 4  m/a

2 20  yr 30  yr 1  m/a 0.4  m 4  m/a

3 30  yr 50  yr 1  m/a 0.4  m 4  m/a

4 50  yr 100  yr 1  m/a 0.4  m 4  m/a

5 100  yr 200  yr 1  m/a 0.4  m 4  m/a

 Velocity and Sink Profile

Time Period Minimum Depth Maximum Depth Vertical Velocity Horizontal Outflow

1 / 1 0  m 1  m 0.01  m/a 0  m/a

1  m 1.3  m 0.01  m/a 6.67  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 1 0  m 1  m 0.028  m/a 0  m/a

1  m 1.3  m 0.028  m/a 18.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 2 0  m 1  m 0.046  m/a 0  m/a

1  m 1.3  m 0.046  m/a 30.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 3 0  m 1  m 0.064  m/a 0  m/a

1  m 1.3  m 0.064  m/a 42.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 4 0  m 1  m 0.082  m/a 0  m/a

1  m 1.3  m 0.082  m/a 54.7  m/a
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1.3  m 3.3  m 0  m/a 0  m/a

2 / 5 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

3 / 1 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

3 / 2 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 1 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 2 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 3 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 4 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 5 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 1 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 2 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 3 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 4 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 5 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Monte Carlo Simulation Results 

     Number of Simulations = 2000

     Number of Variables = 1
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     Number of Data Ranges = 20

     Variable # 1

       Variable Properties End Time

          Time Period = 1

          Triangular Distribution     ( Minimum = 15    Maximum = 50    Mode = 25 )

     Depth = 3.3

   DISTRIBUTION OF PEAK CONCENTRATION 

Minimum

Value

Maximum

Value

Number

Occur.

Probability Cumulative

Probability

Expected

Value

2.286E+01 2.295E+01 37 0.02 0.02 4.237E-01

2.295E+01 2.303E+01 91 0.05 0.06 1.046E+00

2.303E+01 2.312E+01 91 0.05 0.11 1.050E+00

2.312E+01 2.321E+01 126 0.06 0.17 1.459E+00

2.321E+01 2.330E+01 150 0.07 0.25 1.744E+00

2.330E+01 2.339E+01 160 0.08 0.33 1.867E+00

2.339E+01 2.347E+01 178 0.09 0.42 2.085E+00

2.347E+01 2.356E+01 320 0.16 0.58 3.763E+00

2.356E+01 2.365E+01 608 0.30 0.88 7.176E+00

2.365E+01 2.374E+01 20 0.01 0.89 2.369E-01

2.374E+01 2.383E+01 16 0.01 0.90 1.903E-01

2.383E+01 2.391E+01 33 0.02 0.92 3.939E-01

2.391E+01 2.400E+01 31 0.02 0.93 3.714E-01

2.400E+01 2.409E+01 32 0.02 0.95 3.847E-01

2.409E+01 2.418E+01 23 0.01 0.96 2.776E-01

2.418E+01 2.427E+01 22 0.01 0.97 2.665E-01

2.427E+01 2.436E+01 20 0.01 0.98 2.431E-01

2.436E+01 2.444E+01 28 0.01 0.99 3.416E-01

2.444E+01 2.453E+01 11 0.01 1.00 1.347E-01

2.453E+01 2.462E+01 3 0.00 1.00 3.686E-02

Expected Maximum Concentration = 2.349E+01

   DISTRIBUTION OF TIME OF PEAK CONCENTRATION 

Minimum

Value

Maximum

Value

Number

Occur.

Probability Cumulative

Probability

Expected

Value

5.532E+01 5.650E+01 10 0.01 0.01 2.795E-01

5.650E+01 5.767E+01 30 0.01 0.02 8.562E-01

5.767E+01 5.884E+01 54 0.03 0.05 1.573E+00

5.884E+01 6.001E+01 73 0.04 0.08 2.169E+00

6.001E+01 6.118E+01 79 0.04 0.12 2.393E+00

6.118E+01 6.235E+01 99 0.05 0.17 3.057E+00

6.235E+01 6.352E+01 111 0.06 0.23 3.493E+00

6.352E+01 6.469E+01 107 0.05 0.28 3.430E+00

6.469E+01 6.586E+01 122 0.06 0.34 3.982E+00

6.586E+01 6.703E+01 117 0.06 0.40 3.887E+00

6.703E+01 6.820E+01 114 0.06 0.46 3.854E+00
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6.820E+01 6.938E+01 154 0.08 0.53 5.297E+00

6.938E+01 7.055E+01 132 0.07 0.60 4.617E+00

7.055E+01 7.172E+01 150 0.07 0.68 5.335E+00

7.172E+01 7.289E+01 157 0.08 0.75 5.676E+00

7.289E+01 7.406E+01 124 0.06 0.82 4.555E+00

7.406E+01 7.523E+01 117 0.06 0.88 4.367E+00

7.523E+01 7.640E+01 89 0.04 0.92 3.374E+00

7.640E+01 7.757E+01 82 0.04 0.96 3.156E+00

7.757E+01 7.874E+01 79 0.04 1.00 3.087E+00

Expected Time of Maximum Concentration = 68.4391550021306

   VARIABLE NUMBER:     1

Minimum

Value

Maximum

Value

Number

Occur.

Probability Cumulative

Probability

Expected

Value

1.532E+01 1.702E+01 21 0.01 0.01 1.698E-01

1.702E+01 1.873E+01 68 0.03 0.04 6.078E-01

1.873E+01 2.043E+01 101 0.05 0.10 9.886E-01

2.043E+01 2.213E+01 133 0.07 0.16 1.415E+00

2.213E+01 2.383E+01 166 0.08 0.24 1.907E+00

2.383E+01 2.553E+01 164 0.08 0.33 2.024E+00

2.553E+01 2.723E+01 162 0.08 0.41 2.137E+00

2.723E+01 2.893E+01 167 0.08 0.49 2.345E+00

2.893E+01 3.063E+01 159 0.08 0.57 2.368E+00

3.063E+01 3.233E+01 138 0.07 0.64 2.172E+00

3.233E+01 3.403E+01 141 0.07 0.71 2.339E+00

3.403E+01 3.573E+01 124 0.06 0.77 2.163E+00

3.573E+01 3.743E+01 108 0.05 0.83 1.975E+00

3.743E+01 3.913E+01 92 0.05 0.87 1.761E+00

3.913E+01 4.083E+01 65 0.03 0.90 1.299E+00

4.083E+01 4.254E+01 77 0.04 0.94 1.605E+00

4.254E+01 4.424E+01 50 0.03 0.97 1.085E+00

4.424E+01 4.594E+01 31 0.02 0.98 6.988E-01

4.594E+01 4.764E+01 20 0.01 0.99 4.679E-01

4.764E+01 4.934E+01 13 0.01 1.00 3.152E-01

0.000E+00 0.000E+00 0 0.00 0.00 0.000E+00

Expected Value = 2.984E+01

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.



Appendix A Examples 397

© 2021 GAEA Technologies Ltd.



POLLUTEv8398

© 2021 GAEA Technologies Ltd.

6.17 Example 17: Landfill with Composite Primary Liner

This example demonstrates how to create a landfill with a composite primary liner, primary and
secondary leachate collection systems, and a compacted clay secondary liner.

6.17.1 Description

This example demonstrates how to create a landfill with a composite primary liner, primary and
secondary leachate collection systems, and a compacted clay secondary liner. The composite primary
liner is composed of a 60 mil (1.5 mm) geomembrane in good contact with a 0.9 m thick compacted clay
liner. Small holes with an area of 0.1 cm2 and a frequency of 2.5 per hectare (1 per acre) are assumed
for the geomembrane. The method proposed by Giroud et al (1992) is used to calculate the flow
(leakage) through the composite liner, these calculations are performed automatically by POLLUTE.
Below the composite primary liner is a 0.3 m thick granular secondary leachate collection system,
overlying a 0.9 m thick compacted clay secondary liner. There is a 3 m thick aquitard under the
secondary liner, which overlies a 3 m thick aquifer.

The landfill has a length (L) of 200 m in the direction parallel to groundwater flow in the underlying aquifer.
Consideration is being given to a volatile organic contaminant with an initial source concentration of 1500
µg/L, which is assumed to remain constant with time over the time period being examined in this
example. The leachate head on the composite primary liner is assumed to be constant at 0.3 m, the
head on the secondary liner is assumed to be 0.3 m, and the groundwater level relative to the top of the
aquifer is assumed to be 3 m (i.e., at the top of the aquitard).

The flow in the aquifer must be established based on hydrogeologic data and is represented in terms of
the horizontal Darcy velocity (the “Base Outflow Velocity”) in the aquifer at the down-gradient edge of the
landfill (see Example 3 for more discussion of Base Outflow Velocity and Aquifer thickness). 

The parameters used for this example are listed below:

Property Symbol Value Units

Geomembrane Contact Good -

Geomembrane Holes Circles -

Hole Area 0.1 cm2

Hole Frequency 1 /acre

Geomembrane Thickness 60 mil

Geomembrane Diffusion Coef. 3.0x10-5 m2/a

Source Concentration c0 1500 µg/L

Source Type Constant -

Landfill Length L 200 m

Leachate Head on Primary Liner 0.3 m

Leachate Head on Secondary Liner 0.3 m

Groundwater level in Aquifer 3 m

Clay Thickness H 0.9 m

Clay Diffusion Coef. D 0.02 m2/a

Clay Distribution Coef. Kd 0.5 mL/g

Clay Hydraulic Conductivity k 1.0x10-9 m/s

Clay Porosity n 0.35 -
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Clay Dry Density 1.9 g/cm3

Collection System Thickness H 0.3 m

Collection System Dispersion Coef. 100 m2/a

Collection System Density 1.9 g/cm3

Collection System Distr. Coef. Kd 0 mL/g

Collection System Porosity n 0.3 -

Aquitard Thickness H 3 m

Aquitard Hydraulic Conductivity k 1.0x10-5 m/s

Aquitard Diffusion Coef. D 0.02 m2/a

Aquitard Dry Density 1.9 g/cm3

Aquitard Distribution Coef. Kd 0 mL/g

Aquitard Porosity n 0.35 -

Aquifer Thickness h 3 m

Aquifer Porosity nb 0.3 -

Base Outflow Velocity vb 10 m/s

6.17.2 Data Entry

Open the Examples project and open Case 17. The data for this type of model is entered differently than
the previous models, since it was created using the Primary and Secondary Liner Landfill template. 

General Tab
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On the General tab the layers present in the model can be specified. In this example, the model consists
of a primary geomembrane, primary liner, secondary liner, aquitard, and aquifer.

Source & Hydraulic Heads
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This tab is used to specify the source information and hydraulic heads. In this example the source has a
constant concentration of 1500 µg/L and a landfill length of 200 m.The heads specified for the liners and
the groundwater level are relative to the aquifer.

Collection System

The parameters for the secondary leachate collection system are specified on the Collection System
tab.

Geomembranes
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The Geomembranes tab is used to specify the parameters for the primary geomembrane and the method
to calculate the leakage through the geomembrane. In this example, the leakage through the
geomembrane will use the method proposed by Giroud & Bonaparte.

Clay Liners
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The parameters for the primary and secondary clay liners are specified on the Clay Liners tab.

Aquitard

The parameters for the aquitard are specified on the Aquitard tab. 

Aquifer

The parameters for the aquifer are specified on the Aquifer tab. The outflow velocity in the aquifer can be
specified on the bottom of the tab. The minimum outflow velocity for the model will be calculated and
shown.
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6.17.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

6.17.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Depth vs Concentration

Output Listing
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To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab. 

POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Row e and J.R. Booker

Case 17. Landfill with composite primary  liners.                 

THE PASSIVE SINK OPTION HAS BEEN USED. NOTE THE USER IS RESPONSIBLE FOR ENSURING THAT VELOCITY

CHANGES ARE CONSISTENT WITH THE PASSIVE SINK.

 Layer Properties 

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Geomembrane 60 mil 1 3E-5 m²/a 1 0 mL/g 950 kg/m³

Clay Liner 0.9 m 10 0.02 m²/a 0.35 0.5 mL/g 1.9 g/cm³

Collection System 0.3 m 1 100 m²/a 0.3 0 m³/kg 1.9 kg/m³

Clay Liner 0.9 m 10 0.02 m²/a 0.35 0.5 m³/kg 1.9 kg/m³

Aquitard 3 m 10 0.02 m²/a 0.3 0.5 m³/kg 1.9 kg/m³

 Boundary Conditions

    Constant Concentration

          Source Concentration = 1500 µg/L

    Fixed Outflow Bottom Boundary

          Landfill Length = 200 m

          Landfill Width = 0 m

          Base Thickness = 3 m

          Base Porosity = 0.3

          Base Outflow  Velocity = 10 m/a

 Velocity and Sink Profile

Time Period Minimum Depth Maximum Depth Vertical Velocity Horizontal

Outflow

Phase Parameter

01 0  m 0.001524  m 3.9744E-5  m/a 0  m/a 1

0.001524  m 0.9  m 3.9744E-5  m/a 0  m/a 1

0.9  m 1.2  m 3.9744E-5  m/a 0  m/a 1

1.2  m 2.1  m 3.9744E-5  m/a 0  m/a 1

2.1  m 5.1  m 3.9744E-5  m/a 0  m/a 1
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 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Calculated Concentrations at Selected Times and Depths 

Time

yr

Depth

m

Concentration

µg/L

10 0.000E+00 1.500E+03

1.524E-03 6.823E+02

9.152E-02 4.917E+02

1.815E-01 3.370E+02

2.715E-01 2.190E+02

3.615E-01 1.345E+02

4.515E-01 7.798E+01

5.415E-01 4.256E+01

6.315E-01 2.181E+01

7.215E-01 1.044E+01

8.115E-01 4.532E+00

9.015E-01 1.486E+00

1.202E+00 1.485E+00

1.292E+00 5.762E-01

1.382E+00 2.090E-01

1.472E+00 7.081E-02

1.562E+00 2.239E-02

1.652E+00 6.608E-03

1.742E+00 1.819E-03

1.832E+00 4.665E-04

1.922E+00 1.115E-04

2.012E+00 2.487E-05

2.102E+00 5.395E-06

2.402E+00 1.203E-08

2.702E+00 6.039E-11

3.002E+00 6.877E-12

3.302E+00 7.519E-13

3.602E+00 6.479E-14

3.902E+00 4.344E-15

4.202E+00 2.236E-16

4.502E+00 8.703E-18

4.802E+00 2.517E-19

5.102E+00 8.435E-22

20 0.000E+00 1.500E+03

1.524E-03 8.260E+02

9.152E-02 6.636E+02

1.815E-01 5.199E+02

2.715E-01 3.968E+02

3.615E-01 2.946E+02

4.515E-01 2.126E+02
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5.415E-01 1.488E+02

6.315E-01 1.007E+02

7.215E-01 6.553E+01

8.115E-01 4.031E+01

9.015E-01 2.239E+01

1.202E+00 2.238E+01

1.292E+00 1.332E+01

1.382E+00 7.670E+00

1.472E+00 4.275E+00

1.562E+00 2.305E+00

1.652E+00 1.202E+00

1.742E+00 6.060E-01

1.832E+00 2.954E-01

1.922E+00 1.393E-01

2.012E+00 6.381E-02

2.102E+00 2.913E-02

2.402E+00 1.208E-03

2.702E+00 3.221E-05

3.002E+00 5.508E-07

3.302E+00 6.278E-09

3.602E+00 1.246E-10

3.902E+00 2.172E-11

4.202E+00 4.988E-12

4.502E+00 1.028E-12

4.802E+00 1.848E-13

5.102E+00 6.496E-15

30 0.000E+00 1.500E+03

1.524E-03 9.088E+02

9.152E-02 7.644E+02

1.815E-01 6.322E+02

2.715E-01 5.137E+02

3.615E-01 4.098E+02

4.515E-01 3.205E+02

5.415E-01 2.455E+02

6.315E-01 1.837E+02

7.215E-01 1.337E+02

8.115E-01 9.389E+01

9.015E-01 6.252E+01

1.202E+00 6.250E+01

1.292E+00 4.317E+01

1.382E+00 2.919E+01

1.472E+00 1.932E+01

1.562E+00 1.252E+01

1.652E+00 7.934E+00

1.742E+00 4.920E+00

1.832E+00 2.986E+00

1.922E+00 1.776E+00

2.012E+00 1.040E+00

2.102E+00 6.088E-01

2.402E+00 6.824E-02
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2.702E+00 5.728E-03

3.002E+00 3.587E-04

3.302E+00 1.671E-05

3.602E+00 5.782E-07

3.902E+00 1.516E-08

4.202E+00 4.244E-10

4.502E+00 5.379E-11

4.802E+00 1.512E-11

5.102E+00 9.861E-13

50 0.000E+00 1.500E+03

1.524E-03 1.007E+03

9.152E-02 8.850E+02

1.815E-01 7.698E+02

2.715E-01 6.623E+02

3.615E-01 5.634E+02

4.515E-01 4.734E+02

5.415E-01 3.926E+02

6.315E-01 3.210E+02

7.215E-01 2.583E+02

8.115E-01 2.039E+02

9.015E-01 1.573E+02

1.202E+00 1.573E+02

1.292E+00 1.231E+02

1.382E+00 9.522E+01

1.472E+00 7.273E+01

1.562E+00 5.486E+01

1.652E+00 4.087E+01

1.742E+00 3.008E+01

1.832E+00 2.189E+01

1.922E+00 1.576E+01

2.012E+00 1.127E+01

2.102E+00 8.056E+00

2.402E+00 2.028E+00

2.702E+00 4.309E-01

3.002E+00 7.706E-02

3.302E+00 1.158E-02

3.602E+00 1.459E-03

3.902E+00 1.539E-04

4.202E+00 1.358E-05

4.502E+00 1.003E-06

4.802E+00 6.204E-08

5.102E+00 6.335E-10

100 0.000E+00 1.500E+03

1.524E-03 1.124E+03

9.152E-02 1.030E+03

1.815E-01 9.383E+02

2.715E-01 8.503E+02

3.615E-01 7.662E+02

4.515E-01 6.862E+02

5.415E-01 6.106E+02
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6.315E-01 5.398E+02

7.215E-01 4.738E+02

8.115E-01 4.127E+02

9.015E-01 3.567E+02

1.202E+00 3.566E+02

1.292E+00 3.092E+02

1.382E+00 2.666E+02

1.472E+00 2.285E+02

1.562E+00 1.948E+02

1.652E+00 1.652E+02

1.742E+00 1.393E+02

1.832E+00 1.170E+02

1.922E+00 9.780E+01

2.012E+00 8.154E+01

2.102E+00 6.789E+01

2.402E+00 3.197E+01

2.702E+00 1.387E+01

3.002E+00 5.537E+00

3.302E+00 2.031E+00

3.602E+00 6.839E-01

3.902E+00 2.112E-01

4.202E+00 5.978E-02

4.502E+00 1.548E-02

4.802E+00 3.554E-03

5.102E+00 1.703E-04

 NOTICE 

Although this program has been tested and experience w ould indicate that it is accurate w ithin the limits given by the

assumptions of the theory used, w e make no w arranty as to w orkability of this softw are or any other licensed material. No

w arranties either expressed or implied (including w arranties of f itness) shall apply. No responsibility is assumed for any

errors, mistakes or misrepresentations that may occur from the use of this computer program. The user accepts full

responsibility for assessing the validity and applicability of the results obtained w ith this program for any specif ic case.
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6.18 Example 18: Phase Change

In this example a phase change in the secondary leachate collection system is modelled using the
Phase Change special feature. The phase change occurs in the secondary leachate collection system at
the interface between the unsaturated and saturated zones, assumed to be .2 and .1 meters thick
respectively. The landfill contains a constant concentration of DCM, which experiences biological decay
in the landfill, primary and secondary liners, and the aquifer. 

6.18.1 Description

In this example a phase change in the secondary leachate collection system is modelled using the
Phase Change special feature. The landfill has a secondary leachate collection system and liner which
overlies a 1 meter thick aquifer. A phase change occurs in the secondary leachate collection system at
the interface between the unsaturated and saturated zones, assumed to be .2 and .1 meters thick
respectively.

The landfill contains a constant concentration of DCM, which experiences biological decay in the landfill,
primary and secondary liners, and the aquifer. A half-life of 10 years in the landfill and 40 years
everywhere else is assumed. No biological decay is assumed to occur in the secondary leachate
collection system.

The diffusion coefficient of the DCM in the unsaturated zone of the secondary leachate collection system

is assumed to be 300 m2/a, and in the saturated zone to be 100 m2/a (to represent a high degree of
mixing in the saturated zone). The phase change parameter for the DCM in the unsaturated zone is
Henry’s Constant which is assumed to be 0.1 for DCM in this example.

Two layers are used to model the unsaturated and saturated zones of the .3 meter thick secondary
leachate collection system. The first layer represents the unsaturated zone and is .2 meters thick. And
the second layer represents the saturated zone and is .1  meter thick.

A Darcy velocity of 0.003 m/a is assumed through the primary liner, and 0 m/a through the secondary
liner. Thus, for a 500 meter long landfill the outflow rate in the saturated portion of the secondary leachate
collection system would be:

Outflow Rate = (500 * 0.003) / 0.1 = 15 m/a

This example is for a hypothetical landfill and is used to illustrate how to prepare an input file
and run an analysis using the Phase Change option. The example is not a prescription for
modeling contaminant migration during operation of a landfill. Each landfill has its own unique
characteristics and no general prescription can be made. The Phase Change option should
only by used by someone with the hydrogeologic background necessary to appreciate the
subtleties associated with the physical situation and the steps necessary for appropriate
modeling of this physical situation. 

6.18.2 Data Entry

Open the Examples project and open Case 18. 

General Tab
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The general data for this example is specified on the General tab. The Darcy velocity will be displayed
but will be ignored when the Passive Sink option is selected.

Layers Tab
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The layer data for this example consists of four layers: a primary liner, a unsaturated collection system,
a saturated collection system, and a secondary liner. The data for these layers is specified on the
Layers tab.

Boundaries Tab

The boundary conditions for this example are a constant concentration top boundary and a fixed outflow
bottom boundary. These boundaries can be specified on the Boundaries tab.

Special Features

The biological decay and passive sink data for this model can be entered using the Special Features tab.

Passive Sink
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The passive sink data is used to specify the Phase parameter and the horizontal and vertical Darcy
velocities. In this example there are four depth intervals for the passive sink.

Radioactive/Biological Decay

The data for the biological decay of the DCM can be specified by selecting the Radioactive/Biological
Decay option on the Special Features tab. In this example there are three decay intervals: one for the
primary liner, one for the unsaturated and saturated collection system, and one for the secondary liner.
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6.18.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

6.18.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Depth vs Concentration

The Depth vs Concentration chart can be displayed by selecting the Depth vs Concentration item for the
Chart Type.
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Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab. 

POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 18: Phase Change

THE PASSIVE SINK OPTION HAS BEEN USED. NOTE THE USER IS RESPONSIBLE FOR ENSURING THAT VELOCITY

CHANGES ARE CONSISTENT WITH THE PASSIVE SINK.
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 Layer Properties 

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Primary Liner 0.6 m 4 0.02 m²/a 0.4 1.5 cm³/g 1.9 g/cm³

Unsaturated

Collection System

0.2 m 4 300 m²/a 0.45 0 cm³/g 1.9 g/cm³

Saturated Collection

System

0.1 m 4 100 m²/a 0.45 0 cm³/g 1.9 g/cm³

Secondary Liner 0.75 m 4 0.02 m²/a 0.4 1.5 cm³/g 1.9 g/cm³

 Boundary Conditions

    Constant Concentration

          Source Concentration = 0.04 mol/m³

    Fixed Outflow Bottom Boundary

          Landfill Length = 500 m

          Landfill Width = 500 m

          Base Thickness = 1 m

          Base Porosity  = 0.3

          Base Outflow Velocity  = 3 m/a

 Radioactive or Biological Decay

          Radioactive or Biological Decay Source Half Life = 10  yr

          Radioactive or Biological Decay Base Half Life = 40  yr

    First Order Radioactive or Biological Decay Depth Ranges

Minimum Depth Maximum Depth Half Life

0  m 0.6  m 40  yr

0.6  m 0.9  m 0  yr

0.9  m 1.65  m 40  yr

 Velocity and Sink Profile

Time Period Minimum Depth Maximum Depth Vertical Velocity Horizontal

Outflow

Phase Parameter

01 0  m 0.6  m 0.003  m/a 0  m/a 1

0.6  m 0.8  m 0.003  m/a 0  m/a 0.1

0.8  m 0.9  m 0.003  m/a 15  m/a 1

0.9  m 1.65  m 0  m/a 0  m/a 1
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 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Calculated Concentrations at Selected Times and Depths 

Time

yr

Depth

m

Concentration

mol/m3

80 0.000E+00 1.563E-04

1.500E-01 4.912E-04

3.000E-01 7.185E-04

4.500E-01 8.173E-04

6.000E-01 8.009E-04

6.500E-01 8.009E-04

7.000E-01 8.009E-04

7.500E-01 8.009E-04

8.000E-01 8.009E-04

8.250E-01 8.009E-04

8.500E-01 8.009E-04

8.750E-01 8.008E-04

9.000E-01 8.008E-04

1.088E+00 6.483E-04

1.275E+00 4.620E-04

1.463E+00 3.048E-04

1.650E+00 2.079E-04

85 0.000E+00 1.105E-04

1.500E-01 3.922E-04

3.000E-01 5.930E-04

4.500E-01 6.923E-04

6.000E-01 6.960E-04

6.500E-01 6.960E-04

7.000E-01 6.960E-04

7.500E-01 6.960E-04

8.000E-01 6.960E-04

8.250E-01 6.960E-04

8.500E-01 6.960E-04

8.750E-01 6.960E-04

9.000E-01 6.959E-04

1.088E+00 5.830E-04

1.275E+00 4.321E-04

1.463E+00 2.982E-04

1.650E+00 2.118E-04

90 0.000E+00 7.816E-05

1.500E-01 3.151E-04

3.000E-01 4.912E-04

4.500E-01 5.870E-04

6.000E-01 6.040E-04

6.500E-01 6.040E-04

7.000E-01 6.040E-04

7.500E-01 6.040E-04
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8.000E-01 6.040E-04

8.250E-01 6.040E-04

8.500E-01 6.040E-04

8.750E-01 6.040E-04

9.000E-01 6.040E-04

1.088E+00 5.220E-04

1.275E+00 4.010E-04

1.463E+00 2.881E-04

1.650E+00 2.118E-04

95 0.000E+00 5.527E-05

1.500E-01 2.547E-04

3.000E-01 4.083E-04

4.500E-01 4.985E-04

6.000E-01 5.239E-04

6.500E-01 5.239E-04

7.000E-01 5.239E-04

7.500E-01 5.239E-04

8.000E-01 5.239E-04

8.250E-01 5.239E-04

8.500E-01 5.239E-04

8.750E-01 5.239E-04

9.000E-01 5.239E-04

1.088E+00 4.659E-04

1.275E+00 3.698E-04

1.463E+00 2.754E-04

1.650E+00 2.087E-04

100 0.000E+00 3.908E-05

1.500E-01 2.072E-04

3.000E-01 3.408E-04

4.500E-01 4.242E-04

6.000E-01 4.544E-04

6.500E-01 4.544E-04

7.000E-01 4.544E-04

7.500E-01 4.544E-04

8.000E-01 4.544E-04

8.250E-01 4.544E-04

8.500E-01 4.544E-04

8.750E-01 4.544E-04

9.000E-01 4.544E-04

1.088E+00 4.149E-04

1.275E+00 3.392E-04

1.463E+00 2.609E-04

1.650E+00 2.029E-04

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this
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computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
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6.19 Example 19: Multiphase Diffusion Test

In this example a multiphase diffusion test performed by Buss et al. (1995) is modelled. This test involved
the migration of toluene from a ‘constant’ source through a 0.1 cm thick HDPE geomembrane, a 18.2 cm
thick airspace and into a 12.3 cm water reservoir (assumed to be well mixed).

6.19.1 Description

In this example a multiphase diffusion test performed by Buss et al. (1995) is modelled. This test involved
the migration of toluene from a ‘constant’ source through a 0.1 cm thick HDPE geomembrane, a 18.2 cm
thick airspace and into a 12.3 cm water reservoir (assumed to be well mixed). Based on Buss et al. the

geomembrane diffusion coefficient was 6 x 10-8 cm2/s and the phase coefficient was 43.8. From
Schwarzenbach et al. (1993), the diffusion coefficient and phase coefficient for toluene in air are 0.088

cm2/s and 0.27 respectively. Based on these parameters the test is modelled for 600 hours and the
calculated and observed concentrations in the receptor are provided at the end of this example.

6.19.2 Data Entry

Open the Examples project and open Case 19. 

General Tab
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The general data for this example can be specified on the General tab. If the Passive Sink has been
selected yet, the Darcy velocity will be ignored. The run parameters for this example can be specified at
the bottom of this tab. In this example the times to calculate the concentration are 1, 20, 40, 70, 100,
150, 200, 250, 300, 350, 400. 450, 500, 550, and 600 hours.

Layers Tab
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The layer data for this example consists of two layers: a geomembrane and an air space. The data for
these layers can be specified on the Layers tab.

Boundaries Tab

The boundary conditions for this example are a constant concentration top boundary and a fixed outflow
bottom boundary. These boundaries can be specified on the Boundaries tab.

Special Features

The passive sink data for this model can be entered on the Special Features tab.
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Passive Sink

The passive sink data is used to specify the Phase parameter and the horizontal and vertical Darcy
velocities. In this example there are two depth intervals for the passive sink.

6.19.3 Model Execution

To run the model and calculate the concentrations press the Run button on the toolbar.

6.19.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Concentration vs Time

The Concentration vs Time chart can be displayed by selecting the Depth vs Concentration item for the
Chart Type.
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Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab. 

POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 19: Multiphase Diffusion Test
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THE PASSIVE SINK OPTION HAS BEEN USED. NOTE THE USER IS RESPONSIBLE FOR ENSURING THAT VELOCITY

CHANGES ARE CONSISTENT WITH THE PASSIVE SINK.

 Layer Properties 

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Geomembrane 0.1 cm 1 0.000216 cm²/hr 1 0 m³/kg 2.7 kg/m³

Air Space 18.2 cm 4 316.8 cm²/hr 1 0 m³/kg 2.7 kg/m³

 Boundary Conditions

    Constant Concentration

          Source Concentration = 500 mg/L

    Fixed Outflow Bottom Boundary

          Landfill Length = 1 cm

          Landfill Width = 1 cm

          Base Thickness = 12.3 cm

          Base Porosity  = 1

          Base Outflow Velocity  = 0 m/a

 Velocity and Sink Profile

Time Period Minimum Depth Maximum Depth Vertical Velocity Horizontal

Outflow

Phase Parameter

01 0  cm 0.1  cm 0  m/a 0  m/a 43.8

0.1  cm 18.3  cm 0  m/a 0  m/a 0.27

 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Calculated Concentrations at Selected Times and Depths 

Time

hr

Depth

cm

Concentration

mg/L

1 0.000E+00 5.000E+02

1.000E-01 1.771E-04

4.650E+00 7.045E-05

9.200E+00 2.687E-05

1.375E+01 9.110E-06

1.830E+01 6.369E-07

20 0.000E+00 5.000E+02

1.000E-01 3.622E+01

4.650E+00 3.420E+01
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9.200E+00 3.234E+01

1.375E+01 3.062E+01

1.830E+01 2.906E+01

40 0.000E+00 5.000E+02

1.000E-01 8.022E+01

4.650E+00 7.834E+01

9.200E+00 7.660E+01

1.375E+01 7.500E+01

1.830E+01 7.354E+01

70 0.000E+00 5.000E+02

1.000E-01 1.387E+02

4.650E+00 1.370E+02

9.200E+00 1.355E+02

1.375E+01 1.342E+02

1.830E+01 1.329E+02

100 0.000E+00 5.000E+02

1.000E-01 1.890E+02

4.650E+00 1.876E+02

9.200E+00 1.863E+02

1.375E+01 1.851E+02

1.830E+01 1.840E+02

150 0.000E+00 5.000E+02

1.000E-01 2.577E+02

4.650E+00 2.566E+02

9.200E+00 2.556E+02

1.375E+01 2.547E+02

1.830E+01 2.539E+02

200 0.000E+00 5.000E+02

1.000E-01 3.113E+02

4.650E+00 3.104E+02

9.200E+00 3.097E+02

1.375E+01 3.089E+02

1.830E+01 3.083E+02

250 0.000E+00 5.000E+02

1.000E-01 3.530E+02

4.650E+00 3.523E+02

9.200E+00 3.517E+02

1.375E+01 3.512E+02

1.830E+01 3.507E+02

300 0.000E+00 5.000E+02

1.000E-01 3.855E+02

4.650E+00 3.850E+02

9.200E+00 3.845E+02

1.375E+01 3.841E+02

1.830E+01 3.837E+02

350 0.000E+00 5.000E+02

1.000E-01 4.108E+02

4.650E+00 4.104E+02

9.200E+00 4.100E+02

1.375E+01 4.097E+02



Appendix A Examples 427

© 2021 GAEA Technologies Ltd.

1.830E+01 4.094E+02

400 0.000E+00 5.000E+02

1.000E-01 4.305E+02

4.650E+00 4.302E+02

9.200E+00 4.299E+02

1.375E+01 4.297E+02

1.830E+01 4.294E+02

450 0.000E+00 5.000E+02

1.000E-01 4.459E+02

4.650E+00 4.456E+02

9.200E+00 4.454E+02

1.375E+01 4.452E+02

1.830E+01 4.450E+02

500 0.000E+00 5.000E+02

1.000E-01 4.578E+02

4.650E+00 4.577E+02

9.200E+00 4.575E+02

1.375E+01 4.573E+02

1.830E+01 4.572E+02

550 0.000E+00 5.000E+02

1.000E-01 4.672E+02

4.650E+00 4.670E+02

9.200E+00 4.669E+02

1.375E+01 4.668E+02

1.830E+01 4.666E+02

600 0.000E+00 5.000E+02

1.000E-01 4.744E+02

4.650E+00 4.743E+02

9.200E+00 4.742E+02

1.375E+01 4.741E+02

1.830E+01 4.740E+02

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
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6.20 Example 20: Sensitivity Analysis

This example uses the same date as Case 16 for Monte Carlo simulation, except a Sensitivity Analysis
is performed. In this example the failure time has a minimum of 15 years and a maximum of 50 years.

6.20.1 Description

In this example, Sensitivity Analysis will be used to examine the effect of uncertainty in the service life of
a Primary Leachate Collection system. The landfill from Cases 15 and 16 will be used, except the time
that the Primary Leachate Collection system begins to fail will range from 15 to 50 years. Cases 15 and
16 should be reviewed prior to reading this example, where the implementation of the Variable Properties
and Passive Sink special features are described in detail.

The parameters for this example are the same as in Case 15, except for the addition of the Sensitivity
Analysis parameters. 

Property Symbol Value Units

Darcy Velocity va variable m/a

Sink Outflow Velocity vs variable m/a

Diffusion Coefficient D 0.02 m2/a

Dispersivity 0.4 m

Distribution Coefficient K 0 cm3/g

Soil Porosity n 0.3 -

Granular Layer Porosity n 0.3 -

Dry Density 1.5 g/cm3

Layer 1 Thickness H 1 m

Layer 2 Thickness H 0.3 m

Layer 3 Thickness H 2 m

Source Concentration c0 1000 mg/L

Ref. Height of Leachate Hr 7.5 cm3/g

Vol. of Leachate Collected Qc variable m/a

Landfill Length L 200 m

Landfill Width W 1 m

Aquifer Thickness h 1 m

Aquifer Porosity nb 0.3 -

Aquifer Outflow Velocity vb 4 m/a

Minimum Failure Start Time 15 a

Maximum Failure Start Time 50 a

This example is for a hypothetical landfill and is used to illustrate how to prepare an input file
and run an analysis using the Variable Properties and Passive Sink option. The example is not
a prescription for modeling contaminant migration during operation of a landfill. Each landfill
has its own unique characteristics and no general prescription can be made. These options
should only by used by someone with the hydrogeologic and engineering background
necessary to appreciate the subtleties associated with the physical situation and the steps
necessary for appropriate modeling of this physical situation. This option should not be used for
an actual project of importance without the guidance of the program developers.
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6.20.2 Data Entry

Open the Examples project and open Case 20. 

General Tab

The general data for this example is the same as for Case 15, except that the title is different. The run
parameters for this example are the same as for Case 15, except that the concentrations will be only
be calculated at a depth off 3.3 m. This depth corresponds to the base of the aquitard.

Layers Tab
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The layer data for this example is the same as for Case 15.

Boundaries Tab

The boundary conditions for this example is the same as for Case 15.

Special Features

The time-varying data, passive sink, and sensitivity analysis data for this model can be entered using the
Time-varying Data and Passive Sink menu items in the Special Features menu.
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Time-Varying Properties

The time-varying properties for this example is the same as for Case 15 .

Passive Sink

The passive sink data for this example is the same as for Case 15 .

Sensitivity Analysis

The sensitivity analysis data can be specified by checking the Sensitivity Analysis box on the Special
Features tab. The number of simulations is usually between 1000 and 10000. However, the time to
compute this many simulations may be quite large. It is suggested as a trial to use less than 50
simulations. To vary the failure time of the Primary Leachate Collection system, the Variable Properties
end time that corresponds to the time of failure in the input data set is used. 

6.20.3 Model Execution

363

363
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To run the model and calculate the concentrations press the Run button on the toolbar.

6.20.4 Model Output

After the model has been executed, the output for the model will be displayed. 

Probability vs Concentration

The Probability vs Concentration chart can be displayed by selecting the Probability vs Concentration
item for the Chart Type.

Using the chart of the probability vs peak chloride concentration predictions can be made about the
concentration in the aquifer. For example, in this case, the expected maximum concentration is 23.6
mg/L.

Probability vs Time
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The Probability vs Time chart can be displayed by selecting the Probability vs Time item for the Chart
Type.

Using this chart the expected time of the maximum concentration can be predicted. In this example, the
expected time is 68.9 years.

Output Listing

To display the output as a text listing that will show the calculated concentrations as numbers, click on
the List tab. 

POLLUTEv8

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker
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Case 20: Sensitivity Analysis

THE VARIABLE VELOCITY AND/OR CONCENTRATION OPTION HAS BEEN USED. NOTE THAT THE ACCURACY OF THE

CALCULATIONS WITH THIS OPTION WILL DEPEND ON THE NUMBER OF SUBLAYERS USED.

THE PASSIVE SINK OPTION HAS BEEN USED. NOTE THE USER IS RESPONSIBLE FOR ENSURING THAT VELOCITY

CHANGES ARE CONSISTENT WITH THE PASSIVE SINK.

 Layer Properties 

Version 8.00 Beta

Copyright (c) 2021

GAEA Technologies Ltd., R.K. Rowe and J.R. Booker

Case 20: Sensitivity Analysis

THE VARIABLE VELOCITY AND/OR CONCENTRATION OPTION HAS BEEN USED. NOTE THAT THE ACCURACY OF THE

CALCULATIONS WITH THIS OPTION WILL DEPEND ON THE NUMBER OF SUBLAYERS USED.

THE PASSIVE SINK OPTION HAS BEEN USED. NOTE THE USER IS RESPONSIBLE FOR ENSURING THAT VELOCITY

CHANGES ARE CONSISTENT WITH THE PASSIVE SINK.

 Layer Properties 

Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Clay 1 m 4 0.02 m²/a 0.4 0 cm³/g 1.5 g/cm³

Collection System 0.3 m 4 10 m²/a 0.3 0 cm³/g 1.5 g/cm³

Aquitard 2 m 4 0.02 m²/a 0.4 0 cm³/g 1.5 g/cm³

 Boundary Conditions

    Finite Mass Top Boundary

    Fixed Outflow Bottom Boundary

          Landfill Length = 200 m

          Landfill Width = 1 m

          Base Thickness = 1 m

          Base Porosity  = 0.3

 Variation in Properties with Time
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  Time Periods with the same Source and Velocity

Period Start Time No. of

 Steps

Time Step Source Conc Rate of

Change

Height of

Leachate

Volume

Collected

1 0  yr 1 20  yr 1000  mg/L 0 7.5  m 0.29  m/a

2 20  yr 5 2  yr -1  mg/L 0 7.5  m 0.2  m/a

3 30  yr 2 10  yr -1  mg/L 0 7.5  m 0.2  m/a

4 50  yr 5 10  yr -1  mg/L 0 7.5  m 0.2  m/a

5 100  yr 5 20  yr -1  mg/L 0 7.5  m 0.2  m/a

 
Period Start Time End Time Proportion Mass Dispersivity Base Velocity

1 0  yr 20  yr 1  m/a 0.4  m 4  m/a

2 20  yr 30  yr 1  m/a 0.4  m 4  m/a

3 30  yr 50  yr 1  m/a 0.4  m 4  m/a

4 50  yr 100  yr 1  m/a 0.4  m 4  m/a

5 100  yr 200  yr 1  m/a 0.4  m 4  m/a

 Velocity and Sink Profile

Time Period Minimum Depth Maximum Depth Vertical Velocity Horizontal Outflow

1 / 1 0  m 1  m 0.01  m/a 0  m/a

1  m 1.3  m 0.01  m/a 6.67  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 1 0  m 1  m 0.028  m/a 0  m/a

1  m 1.3  m 0.028  m/a 18.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 2 0  m 1  m 0.046  m/a 0  m/a

1  m 1.3  m 0.046  m/a 30.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 3 0  m 1  m 0.064  m/a 0  m/a

1  m 1.3  m 0.064  m/a 42.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 4 0  m 1  m 0.082  m/a 0  m/a

1  m 1.3  m 0.082  m/a 54.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 5 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

3 / 1 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

3 / 2 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 1 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 2 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 3 0  m 1  m 0.1  m/a 0  m/a
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1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 4 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 5 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 1 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 2 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 3 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 4 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 5 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Sensitivity Analysis Results 

     Number of Simulations = 2000

     Number of Data Ranges = 50

       Variable Properties End Time

          Time Period = 1

          Uniform Distribution     ( Minimum = 15    Maximum = 50 )

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
Layer Thickness Number of

Sublayers

Coefficient of

Hydrodynamic

Dispersion

Matrix Porosity Distributon

Coefficient

Dry Density

Clay 1 m 4 0.02 m²/a 0.4 0 cm³/g 1.5 g/cm³

Collection System 0.3 m 4 10 m²/a 0.3 0 cm³/g 1.5 g/cm³

Aquitard 2 m 4 0.02 m²/a 0.4 0 cm³/g 1.5 g/cm³
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 Boundary Conditions

    Finite Mass Top Boundary

    Fixed Outflow Bottom Boundary

          Landfill Length = 200 m

          Landfill Width = 1 m

          Base Thickness = 1 m

          Base Porosity  = 0.3

 Variation in Properties with Time

  Time Periods with the same Source and Velocity

Period Start Time No. of

 Steps

Time Step Source Conc Rate of

Change

Height of

Leachate

Volume

Collected

1 0  yr 1 20  yr 1000  mg/L 0 7.5  m 0.29  m/a

2 20  yr 5 2  yr -1  mg/L 0 7.5  m 0.2  m/a

3 30  yr 2 10  yr -1  mg/L 0 7.5  m 0.2  m/a

4 50  yr 5 10  yr -1  mg/L 0 7.5  m 0.2  m/a

5 100  yr 5 20  yr -1  mg/L 0 7.5  m 0.2  m/a

 
Period Start Time End Time Proportion Mass Dispersivity Base Velocity

1 0  yr 20  yr 1  m/a 0.4  m 4  m/a

2 20  yr 30  yr 1  m/a 0.4  m 4  m/a

3 30  yr 50  yr 1  m/a 0.4  m 4  m/a

4 50  yr 100  yr 1  m/a 0.4  m 4  m/a

5 100  yr 200  yr 1  m/a 0.4  m 4  m/a

 Velocity and Sink Profile

Time Period Minimum Depth Maximum Depth Vertical Velocity Horizontal Outflow

1 / 1 0  m 1  m 0.01  m/a 0  m/a

1  m 1.3  m 0.01  m/a 6.67  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 1 0  m 1  m 0.028  m/a 0  m/a

1  m 1.3  m 0.028  m/a 18.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 2 0  m 1  m 0.046  m/a 0  m/a

1  m 1.3  m 0.046  m/a 30.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 3 0  m 1  m 0.064  m/a 0  m/a

1  m 1.3  m 0.064  m/a 42.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

2 / 4 0  m 1  m 0.082  m/a 0  m/a

1  m 1.3  m 0.082  m/a 54.7  m/a
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1.3  m 3.3  m 0  m/a 0  m/a

2 / 5 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

3 / 1 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

3 / 2 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 1 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 2 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 3 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 4 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

4 / 5 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 1 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 2 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 3 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 4 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

5 / 5 0  m 1  m 0.1  m/a 0  m/a

1  m 1.3  m 0.1  m/a 66.7  m/a

1.3  m 3.3  m 0  m/a 0  m/a

 Laplace Transform Parameters 

     TAU = 7     N = 20     SIG = 0     RNU = 2

 Sensitivity Analysis Results 

     Number of Simulations = 2000

     Number of Data Ranges = 50
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       Variable Properties End Time

          Time Period = 1

          Uniform Distribution     ( Minimum = 15    Maximum = 50 )

     Depth = 3.3

   DISTRIBUTION OF PEAK CONCENTRATION 

Minimum

Value

Maximum

Value

Number

Occur.

Probability Cumulative

Probability

Expected

Value

2.285E+01 2.289E+01 68 0.03 0.03 7.775E-01

2.289E+01 2.293E+01 53 0.03 0.06 6.070E-01

2.293E+01 2.296E+01 47 0.02 0.08 5.392E-01

2.296E+01 2.300E+01 43 0.02 0.11 4.941E-01

2.300E+01 2.304E+01 41 0.02 0.13 4.719E-01

2.304E+01 2.308E+01 39 0.02 0.15 4.497E-01

2.308E+01 2.312E+01 38 0.02 0.16 4.389E-01

2.312E+01 2.315E+01 38 0.02 0.18 4.396E-01

2.315E+01 2.319E+01 38 0.02 0.20 4.403E-01

2.319E+01 2.323E+01 37 0.02 0.22 4.294E-01

2.323E+01 2.327E+01 38 0.02 0.24 4.418E-01

2.327E+01 2.331E+01 39 0.02 0.26 4.541E-01

2.331E+01 2.335E+01 40 0.02 0.28 4.665E-01

2.335E+01 2.338E+01 42 0.02 0.30 4.907E-01

2.338E+01 2.342E+01 44 0.02 0.32 5.149E-01

2.342E+01 2.346E+01 47 0.02 0.35 5.509E-01

2.346E+01 2.350E+01 52 0.03 0.37 6.105E-01

2.350E+01 2.354E+01 83 0.04 0.41 9.760E-01

2.354E+01 2.358E+01 153 0.08 0.49 1.802E+00

2.358E+01 2.361E+01 244 0.12 0.61 2.879E+00

2.361E+01 2.365E+01 176 0.09 0.70 2.080E+00

2.365E+01 2.369E+01 14 0.01 0.71 1.657E-01

2.369E+01 2.373E+01 14 0.01 0.71 1.660E-01

2.373E+01 2.377E+01 14 0.01 0.72 1.662E-01

2.377E+01 2.381E+01 15 0.01 0.73 1.784E-01

2.381E+01 2.384E+01 15 0.01 0.74 1.787E-01

2.384E+01 2.388E+01 15 0.01 0.74 1.790E-01

2.388E+01 2.392E+01 16 0.01 0.75 1.912E-01

2.392E+01 2.396E+01 17 0.01 0.76 2.035E-01

2.396E+01 2.400E+01 17 0.01 0.77 2.038E-01

2.400E+01 2.403E+01 18 0.01 0.78 2.161E-01

2.403E+01 2.407E+01 18 0.01 0.79 2.165E-01

2.407E+01 2.411E+01 20 0.01 0.80 2.409E-01

2.411E+01 2.415E+01 20 0.01 0.81 2.413E-01

2.415E+01 2.419E+01 22 0.01 0.82 2.659E-01

2.419E+01 2.423E+01 22 0.01 0.83 2.663E-01

2.423E+01 2.426E+01 25 0.01 0.84 3.031E-01

2.426E+01 2.430E+01 26 0.01 0.85 3.157E-01

2.430E+01 2.434E+01 30 0.01 0.87 3.648E-01

2.434E+01 2.438E+01 32 0.02 0.88 3.898E-01

2.438E+01 2.442E+01 38 0.02 0.90 4.636E-01
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2.442E+01 2.446E+01 46 0.02 0.93 5.620E-01

2.446E+01 2.449E+01 65 0.03 0.96 7.954E-01

2.449E+01 2.453E+01 21 0.01 0.97 2.574E-01

2.453E+01 2.457E+01 9 0.00 0.97 1.105E-01

2.457E+01 2.461E+01 10 0.01 0.98 1.229E-01

2.461E+01 2.465E+01 10 0.01 0.98 1.231E-01

2.465E+01 2.469E+01 10 0.01 0.99 1.233E-01

2.469E+01 2.472E+01 10 0.01 0.99 1.235E-01

2.472E+01 2.476E+01 11 0.01 1.00 1.361E-01

Expected Maximum Concentration = 2.362E+01

   DISTRIBUTION OF TIME OF PEAK CONCENTRATION 

Minimum

Value

Maximum

Value

Number

Occur.

Probability Cumulative

Probability

Expected

Value

5.500E+01 5.548E+01 28 0.01 0.01 7.733E-01

5.548E+01 5.595E+01 27 0.01 0.03 7.521E-01

5.595E+01 5.643E+01 27 0.01 0.04 7.586E-01

5.643E+01 5.690E+01 27 0.01 0.05 7.650E-01

5.690E+01 5.738E+01 27 0.01 0.07 7.714E-01

5.738E+01 5.786E+01 28 0.01 0.08 8.067E-01

5.786E+01 5.833E+01 27 0.01 0.10 7.843E-01

5.833E+01 5.881E+01 27 0.01 0.11 7.907E-01

5.881E+01 5.929E+01 27 0.01 0.12 7.971E-01

5.929E+01 5.976E+01 27 0.01 0.14 8.036E-01

5.976E+01 6.024E+01 28 0.01 0.15 8.400E-01

6.024E+01 6.071E+01 27 0.01 0.16 8.164E-01

6.071E+01 6.119E+01 27 0.01 0.18 8.229E-01

6.119E+01 6.167E+01 27 0.01 0.19 8.293E-01

6.167E+01 6.214E+01 27 0.01 0.20 8.357E-01

6.214E+01 6.262E+01 28 0.01 0.22 8.733E-01

6.262E+01 6.310E+01 27 0.01 0.23 8.486E-01

6.310E+01 6.357E+01 27 0.01 0.25 8.550E-01

6.357E+01 6.405E+01 27 0.01 0.26 8.614E-01

6.405E+01 6.452E+01 27 0.01 0.27 8.679E-01

6.452E+01 6.500E+01 28 0.01 0.29 9.067E-01

6.500E+01 6.548E+01 27 0.01 0.30 8.807E-01

6.548E+01 6.595E+01 27 0.01 0.31 8.871E-01

6.595E+01 6.643E+01 27 0.01 0.33 8.936E-01

6.643E+01 6.690E+01 27 0.01 0.34 9.000E-01

6.690E+01 6.738E+01 28 0.01 0.35 9.400E-01

6.738E+01 6.786E+01 27 0.01 0.37 9.129E-01

6.786E+01 6.833E+01 27 0.01 0.38 9.193E-01

6.833E+01 6.881E+01 30 0.01 0.40 1.029E+00

6.881E+01 6.929E+01 82 0.04 0.44 2.831E+00

6.929E+01 6.976E+01 82 0.04 0.48 2.850E+00

6.976E+01 7.024E+01 68 0.03 0.51 2.380E+00

7.024E+01 7.071E+01 54 0.03 0.54 1.903E+00

7.071E+01 7.119E+01 54 0.03 0.57 1.916E+00
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7.119E+01 7.167E+01 55 0.03 0.59 1.964E+00

7.167E+01 7.214E+01 55 0.03 0.62 1.977E+00

7.214E+01 7.262E+01 54 0.03 0.65 1.954E+00

7.262E+01 7.310E+01 54 0.03 0.68 1.967E+00

7.310E+01 7.357E+01 54 0.03 0.70 1.980E+00

7.357E+01 7.405E+01 55 0.03 0.73 2.030E+00

7.405E+01 7.452E+01 55 0.03 0.76 2.043E+00

7.452E+01 7.500E+01 54 0.03 0.78 2.019E+00

7.500E+01 7.548E+01 54 0.03 0.81 2.031E+00

7.548E+01 7.595E+01 54 0.03 0.84 2.044E+00

7.595E+01 7.643E+01 55 0.03 0.87 2.095E+00

7.643E+01 7.690E+01 55 0.03 0.89 2.108E+00

7.690E+01 7.738E+01 54 0.03 0.92 2.083E+00

7.738E+01 7.786E+01 54 0.03 0.95 2.096E+00

7.786E+01 7.833E+01 54 0.03 0.97 2.109E+00

7.833E+01 7.881E+01 52 0.03 1.00 2.043E+00

Expected Time of Maximum Concentration = 68.9456445222611

   VARIABLE NUMBER:     1

Minimum

Value

Maximum

Value

Number

Occur.

Probability Cumulative

Probability

Expected

Value

1.500E+01 1.570E+01 40 0.02 0.02 3.070E-01

1.570E+01 1.640E+01 40 0.02 0.04 3.210E-01

1.640E+01 1.710E+01 40 0.02 0.06 3.350E-01

1.710E+01 1.780E+01 40 0.02 0.08 3.490E-01

1.780E+01 1.850E+01 40 0.02 0.10 3.630E-01

1.850E+01 1.920E+01 40 0.02 0.12 3.770E-01

1.920E+01 1.990E+01 40 0.02 0.14 3.910E-01

1.990E+01 2.060E+01 40 0.02 0.16 4.050E-01

2.060E+01 2.130E+01 40 0.02 0.18 4.190E-01

2.130E+01 2.200E+01 40 0.02 0.20 4.330E-01

2.200E+01 2.270E+01 40 0.02 0.22 4.470E-01

2.270E+01 2.340E+01 40 0.02 0.24 4.610E-01

2.340E+01 2.410E+01 40 0.02 0.26 4.750E-01

2.410E+01 2.480E+01 40 0.02 0.28 4.890E-01

2.480E+01 2.550E+01 40 0.02 0.30 5.030E-01

2.550E+01 2.620E+01 40 0.02 0.32 5.170E-01

2.620E+01 2.690E+01 40 0.02 0.34 5.310E-01

2.690E+01 2.760E+01 40 0.02 0.36 5.450E-01

2.760E+01 2.830E+01 40 0.02 0.38 5.590E-01

2.830E+01 2.900E+01 40 0.02 0.40 5.730E-01

2.900E+01 2.970E+01 40 0.02 0.42 5.870E-01

2.970E+01 3.040E+01 40 0.02 0.44 6.010E-01

3.040E+01 3.110E+01 40 0.02 0.46 6.150E-01

3.110E+01 3.180E+01 40 0.02 0.48 6.290E-01

3.180E+01 3.250E+01 40 0.02 0.50 6.430E-01

3.250E+01 3.320E+01 40 0.02 0.52 6.570E-01

3.320E+01 3.390E+01 40 0.02 0.54 6.710E-01
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3.390E+01 3.460E+01 40 0.02 0.56 6.850E-01

3.460E+01 3.530E+01 40 0.02 0.58 6.990E-01

3.530E+01 3.600E+01 40 0.02 0.60 7.130E-01

3.600E+01 3.670E+01 40 0.02 0.62 7.270E-01

3.670E+01 3.740E+01 40 0.02 0.64 7.410E-01

3.740E+01 3.810E+01 40 0.02 0.66 7.550E-01

3.810E+01 3.880E+01 40 0.02 0.68 7.690E-01

3.880E+01 3.950E+01 40 0.02 0.70 7.830E-01

3.950E+01 4.020E+01 40 0.02 0.72 7.970E-01

4.020E+01 4.090E+01 40 0.02 0.74 8.110E-01

4.090E+01 4.160E+01 40 0.02 0.76 8.250E-01

4.160E+01 4.230E+01 40 0.02 0.78 8.390E-01

4.230E+01 4.300E+01 40 0.02 0.80 8.530E-01

4.300E+01 4.370E+01 40 0.02 0.82 8.670E-01

4.370E+01 4.440E+01 40 0.02 0.84 8.810E-01

4.440E+01 4.510E+01 40 0.02 0.86 8.950E-01

4.510E+01 4.580E+01 40 0.02 0.88 9.090E-01

4.580E+01 4.650E+01 40 0.02 0.90 9.230E-01

4.650E+01 4.720E+01 40 0.02 0.92 9.370E-01

4.720E+01 4.790E+01 40 0.02 0.94 9.510E-01

4.790E+01 4.860E+01 40 0.02 0.96 9.650E-01

4.860E+01 4.930E+01 40 0.02 0.98 9.790E-01

4.930E+01 5.000E+01 40 0.02 1.00 9.930E-01

0.000E+00 0.000E+00 0 0.00 0.00 0.000E+00

Expected Value = 3.250E+01

 NOTICE 

Although this program has been tested and experience would indicate that it is accurate within the limits given by the assumptions of the theory

used, we make no warranty  as to workability  of this software or any other licensed material. No warranties either expressed or implied (including

warranties of fitness) shall apply . No responsibility  is assumed for any errors, mistakes or misrepresentations that may occur from the use of this

computer program. The user accepts full responsibility  for assessing the validity  and applicability  of the results obtained with this program for any

specific case.
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